SAS® IT Resource Management 3.3 Reporting Guide
Contents

About This Book ................................................................. vii
Recommended Reading ..................................................... xi

PART 1  Introduction to SAS IT Resource Management and
Batch Reporting  1

Chapter 1 • About SAS IT Resource Management ................. 3
Benefits of Using SAS IT Resource Management .............. 4
How Does SAS IT Resource Management Work? .............. 4
How to Locate Documentation and Help for SAS IT Resource Management ...... 6
Accessibility .............................................................. 8

Chapter 2 • About Batch Reporting ........................................... 9
Overview of How SAS IT Resource Management Works to Create Batch Reports ... 9
Overview of Batch Reporting .............................................. 10
Reporting Components across SAS Products and Applications .......... 14

Chapter 3 • Working with the Adapter Setup Wizard ................. 19
What Is the Adapter Setup Wizard? .................................. 19
How to Use the Adapter Setup Wizard ............................... 20
Reporting Jobs and Objects Created by the Adapter Setup Wizard ... 26
Using Domain Categories ................................................. 30
Types of Reports That the Adapter Setup Wizard Creates .......... 31
Viewing Batch Reports ..................................................... 31

PART 2  Creating and Modifying Batch Reports  33

Chapter 4 • About Creating and Modifying Batch Reports ......... 35
Why Create or Modify Batch Reports? ............................... 35
How to Create or Modify Your Own Batch Reports .............. 35

Chapter 5 • Working with Supplied SAS Enterprise Guide Projects .... 45
About SAS Enterprise Guide Projects ................................ 45
Preparing to Work with SAS Enterprise Guide ..................... 50
How to Modify a Report in a Supplied SAS Enterprise Guide Project .... 57

Chapter 6 • Working with the ITRM Gallery Task in SAS Enterprise Guide .... 59
About the ITRM Gallery Task .......................................... 59
Working with the ITRM Gallery Task ................................ 60

Chapter 7 • Working with Report Jobs and Gallery Transformations ........ 69
About Report Jobs ........................................................ 69
Working with Report Jobs ............................................... 71
# Contents

About Gallery Transformations ................................................. 74  
Working with Gallery Transformations ................................. 76  
Specifying a Data Source Location ........................................ 87  
About Templates and Style Sheets ......................................... 88  
Working with Templates and Style Sheets ....................... 90  

**PART 3** Viewing and Managing Batch Reports 93

**Chapter 8 • Working with the Gallery Manager** ............................................. 95
  What Is Gallery Manager? .................................................... 95  
  How to Get Help and Documentation for Gallery Manager .......... 96  
  How Gallery Manager Works ............................................. 96  
  The Gallery Manager Interface .......................................... 99  
  Sample Reports ..................................................................... 106

**Chapter 9 • Working with the SAS Content Server** ............................... 109
  About the SAS Content Server ............................................ 109  
  Working with the SAS Content Server ................................. 110

**PART 4** Interactive Reporting and Using the SAS Portal  and SAS BI Dashboard 113

**Chapter 10 • About Interactive Reporting** ......................................... 115
  Overview of Interactive Reporting ........................................ 115

**Chapter 11 • Using SAS Enterprise Guide Interactively** ...................... 117
  Overview of SAS Enterprise Guide ....................................... 117  
  Accessing SAS IT Resource Management Projects with SAS Enterprise Guide ............................................. 118
  Locating SAS Enterprise Guide Documentation ......................... 119

**Chapter 12 • Using SAS Web Report Studio Interactively** ................. 121
  Overview of SAS Web Report Studio .................................... 121  
  Access SAS IT Resource Management Information Maps to Generate a Report in SAS Web Report Studio ............................................. 124
  E-mailing SAS IT Resource Management Reports .................... 125
  Locating SAS Web Report Studio Documentation ...................... 125

**Chapter 13 • Using SAS Add-In for Microsoft Office Interactively** ........ 127
  SAS Add-In for Microsoft Office and SAS IT Resource Management Data ............................................. 127
  Using SAS Add-In for Microsoft Office to Access SAS IT Resource Management Data ............................................. 128

**Chapter 14 • Using SAS Portal for Communicating IT Domain Intelligence** 131
  Overview of SAS Information Delivery Portal ......................... 131  
  Locating SAS Information Delivery Portal Documentation .......... 134

**Chapter 15 • Using SAS BI Dashboard** ............................................... 135
  Overview of SAS BI Dashboard ........................................... 135  
  Locating SAS BI Dashboard Documentation ............................ 137
PART 5  Appendixes  139

Appendix 1 • Naming Standards for Reporting Objects .......................... 141
  About Naming Standards for SAS IT Resource Management Reporting Objects . 141
  Naming Standards and Location of Objects ........................................ 141

Appendix 2 • Reporting Standards for SAS IT Resource Management Reports .... 147
  About Reporting Standards for SAS IT Resource Management Reports .......... 147
  Standard Specifications for Report Tasks ........................................... 152

Appendix 3 • Troubleshooting and Debugging Tips ................................. 155
  How to Verify the SAS IT Resource Management Enterprise Guide Installation and Configuration .................. 156
  Why SAS Enterprise Guide Reports Do Not Display Correctly ................. 157
  Why Are Reports Missing from the Gallery Manager? ......................... 165
  Why Report Jobs Are Not Generating Reports ................................ 168
  Removing Duplicate Reports That Are Stored on the SAS Content Server ... 170
  Invalid User ID or Password Error Message Is Received ....................... 171
  Invalid User ID and Password Embedded in Generated Code of Report Jobs . 171
  Error Message: Select a SAS Content Server .................................. 172
  How to Debug a Middle-tier Connection Problem in a Report Job ............ 172
  How to Access Gallery Manager Reports in the SAS Content Server .......... 174
  How to Refresh the Cache for Gallery Manager Reports ....................... 174
  How to Back Up Reports ................................................................... 175
  Technical Support ............................................................................. 175

Appendix 4 • Best Practices .................................................................. 177
  Run Report Jobs at Night or during Low Usage Periods ....................... 177
  Limit the Reports That the Filters Can Retrieve When Creating a Gallery .. 178
  Add a User-Defined Report Occurrence to the Gallery Manager ............. 178
  Managing SAS Enterprise Guide Projects for SAS IT Resource Management . 180
  Designing Reports for Batch Jobs ..................................................... 183
  Create Tile Charts with Web Links .................................................... 183
  Override Report Expiration Dates to Purge Reports from the SAS Content Server . 184
  Back Up Your Data and Reports ....................................................... 184
  Schedule Report Jobs Based on the Available Data .............................. 184

Appendix 5 • Report Conversion Guide .................................................. 187
  Converting Reports .......................................................................... 188
  Creating Bar and Pie Charts Using SAS Enterprise Guide ..................... 195
  Creating Line and Other Plots Using SAS Enterprise Guide ................... 207
  Creating Tabular Reports Using SAS Enterprise Guide ......................... 219
  Working with SAS IT Resource Management ...................................... 228

Index ................................................................................................. 231
Contents
About This Book

Audience

The purpose of the *SAS IT Resource Management: Reporting Guide* is to present all topics that are related to SAS IT Resource Management reporting. For information about system administration and data preparation topics, see the *SAS IT Resource Management: Administrator's Guide*.

The *SAS IT Resource Management: Reporting Guide* is designed for the following users:

- Performance analysts are responsible for analyzing IT performance data and communicating the results of this analysis. Performance analysts use SAS IT Resource Management to design and create reports for the purposes of IT performance management and capacity planning.

  These users understand how to analyze the IT resource measurement data that is managed by data administrators. They analyze this data to measure the utilization, availability, and performance of IT resources. They also plan the proper adjustments to the IT infrastructure to meet the current and projected demands of the business. Performance analysts often function as capacity planners, system administrators, and business analysts. Their job responsibilities require them to analyze data and to communicate IT intelligence by designing, generating, sharing, and viewing reports.

  Performance analysts typically use the documentation that is found in this reporting guide. They might also refer to all SAS IT Resource Management documentation or SAS product documentation for those products that are included in the SAS IT Resource Management solution such as SAS Enterprise Guide.

- Information consumers are responsible for analyzing report data and making decisions based on that data.

  These users are business people who are interested in the overall performance aspects of IT at a company. They often function as system architects, IT managers, and IT executives. Information consumers use the reports that are generated by SAS IT Resource Management to support decisions that they make regarding the IT infrastructure. They need to access IT intelligence reports from the office as well as from remote locations.

  Information consumers typically use the documentation that is found in this reporting guide, especially the sections about interpreting reports and using SAS Web Report Studio. They might also refer to the *Introduction to SAS IT Resource Management* and the *SAS IT Resource Management: Gallery Manager User’s Guide*.

- Data administrators are responsible for administering the IT data mart and setting up the jobs that stage and aggregate IT performance data so that report-ready data is available for generating reports.
These users are responsible for administering the IT data mart and adapters; handling the extract, transform, and load (ETL) processes; and managing reporting processes. Data administrators typically deploy and schedule the batch production jobs that prepare and generate IT performance reports. They often function as IT performance managers and capacity planners.

Data administrators primarily use the documentation that is found in the *SAS IT Resource Management: Administrator's Guide*. They might also refer to all SAS IT Resource Management documentation or SAS product documentation for those products that are included in the SAS IT Resource Management solution such as SAS Enterprise Guide.

### Requirements

Here are the prerequisites for using SAS IT Resource Management:

- A user ID and password that is appropriate for the type of access that is needed to accomplish designated IT Resource Management functions.
  
  *Note:* Data administrators use SAS Management Console to define the logins for users and groups of users, based on their roles and the SAS products with which they need to work. For more information, see the “Preparing to Work with the SAS IT Resource Management Client” chapter in the *SAS IT Resource Management: Administrator’s Guide*.

- An operating environment that includes a supported client, middle tier, and server.

- Depending on your role, you might need access to SAS software that is used by SAS IT Resource Management.
  
  *Note:* To log on to the SAS products in the following list, select Programs » SAS. From the list of software that is displayed, select the application that you want to work with. Then enter your user ID and password.

  - **SAS IT Resource Management**
    
    *Note:* The SAS IT Resource Management solution provides additional IT-specific features and functionality to the data management capabilities of SAS Data Integration Studio. These additional features and functions are seamlessly integrated with those of SAS Data Integration Studio. The enhanced capabilities of SAS Data Integration Studio that are delivered by SAS IT Resource Management are commonly referred to as the SAS IT Resource Management client, throughout this document.

  - **SAS Information Map Studio**
  
  - **SAS Enterprise Guide with add-in for SAS IT Resource Management**
  
  - **SAS Management Console**

  You might also want to access SAS products that are Web-based.

  *Note:* To log on to the SAS products in the following list, open your Web browser and point it to the URL address of the product that you want to use.

  - **SAS IT Resource Management – Gallery Manager**, referred to as Gallery Manager throughout the remainder of this document
  
  - **SAS Web Report Studio**
  
  - **SAS BI Dashboard**
• SAS ID Portal
• SAS Add-In for Microsoft Office

Online Help is available for all SAS software. Click Help within the product in order to access it. In addition, documentation for SAS software is available at http://support.sas.com/documentation/index.html. Use the A-Z index to locate the documentation that you want to access.
About This Book
Recommended Reading

- *SAS IT Resource Management: Overview*
- *SAS IT Resource Management: Administrator's Guide*
- *SAS IT Resource Management: Gallery Manager User's Guide*
- *SAS IT Resource Management: Migration Documentation*

For a complete list of SAS publications, go to support.sas.com/bookstore. If you have questions about which titles you need, please contact a SAS Publishing Sales Representative:

SAS Publishing Sales  
SAS Campus Drive  
Cary, NC 27513-2414  
Phone: 1-800-727-3228  
Fax: 1-919-677-8166  
E-mail: sasbook@sas.com  
Web address: support.sas.com/bookstore
Recommended Reading
Part 1

Introduction to SAS IT Resource Management and Batch Reporting

Chapter 1
About SAS IT Resource Management ........................................ 3

Chapter 2
About Batch Reporting ............................................................ 9

Chapter 3
Working with the Adapter Setup Wizard .................................. 19
Chapter 1
About SAS IT Resource Management

What Is SAS IT Resource Management?
SAS IT Resource Management is an IT performance management and capacity planning solution that enables the analysis of any IT data source. The solution creates an integrated IT performance data warehouse, delivers and applies the advanced analytic capabilities of SAS to that warehouse for the purposes of IT performance management and capacity planning, and renders the IT Intelligence necessary to optimize the IT infrastructure. In addition, the solution leverages the IT performance data warehouse and the SAS product capabilities that are included in the solution for purposes beyond the scope of IT performance management such as IT financial management or IT service management. With IT Resource Management, IT departments can manage and plan the usage of their resources to provide a stable yet scalable IT environment for its current and future operations.

To meet the challenges of today’s competitive business environment, the IT department must solicit information from the leaders of the business about the demands that directly affect the IT infrastructure. Concurrently, the IT department must deliver enough information about the performance and capacity of IT resources to allow the business's decision makers to understand and evaluate their current consumption of IT. As such, the communication of IT performance and capacity information must be in a language and format that is suitable for its intended purpose and audience. It is the role of IT performance management and capacity planning software to facilitate this communication so that the IT department can plan and implement adjustments to the IT infrastructure. In the end, this ensures that the business remains competitive and responsive to its customers.
Benefits of Using SAS IT Resource Management

SAS IT Resource Management can be used to resolve a variety of systems management challenges within an organization. It provides the functionality to do the following tasks:

- Establish IT data marts that contain all the resource management data, over various periods of time, that is associated with an enterprise.
- Define and create aggregated data that is specific to a site's analysis and reporting requirements.
- Create common references to common measurements that are available in disparate data sources. This ensures that the IT data mart provides an independent set of measurements that can be analyzed across the IT enterprise.
- Provide graphical and textual reports that contain information that is needed to manage current day IT operations.
- Use SAS IT domain knowledge for performance management, capacity planning, IT resource forecasting, peak period and seasonality analysis, workload analysis, and enterprise IT performance summaries. This information complements existing IT utilization, availability, and performance analysis capabilities.
- Provide a variety of report output mediums to accommodate the needs of the data administrators, performance analysts, and high-level information consumers.

How Does SAS IT Resource Management Work?

SAS IT Resource Management supports adapters for many of the most popular network system and application management tools across the Windows, UNIX, and z/OS operating environments. It also provides the tooling for the creation of user-written adapters for any data source that is not natively supported by the solution. In doing so, it takes advantage of SAS®9 and the enterprise-class solutions that SAS 9 provides, such as:

- SAS Data Integration Studio

This solution provides flexible data integration and specific IT Resource Management services for most data sources. These services perform most of the data preparation and aggregation work that is needed to analyze and report on resource performance. These services enable you to perform the following tasks:

- Create and maintain the IT data marts that are the containers for the staging, aggregation, information map, and report jobs as well as the staged tables and libraries, the aggregation tables and libraries, and the information maps that are created by or used by SAS IT Resource Management.
- Create, maintain, and deploy the jobs that populate the IT data mart.
- Calculate new columns and statistics, percentiles, percent changes, and so on from the input data.
- Create and run the jobs that aggregate the data.
- Create analysis and report-ready data sources from the aggregated data.
• Create and run jobs that produce IT intelligence reports.

• SAS Enterprise Guide

This solution provides comprehensive reporting definition services. Report tasks can be run interactively in SAS Enterprise Guide projects by running the branches of a project that include those report tasks.

Each SAS Enterprise Guide project that SAS IT Resource Management supplies includes one or more ITRM Gallery tasks. ITRM Gallery tasks publish the report definitions to the SAS Metadata Server so that the SAS IT Resource Management client can include that report definition in a report job. Those jobs are then deployed and scheduled for execution in batch mode. The resulting report output can be accessed by the Gallery Manager web application.

• Gallery Manager

This Web-based application manages and organizes report output that is stored on the SAS Content Server. Filters are available to use in organizing the report output.

• SAS Business Intelligence Platform

This platform uses the SAS Foundation technology, which includes the following software: Base SAS, SAS/GRAPH, the Output Delivery System (ODS), and other technologies. It also uses the following components:

• SAS Information Map Studio: This product provides easy access to data using business-oriented terminology. Information maps that are created by the information map transformation in the SAS IT Resource Management client can be read and modified by SAS Information Map Studio.

• SAS Metadata Repository: This repository of centralized metadata stores information about the objects that are created and used by SAS IT Resource Management, such as IT data marts, ETL jobs, information maps, report tasks, report jobs, and more.

• SAS Web Report Studio: This Web-based, interactive query and analysis tool simplifies and standardizes access to and reporting of performance information.

• SAS Information Delivery Portal: This customizable portal provides corporate decision makers with easy access to the data that is most pertinent to them by means of reports and dashboards, such as key performance indicators (KPIs), filter reports, and more. SAS Information Delivery Portal enables the selective and secure dissemination of information throughout an organization.

• The BI Dashboard is a Web-based interface that displays within SAS Information Delivery Portal. Using data and information maps from multiple sources, information consumers and performance analysts users can create dashboards that display information that is pertinent to their areas of interest.

• SAS Add-In for Microsoft Office: This product enables integration with commonly used Microsoft products such as Microsoft Word and Microsoft Excel.

• SAS Statistics, High Performance Forecasting, and Econometric Time Series: These solutions provide a complete set of SAS statistical methods for IT data analysis.

For more information, see Chapter 1, "General Overview" of SAS IT Resource Management: Administrator's Guide.
How to Locate Documentation and Help for SAS IT Resource Management

Accessing SAS IT Resource Management Online Help

Online Help is available for anyone who performs tasks with the user interface.

*Note:* The Help that is provided with this release of the SAS IT Resource Management software briefly describes the fields on the windows that are specific to IT Resource Management.

To display the field-based Help window for an active window or tab, click **Help** or press the F1 key. To search for topics about concepts or features that are identified by specific words, such as "information maps," click the **Search** tab (magnifying glass icon) in the Help window. Enter the text to be found and press the ENTER key.

Online Help is available for all SAS technology products on which SAS IT Resource Management is built.

Accessing SAS IT Resource Management Documentation

The following SAS IT Resource Management documentation is available from **http://support.sas.com/itrm**:

- **What's New in SAS IT Resource Management**
  This document provides a brief description of the new features that are included in this release of the SAS IT Resource Management software and documentation.

- **SAS IT Resource Management: Overview**
  This document provides information about the extensive domain intelligence that is available with SAS IT Resource Management.

  The audience for this introductory document is anyone who works with SAS IT Resource Management or who uses the reports that are generated by the software.

- **SAS IT Resource Management: Administrator's Guide**
  This document contains detailed information about the tasks that are required to set up and manage the IT data mart. It also describes how to set up the IT Resource Management adapters so that they can process the IT resource data that is stored in the IT data mart. This guide provides information about how to set up and maintain IT data marts, work with simple and summarized aggregations, information maps, and the wizards, especially the Adapter Setup wizard, that facilitate the specification of the extract, transform, and load (ETL) processes that are required for administering a site's IT resource data.

  This document provides information about the other functional components of the software, such as the SAS Metadata Repository (SMR) and the like.

  The audience for this document is SAS IT Resource Management data administrators or capacity planners.

- **SAS IT Resource Management: Reporting Guide**
  This document contains detailed information about the tasks that are required to generate, view, and manage reports. It describes how to work with the ITRM Gallery
task in SAS Enterprise Guide, Gallery transformations that are available from the SAS IT Resource Management client, and the Gallery Manager application. It also provides general information about other SAS products that support the reporting processes, such as SAS Web Report Studio, SAS Information Delivery Portal, and SAS Add-in for Microsoft Office.

A “Report Conversion” appendix provides a description of the steps that are performed in order to re-create reports that were generated using SAS IT Resource Management 2.7 report macros. These steps use SAS Enterprise Guide, which is included in SAS IT Resource Management. Separate instructions are provided for converting report macros to the current version of SAS Enterprise Guide.

- **SAS IT Resource Management: Gallery Manager User's Guide**
  This document contains detailed information about the tasks that are required to create, view, and manage galleries and to view the reports that are included in those galleries.

  This document contains detailed information about the tasks that are required to install, customize, and use the SAS IT Resource Management Adapter for SAP.

- **SAS IT Resource Management: System Requirements**
  This document provides a list of the requirements needed to support the server tier, middle tier, and client tier for SAS IT Resource Management.

- "Assigning Unique Application Servers to SAS IT Resource Management Data Tier" technical paper

- **SAS IT Resource Management: Migration Guide**
  This document provides a description of the steps that are performed in order to move a site's processing from the earlier versions of the software to the current version.

- **Demand Technology Performance Sentry Data Collection Sets for SAS IT Resource Management**
  This HTML resource contains data collection sets for ITRM Windows Server and ITRM Exchange.

- **SAS IT Resource Management: Supplied Staged and Aggregation Tables for Supported Adapters**
  This HTML resource contains detailed table and column information about the staged tables and aggregation tables that are generated by the Adapter Setup wizard.

- **SAS IT Resource Management: Supplied Report Samples**

  *Note:* Information about the system requirements, supported adapter metrics, and the SAS IT Resource Management data models is also available at [http://support.sas.com/itrm](http://support.sas.com/itrm).

Documentation is available for the business intelligence and data integration components of the SAS Intelligence Platform and all the SAS products that are referenced in this document. To access this documentation, navigate to the Web site at this location: [http://support.sas.com/documentation/onlinedoc/index.html](http://support.sas.com/documentation/onlinedoc/index.html). On this page, use the **Select a Product** drop-down menu to choose the documentation for the product or solution that you want to view. Then click **Go**.
Accessibility

SAS IT Resource Management includes the following accessibility and compatibility features that improve usability of the product for users with disabilities. These features are related to accessibility standards for electronic information technology that were adopted by the U.S. Government under Section 508 of the U.S. Rehabilitation Act of 1973, as amended.

If you have questions or concerns about the accessibility of SAS products, send e-mail to accessibility@sas.com.

SAS IT Resource Management addresses several areas of 508 compliance:

- Software accessibility compliance applies to software.
  
  In SAS IT Resource Management, software accessibility compliance applies to the SAS Data Integration Studio user interface. SAS IT Resource Management uses the functionality of SAS Data Integration Studio for data manipulation functions. As such it has the same accessibility features as that product. For information about these features, see *SAS Data Integration Studio: User's Guide*.

- Windows accessibility compliance applies to Windows applications, such as SAS Enterprise Guide and SAS Add-In for Microsoft Office.
  
  SAS Enterprise Guide conforms to accessibility standards for the Windows platform. In addition, SAS Enterprise Guide has keyboard shortcuts for the following areas: the Import Data task, the main workspace, menus, the project tree, a process flow, the properties window for an object, and the code editor. For more information, see the Keyboard Shortcuts in the Help for SAS Enterprise Guide.

  You can also use keyboard navigation to navigate through the options in a drop-down list by pressing ALT and the up and down arrow keys.

  In some instances, you can use the Enable accessibility features option to enable additional accessibility features in the task windows and the windows that appear when you run a stored process. This option is available from the Options dialog box.

- Web accessibility compliance applies to browser-based content and Web-based applications, such as SAS Web Report Studio, SAS ID Portal, SAS BI Dashboard.

  The accessibility features for these products are described in the documentation for these products. To locate the appropriate documentation for a SAS product, use the A-Z index at this location: http://support.sas.com/documentation/index.html.
Chapter 2
About Batch Reporting

Overview of How SAS IT Resource Management Works to Create Batch Reports

SAS IT Resource Management provides the processes and the supporting technology that are required to regularly collect, aggregate, analyze, and report on the IT performance evaluation data that is vital to the health of an enterprise.

In general, the processes that gather and monitor IT performance evaluation data consist of the following steps.

Prepare IT performance data for reporting:

1. Collect the raw data about a resource.
2. Process (stage) the raw data.
3. Aggregate the data from the staged tables.
4. Generate information maps.

Generate and analyze IT reports:

5. Define and generate the reports.
6. View the reports.

Overview of Batch Reporting

Batch Reporting Architecture
Information Map
SAS Enterprise Guide Project
ITRM Gallery Task
Report Definition
Gallery Transformation
Report Job
Report Output
SAS Content Server
Gallery Manager

Reporting Components across SAS Products and Applications

Overview of How SAS IT Resource Management Works to Create Batch Reports

SAS IT Resource Management provides the processes and the supporting technology that are required to regularly collect, aggregate, analyze, and report on the IT performance evaluation data that is vital to the health of an enterprise.

In general, the processes that gather and monitor IT performance evaluation data consist of the following steps.

Prepare IT performance data for reporting:

1. Collect the raw data about a resource.
2. Process (stage) the raw data.
3. Aggregate the data from the staged tables.
4. Generate information maps.

Generate and analyze IT reports:

5. Define and generate the reports.
6. View the reports.
The first four steps in the preceding process prepare your IT performance data for reporting. The *SAS IT Resource Management: Administrator’s Guide* provides detailed information about each of these processes and describes how a systems administrator might work with SAS IT Resource Management to prepare raw IT data for reporting.

The last two steps in the process make up the reporting process. These steps define the IT reports that you want to generate and enable you to view the report output to analyze your data. This book, the *SAS IT Resource Management: Reporting Guide*, provides detailed information about each of these processes and their components.

---

**Overview of Batch Reporting**

**Batch Reporting Architecture**

The Adapter Setup wizard in SAS IT Resource Management enables you to easily invoke and create the components that are needed for batch reporting on various adapters and domain categories. These reporting components are either supplied by SAS IT Resource Management (such as supplied SAS Enterprise Guide projects and report definitions) or created when the Adapter Setup wizard executes (such as the reporting jobs and gallery transformations).
The following figure shows the basic components of the batch reporting process and how these components work together to create batch reports.

**Figure 2.1** Overview of Reporting Components and Batch Reporting Architecture

1. Information Map
2. SAS Enterprise Guide Project
3. ITRM Gallery Task
4. Report Definition
5. Report Job
6. Gallery Transformation
7. Report Output and Metadata
8. SAS Content Server
9. Gallery Manager

- Information Map can be identified in the ITRM Gallery task component of the project.
- ITRM Gallery task component of the project publishes metadata that resides in metadata and is selected in the Gallery transformation component of a report job.
- Gallery transformation is executed to generate report output and metadata.
- Report output and metadata is stored in the SAS Content Server.
- Gallery Manager reads report output from the SAS Content Server and displays collections of reports.
Each component of the batch reporting process contributes to the final report output and specifies characteristics of the report such as its content, appearance, location, filters for viewing, and expiration date. You can use the supplied components and predefined process flows for your batch reports. You can also use these supplied components as templates to customize the supplied batch reports for your business needs or create your own batch reports with different reporting parameters.

The following topics in this section describe how each of the reporting components in the batch reporting architecture work together to generate IT reports and make them available for viewing. After you understand the function of each component, where it fits in the batch reporting architecture, and how it affects the other reporting components, then you can work with these components to create or modify your own batch reports if necessary.

**Information Map**

Information maps are data sources that include a collection of data items and filters that describe and present a report-ready view of your IT resource data. Information maps are stored in IT data marts.

Report definitions in the report jobs use information maps to locate and filter the physical data for report input. Pointers to information maps are also included in the SAS Enterprise Guide projects that SAS IT Resource Management supplies.

**SAS Enterprise Guide Project**

SAS IT Resource Management supplies SAS Enterprise Guide projects for several supported adapters and domain categories. These projects manage references to data, related report tasks, code, and report results that determine how data appears in the batch reports that the Adapter Setup wizard creates.

An ITRM Gallery task is appended to each branch of a project. This task extracts the generated code of the branch and additional metadata to include it in a report definition that it creates and saves on the SAS Metadata Server for use by Gallery transformations that are in report jobs.

**ITRM Gallery Task**

The ITRM Gallery task is the last component of a supplied SAS Enterprise Guide project process flow. The ITRM Gallery task specifies the filters and metadata that are used to view the report output in the Gallery Manager. When run, the ITRM Gallery task creates a report definition that includes all of the metadata and SAS code from a given branch of your SAS Enterprise Guide project. The report definition also includes the filters and additional metadata that are specified in the task.

The resulting report definitions are saved on the SAS Metadata Server and used by Gallery transformations that are in report jobs.

**Report Definition**

A report definition, created by an ITRM Gallery task and stored in the SAS Metadata Server, contains the SAS code that defines one or more reports. Report definitions include the metadata values that can be used as filters to subset reports in Gallery Manager. These properties, specified in the ITRM Gallery task that creates the report definition, include filter values for domain category, domain subcategory, job schedule frequency, and possibly other keywords that might be specific to the report.
The Gallery transformation, a component of a SAS IT Resource Management report job, identifies the report definitions that are used to create the report output when the job is run.

**Gallery Transformation**

Gallery transformations are part of the report jobs that support the reporting functions of SAS IT Resource Management. A Gallery transformation specifies how to group together report definitions that generate reports and store output on the SAS Content Server. A Gallery transformation can also adjust the expiration date of report output, overriding the parameter that is specified in the associated report definitions.

When executed, the report job that contains the Gallery transformation uses the report definitions that the transformation identifies to generate report output.

**Report Job**

Report jobs consist of Gallery transformations that, when executed, generate SAS code that creates reports from the report definitions that are identified in the Gallery transformation. The report jobs, stored in the IT data mart, create and delete report output.

**Report Output**

Report output is the report that the report job creates when executed. The reports are stored on the SAS Content Server, a server that SAS IT Resource Management uses for remote content management. The SAS Content Server stores report content and the associated report properties. It also provides version control and distribution of the stored reports.

After the SAS IT Resource Management reports are available on the SAS Content Server, you can use Gallery Manager to view the reports.

**SAS Content Server**

The SAS Content Server is a content repository where SAS IT Resource Management stores reports and report metadata that is the output of report jobs. These report jobs include Gallery transformations that specify the repository folder path, relative to the SAS Content Server, in which to store the reports. These reports are generated and stored on the SAS Content Server in corresponding subfolders of the *sasdat/ITRM* folder.

**Gallery Manager**

Gallery Manager is a Web-based application that enables you to view and organize the SAS IT Resource Management reports that are available in the SAS Content Server.
Reporting Components across SAS Products and Applications

When working with batch reporting for SAS IT Resource Management, you might need to work with several of the reporting components that are described in this chapter. These components are accessible in various SAS products and applications that you use to create, modify, and view SAS IT Resource Management reports.

For example, working with a reporting component might require that you access Gallery Manager, SAS Enterprise Guide, and the SAS IT Resource Management client to complete modifications for the reporting process. The recommended process for modifying a supplied report is to view the properties of a report in Gallery Manager, identify the reporting components that correspond to that report, and modify the reporting components as needed. For more information, see “How to Create or Modify Your Own Batch Reports” on page 35.

The Report Properties dialog box in Gallery Manager provides the SAS Enterprise Guide project, process flow, and ITRM Gallery task names. It also provides the domain category and information map (the data source from which the report is generated) that are associated with a report. This report metadata enables you to locate the corresponding SAS Enterprise Guide project, process flow, information map, and ITRM Gallery task from which the report was designed and created. This report metadata also enables you to use the SAS IT Resource Management client to locate the domain category, information map, report job, and Gallery transformation that are created and deployed to produce the report.

The following three figures show the relationships of these reporting components as they are represented in each of the SAS products and applications that you might use to identify and specify them. A single reporting component is marked with the same number in each of the three figures for easy comparison.
**Figure 2.2** Report Properties Dialog Box in Gallery Manager

1. Information map or data source
2. SAS Enterprise Guide project name
3. SAS Enterprise Guide process flow
4. ITRM Gallery task and report definition name
5. Domain category
Figure 2.3  Project and Process Flow in SAS Enterprise Guide

1 information map or data source
2 SAS Enterprise Guide project name
3 SAS Enterprise Guide process flow
4 ITRM Gallery task and report definition name
Figure 2.4  Report Job and Gallery Transformation Properties in the SAS IT Resource Management Client

1. information map or data source
2. SAS Enterprise Guide project name
3. SAS Enterprise Guide process flow
4. ITRM Gallery task and report definition name
5. domain category
6. report job and Gallery transformation
Chapter 3
Working with the Adapter Setup Wizard

What Is the Adapter Setup Wizard?

The SAS IT Resource Management client includes an Adapter Setup wizard. This wizard enables you to define and create staging jobs, aggregation jobs, information map jobs, and reporting jobs that process the raw data for an IT resource. These jobs include predefined configurations that are based on industry intelligence that represents a best estimate about the types of aggregations and reports that most sites need for analysis.

The Adapter Setup wizard creates reporting jobs that produce reports that are good choices for many users. To examine the reports that SAS IT Resource Management provides, you can use the Adapter Setup wizard to process a sample set of data and then create and run the resulting report jobs. You can then use Gallery Manager to view the reports that are generated.

If the supplied reports do not meet all of the specific reporting needs for your environment, then you can identify the modifications that you want to make to the reporting jobs. You can then work with the corresponding supplied SAS Enterprise Guide projects and reporting architecture to implement your modifications. For more information, see “How to Create or Modify Your Own Batch Reports” on page 35.

Note: If your site does not process data from any of the data sources for which SAS IT Resource Management provides an adapter, then you can use an alternate data source to process a sample set of data to run the Adapter Setup wizard and view the reports that it generates. For example, some data sources that are commonly available in IT enterprises are SAR for UNIX systems, SNMP for IP networks, or a trial license of Demand Technology Performance Sentry for Windows systems.
After the wizard creates the appropriate jobs, you can schedule and run each as needed. The jobs process the raw data in a manner that is specified by or based on a selected adapter and domain category.

For more information about using the Adapter Setup wizard, see “How to Use the Adapter Setup Wizard” on page 20.

---

**How to Use the Adapter Setup Wizard**

The Adapter Setup wizard guides you through several steps that help define staging, aggregation, and reporting components. These components are used to create the ETL jobs that process your IT resource data.

The following information provides brief instructions for completing the Adapter Setup wizard. For more detailed information about the specific fields and requirements for each page of the wizard, see the “Creating Jobs Using the Adapter Setup Wizard” topic in the *SAS IT Resource Management: Administrator’s Guide*.

1. From the SAS IT Resource Management menu, select **New ➔ IT Resource Management ➔ Adapter Setup** to open the Adapter Setup wizard.

2. Specify the adapter for which you want to create jobs.

   **Display 3.1 Specify the Adapter**

   ![Adapter Setup Wizard](image)

3. Specify the configuration level that represents the scope of output jobs that you want the Adapter Setup wizard to create.

   **Note:** If you are using an adapter that does not include aggregations that are categorized with configuration levels, then the level is automatically set to create a staging job only and this page does not appear.
Display 3.2  Specify the Level of Output

For more information about the metrics and aggregations that are supported for each adapter, see the SAS IT Resource Management metrics documentation. To locate the SAS IT Resource Management documentation, use the Products Index at [http://support.sas.com/documentation/index.html](http://support.sas.com/documentation/index.html).

4. Specify the IT data mart where you want to save the ETL jobs that the Adapter Setup wizard will create, or create a new IT data mart.

Display 3.3  Specifying the IT Data Mart

5. Specify staging parameters for the selected adapter. Staging parameters vary by adapter as they specify the configurations that are required to extract, transform, and
load specific raw data into staged tables. The following image is an example of the staging parameters for the DT Perf Sentry adapter:

Display 3.4 Specifying Staging Parameters for the Adapter

6. Specify one or more domain categories that you want the Adapter Setup wizard to use when creating the resulting jobs.

Note: If you are using an adapter that does not have aggregation and information map jobs available from the Adapter Setup wizard, then the wizard creates only a staging job and skips this page.
Select the Domain Categories for the Adapter

For more information, see “Using Domain Categories” on page 30.

7. Select the time periods and key metrics that you want to use for the aggregation and reporting jobs.

*Note:* If you are using an adapter that does not have aggregation and information map jobs available from the Adapter Setup wizard, then the wizard creates only a staging job and skips this page.
8. Specify the location of any user-written formulas to use in addition to the formulas that SAS IT Resource Management supplies.

Display 3.7 Specify User-Written Formulas

9. Specify the location of the SAS Content Server where the reports that are generated from the resulting jobs are stored. Also specify whether you want the Adapter Setup wizard to automatically deploy the jobs that it creates.
This page does not appear if you selected the configuration level **Staging Job Only** on the second page of the wizard. In this case, the Adapter Setup wizard creates only one staging job that you must deploy manually.

**Display 3.8  Specify SAS Content Server and Job Deployment Page**

Note: If you are using domain categories that do not result in reporting jobs, then the SAS Content Server options are not available on this page. For more information, see the “Jobs That the Adapter Setup Wizard Creates for Domain Categories” appendix in the *SAS IT Resource Management: Administrator’s Guide*.

The report definitions that the Adapter Setup wizard uses to create the report jobs are stored on the SAS Metadata Server. In addition, the report output that is generated from the report jobs is stored on the SAS Content Server.

a. If you are using domain categories that result in reporting jobs, then accept the default values for the following parameters for the SAS Content Server:

**SAS Content Server**

specifies the name of the server that is used as the SAS Content Server for storing report definitions and report job outputs.

**Repository folder path**

specifies the path within the SAS Content Server where the reports are stored. The default location is `/SASContentServer/repository/default/sasdag/ITRM`.

**URL file name parameters**

specifies the parameters that pertain to the URL filename, such as Proxy, user ID, or password. For example, the contents of this field could be `user='userID', pass='password',` and so on. The contents of this field are used to communicate with Gallery Manager. In most configurations, these parameters are not needed.
A value is optional in this field. The default value for this field is blank.
For information about the contents that can be entered in this field, see the
"FILENAME Statement, URL Access Method" topic in SAS Statements:
Reference.

**Note:** The contents of the field are not verified.

b. Specify the parameters to indicate whether you want the Adapter Setup wizard to
deploy the jobs that it creates.

10. View a summary of the metadata that you specified with the Adapter Setup wizard.

**Display 3.9**  View Specifications

11. Click **Finish** when complete. The wizard creates the jobs and saves them in a folder
named `<adapter><number>` within the IT data mart that you selected.

---

**Reporting Jobs and Objects Created by the Adapter Setup Wizard**

**About Reporting Jobs Created by the Adapter Setup Wizard**

The Adapter Setup wizard programmatically creates reporting jobs for the domain
categories and time periods that you might select. These reporting jobs are named using
the convention `<domain subcategory> <time period>` (such as Daily, Weekly, and Monthly) Reporting, and they are stored in the same domain
category folder as the aggregation and information map jobs.
Reporting jobs include Gallery transformations that use report definitions and information maps to generate reports using data for IT resources. When a reporting job executes, it creates the necessary report packages and reports based on the information maps that are in the same domain category folder. The reports are then saved as graphic files (such as HTML or .png files) in the SAS Content Server that you selected in the Adapter Setup wizard. For more information about the reporting jobs that the Adapter Setup wizard creates for specific domain categories and time periods, see “How to Determine Whether the Adapter Setup Wizard Will Create Reporting Jobs for Your Selections”.

Note: The metadata server and SAS Content Server must be running when reporting jobs execute or the jobs will fail to generate output.

After a reporting job is deployed, scheduled, and executed, the resulting report output is available for viewing with Gallery Manager. Gallery Manager enables you to access, filter, and manage your report content from a Web browser. For more information, see “Working with the Gallery Manager” on page 95.

How to Determine Whether the Adapter Setup Wizard Will Create Reporting Jobs for Your Selections

SAS IT Resource Management supplies predefined report definitions for several domain categories and time periods. These report definitions include information such as the names of the variables, the report style, and other attributes that are used to build graphical reports from your IT resource data. The Adapter Setup wizard uses these prepackaged report definitions in the reporting jobs that it creates for the domain categories and time periods that you select.

Note: The prepackaged report definitions that the Adapter Setup wizard jobs use were created by the supplied SAS Enterprise Guide projects. If you want to modify a report that the Adapter Setup wizard creates, or if you want to create your own report that is similar to one that the wizard creates, then you can use the corresponding supplied SAS Enterprise Guide project as a template. To do so, copy the supplied project and make the necessary modifications to create a modified report definition. For more information about how to complete this and other related tasks, see “How to Create or Modify Your Own Batch Reports” on page 35 and “Managing SAS Enterprise Guide Projects for SAS IT Resource Management” on page 180.

If you select a domain category and time period for which SAS IT Resource Management supplies report definitions, then the Adapter Setup wizard creates the appropriate reporting jobs. To determine whether the Adapter Setup wizard is going to create reporting jobs for the domain category and time periods that you selected, you can view the Summary page of the wizard before you select Finish.
The Summary page lists the report jobs that the Adapter Setup wizard will create and the report definitions that the report jobs use, as shown in the following image:

**Display 3.10 Example of a Summary Page Listing Report Jobs**

Note: The Summary page also includes a note if no reporting jobs will be created.

You can also determine whether the Adapter Setup wizard is going to create reporting jobs based on your selections by viewing the list of supplied report definitions for a given domain category and time period. If SAS IT Resource Management supplies report definitions for a given adapter, domain category, and time period, then the Adapter Setup wizard creates a reporting job for those selections based on the configuration level that you selected. If there are no supplied report definitions for a given adapter, domain category, and time period, then the Adapter Setup wizard does not create reporting jobs for those selections.

To view the supplied report definitions, perform the following steps:

1. In the **Folders** tree, select **Shared Data ⇒ SAS IT Resource Management ⇒ 3.3 IT Report Definitions**.
2. Select an `<adapter>` folder.
3. Select a `<domain category>` folder.
4. Select **Supplied**.
5. Select a `<time period>` folder.
You can also create your own report definitions, Gallery transformations, and reporting jobs. You can create reporting jobs to supplement those that the Adapter Setup wizard creates. You can also add reporting jobs for the domain categories and time periods for which the Adapter Setup wizard does not create reporting jobs. Report definitions that you create should be stored in the **User Defined** folder within the domain category folder. For more information about how to create your own report definitions, see “About the ITRM Gallery Task” on page 59.

If you decide to create your own reporting objects and jobs, maintain consistency and efficiency by using the same naming conventions and folder structure that SAS IT Resource Management uses for supplied reports. For more information, see “How to Create or Modify Your Own Batch Reports” on page 35 and “Naming Standards and Location of Objects” on page 141.

### Deploy and Run Jobs That the Adapter Setup Wizard Creates

The Adapter Setup wizard does not run the jobs that it creates. You must run the resulting jobs as needed. These jobs depend on one another to process the raw data for reporting. For example, the aggregation jobs include aggregations that rely on the staged tables that are generated when the staging job is run. As a result, each job should be run only after the jobs that it depends on have been run.

The following list shows the types of jobs that the Adapter Setup wizard creates and the dependencies of each. Each job type in the list is dependent on the job type that precedes it.

1. staging job
2. aggregation job
3. information map job
4. reporting job

For more information, see “Deploying and Running Report Jobs” on page 73.

Note: Based on your specifications, the Adapter Setup wizard might not create all four types of jobs (staging, aggregation, information map, and reporting) when it executes. For example, you might specify in the wizard to create only a staging job. Or, you might select a supported adapter for which the Adapter Setup wizard does not create reporting jobs.

---

Using Domain Categories

Domain categories are categories of tables that are organized logically to represent subsets of the IT resource measurements that are available from an adapter. This organization helps you create reports from one or more related aggregation tables of IT performance measurements.

Note: The domain categories that the Adapter Setup wizard displays are not necessarily all of the available domain categories for an adapter. You can view all of the domain categories for an adapter by opening the Folders tree view and expanding Products ➜ SAS IT Resource Management ➜ Adapters ➜ <adapter name> ➜ IT Template Tables. The template tables are the metadata used to create staged tables and are grouped by domain category. All of the domain categories for an adapter are in this list.

The domain categories that are associated with an adapter vary based on the requirements and capabilities of each adapter. If SAS IT Resource Management provides aggregation and information map jobs for a given adapter, then the Adapter Setup wizard enables you to select the domain categories that you want to use. If an adapter does not have aggregation and information map jobs available from the Adapter Setup wizard, then the wizard creates only a staging job and does not enable you to select a domain category.

This capability helps you manage system performance by enabling you to select the specific domain categories that are essential to the performance management and capacity planning processes for your enterprise. The time that the Adapter Setup wizard takes to create the resulting jobs varies based on the number of staged tables, aggregation jobs and tables, information map jobs, and reporting jobs that are generated for the domain categories that you select.

Note: The Adapter Setup wizard creates ETL jobs based on the domain categories that you select. However, the domain categories for some adapters are divided further into domain subcategories. In these cases, the jobs that are created are based on the domain subcategories instead. This prevents jobs from being too large. When working with the ETL jobs that the Adapter Setup wizard creates, you might notice that the jobs are categorized into these subcategories.

For more information about the types of jobs that the Adapter Setup wizard creates for each adapter and domain category, see the “Jobs That the Adapter Setup Wizard Creates for Domain Categories” appendix in the SAS IT Resource Management: Administrator’s Guide.
Types of Reports That the Adapter Setup Wizard Creates

The Adapter Setup wizard provides a wide variety of report types that provide analytical intelligence about IT resources. These reports are designed and configured to show your IT data in a format that is visually appealing and accurate. The selection of a report type to communicate an IT domain intelligence fact is best made by understanding both the message and the audience for which that message is targeted.

Some of the reports that the Adapter Setup wizard creates include tabular and line plots, bar charts, tile charts, and bubble plots. For more information and examples of report types that the Adapter Setup wizard creates, see the “Domain Intelligence Offered by SAS IT Resource Management” topic in the *Introduction to SAS IT Resource Management*.

Viewing Batch Reports

The Adapter Setup wizard enables you to create reporting jobs that run to generate batch reports. These batch reports are saved on the SAS Content Server. To view, manage, and sort these reports, you can use the Gallery Manager.

Gallery Manager is a Web-based application that enables performance analysts and information consumers to access, filter, and manage galleries of report content. For more information, see “Working with the Gallery Manager” on page 95.
Part 2

Creating and Modifying Batch Reports

Chapter 4
About Creating and Modifying Batch Reports .................. 35

Chapter 5
Working with Supplied SAS Enterprise Guide Projects .......... 45

Chapter 6
Working with the ITRM Gallery Task in SAS Enterprise Guide .... 59

Chapter 7
Working with Report Jobs and Gallery Transformations .......... 69
Chapter 4
About Creating and Modifying Batch Reports

Why Create or Modify Batch Reports?

The topics in this chapter describe the various ways that you can create your own batch reports or modify the batch reports that SAS IT Resource Management supplies. These topics also provide information about the reporting components that you must modify to perform various tasks and how to find detailed information about these components.

The recommended process to create or modify batch reports is to first run the Adapter Setup wizard and the jobs that it creates to visually review the reports that SAS IT Resource Management offers.

Note: If you modify report definitions, remember to redeploy the associated jobs.

How to Create or Modify Your Own Batch Reports

Understanding the Batch Reporting Process

The batch reporting process consists of several reporting components that are interconnected within a process flow. The components of this process flow are specified and then executed in a standard sequence in order to generate batch reports. For an example of the reporting components and how they work together in the process flow, see “Overview of Batch Reporting” on page 10.

The Adapter Setup wizard enables you to automatically create and connect the reporting components for several adapters and domain categories that you select. However, you might choose to modify elements of specific reports or add to the existing set of reports.
SAS IT Resource Management enables you to do so by making each reporting component modifiable. You can make a copy of the supplied components and then modify the copies as needed to accommodate the reporting needs for your organization.

**Tip** When you modify or add a specific reporting component, you will likely need to modify the other reporting components downstream in the process flow to accommodate your change. For example, you might add an ITRM Gallery task in a SAS Enterprise Guide project to create a new report definition. You must then add or modify a corresponding Gallery transformation in the report job to identify the new report definition.

### Prepare to Create or Modify Your Own Batch Reports

Before you decide to create or modify your own batch reports, visually review the reports that the Adapter Setup wizard creates and determine whether these reports meet your needs. To do so, perform the following steps:

1. In SAS IT Resource Management, run the Adapter Setup wizard for selected adapters and domain categories.

   For more information, see “How to Use the Adapter Setup Wizard” on page 20.

   **Tip** For best results, use more than one day of data that spans across the week and month boundaries. For example, include data that includes at least the last day of a week and month as well as the first day of the following week and month. This scope of data ensures that you can generate daily, weekly, and monthly reports. If you use data from one day only, then you will not be able to generate weekly or monthly reports.

2. Deploy and run the resulting jobs.

   For more information, see the “Jobs” chapter in the *SAS IT Resource Management: Administrator’s Guide*.

3. In Gallery Manager, review the reports and identify the reports that you want to modify, if necessary. For more information, see “What Is Gallery Manager?” on page 95.

### Modifying the Data Source

#### Ways to Modify the Data Source

An information map is the data source for a batch report that is generated from Adapter Setup wizard report jobs. If you modify the information map that serves as the data source for a batch report, then you might need to modify the other reporting components in the batch reporting process to accommodate your change throughout the process.

The following modifications to an information map do not require that you modify the other reporting components in the process:

- Modify an information map filter expression.
- Add or remove a data item or information map that is not used in any other currently deployed jobs or SAS Enterprise Guide projects.
The following modifications to an information map require that you also modify the corresponding SAS Enterprise Guide project, report definitions, and deployed jobs:

- Change the name of an information map or data item that is used in a SAS Enterprise Guide project that is in use or a report job that is currently deployed.
- Add a data item or information map filter that you want to use in a report.

For instructions about how to perform these tasks, see “How to Modify the Data Source” on page 37.

**How to Modify the Data Source**

To modify the data source or information map that a batch report uses, perform the following steps:

1. In Gallery Manager, open the report that you want to modify.
2. Select **Action ➤ Report Properties** in the Gallery pane to open the Report Properties dialog box and note the following information:
   - **DataSource**: The value in this field is the name of the information map and information map transformation for the report.
   - **Domain Category**: The value in this field is an abbreviated representation of the adapter and the domain category that corresponds to the report and the reporting components that created it.
3. In the SAS IT Resource Management client, locate the IT data mart where the Adapter Setup wizard stored the corresponding jobs for the report.
   - **Note**: If you do not know where the jobs were stored, then you can use the adapter and domain category information from the report properties (identified in the previous step) to locate the folders. The Adapter Setup wizard creates folder names in the IT data mart that correspond with the adapter and domain category names.
   - For more information, see the “Adapter Setup Wizard” chapter in the *SAS IT Resource Management: Administrator's Guide*.
4. Open the information map job for the domain category. In the job, locate the information map transformation that has the same name as the **DataSource** for the report.
5. Right-click the information map transformation and select **Properties**. The Properties dialog box appears and enables you to make modifications to the information map that the transformation creates when executed.
   - For more information about working with information maps, see the “Information Maps” chapter in the *SAS IT Resource Management: Administrator's Guide*.
6. Redeploy and run the information map job.
7. Modify the other reporting components if necessary.
   - For more information, see “Ways to Modify the Data Source” on page 36.

For more information about working with information maps in SAS IT Resource Management, see Chapter 10, “Information Maps” in the *SAS IT Resource Management: Administrator's Guide*. 
Modifying How Batch Reports Look

Ways to Modify How Batch Reports Look
SAS IT Resource Management supplies SAS Enterprise Guide projects that include several components such as report tasks and ITRM Gallery tasks. The parameters that are specified in these components affect how batch reports look. These parameter specifications are included in the report definition that the Gallery transformation identifies in the corresponding report job.

The following modifications require that you modify components in the SAS Enterprise Guide project, run the ITRM Gallery task to create a new report definition, and then redeploy the report job:

- Change the title or footnote of a report.
- Change or add a data item in a report such as an analysis variable or a BY variable.
- Change the report style for one report.
- Change the graph format, style sheet, or colors for one report.

If you want to change the style sheet, the graph format, or the colors for all reports in the report job, then you can modify the Gallery transformation only and then redeploy the report job.

For instructions about how to perform these tasks, see “How to Modify the Way a Specific Batch Report Looks”.

How to Modify the Way a Specific Batch Report Looks
To modify how a specific batch report looks, perform the following steps:

1. In Gallery Manager, locate and open the report that you want to modify. For more information, see “What Is Gallery Manager?” on page 95.

2. Select Action ➔ Report Properties in the Gallery pane to open the Report Properties dialog box and note the following information:

   - **Project**
     The value in this field is the name of the supplied SAS Enterprise Guide project that is associated with the report.

   - **ProcessFlow**
     The value in this field is the page of the SAS Enterprise Guide project that is associated with the report. This page includes the ITRM Gallery task that creates the report definition for the report.

   - **GalleryTask**
     The value in this field is the name of the report definition and the ITRM Gallery task that creates the report definition for the report.

3. Navigate to the location on the client workstation where you installed SAS IT Resource Management. The projects are located at SASITResourceManagementSASEnterpriseGuideComponents\3.3. For example, if you installed SAS IT Resource Management on a 64-bit machine, the projects might be located at C:\Program Files\SASHome\x86\SASITResourceManagementSASEnterpriseGuideComponents\3.3.

4. Copy the supplied SAS Enterprise Guide project that you want to modify.
CAUTION:

Modify a copy of a supplied SAS Enterprise Guide project only. Do not modify a supplied SAS Enterprise Guide project directly. The supplied SAS Enterprise Guide projects include specifications and IT domain intelligence that SAS IT Resource Management provides for reporting. If you modify supplied projects directly, then you will lose the specifications and benefits that these projects provide for future reference. Also, when SAS IT Resource Management provides project updates, your modifications will be overwritten. For more information, see “Managing SAS Enterprise Guide Projects for SAS IT Resource Management” on page 180.

5. Verify that you have set up SAS Enterprise Guide and migrated your projects so that they can work with the SAS IT Resource Management 3.3 IT data marts. For more information about how to perform these tasks, see “About Preparing to Work with SAS Enterprise Guide” on page 50.

6. Review the Project Notes and Process Flow Notes for the project if they are available. You can use the information in these notes files to determine the types of reports that the project creates and understand the general conventions that are used to specify the reports.

7. Modify the reports in the copy of the supplied project. You can use the ProcessFlow and GalleryTask properties that you identified previously to locate the specific branch of components in the project that affect the report.

For more information, see “Working with Supplied SAS Enterprise Guide Projects” on page 45.

8. Open the ITRM Gallery task and click Finish to run it and create an updated report definition.

Note: Report definitions that you create are stored in a User Defined folder. Report definitions that you create do not and should not overwrite the supplied report definitions that are in a Supplied folder.

For more information, see “Working with the ITRM Gallery Task” on page 60.

9. If your modifications included adding a new report definition or changing the name of an existing report definition, then you must also update the Gallery transformation in the corresponding report job to add the new report definition or specify the updated report definition with the new name.

For more information, see “Working with Gallery Transformations” on page 76.

10. Redeploy and run the corresponding report job.

For more information, see “Deploying and Running Report Jobs” on page 73.

How to Modify the Look of All Batch Reports That a Report Job Creates

If you want to change only the style sheet, the graph format, or the colors for all reports that a report job creates, then you can modify the Gallery transformation of the report job and redeploy the job. To do so, perform the following tasks:

1. In SAS IT Resource Management, locate the IT data mart where the Adapter Setup wizard stored the report job that you want to modify.

Note: If you do not know where the report job is stored, then you can use the Gallery Manager to view the properties for one of the reports that the report job creates. Use the DomainCategory and GalleryTask properties to deduce the IT data mart folder where the job is stored and the report definition that the report
For more information, see “What Is Gallery Manager?” on page 95.

For more information, see the “What Does the Adapter Setup Wizard Create” topic in the *SAS IT Resource Management: Administrator's Guide*.

2. Double click the report job to open it in the process flow window.

3. Right-click the Gallery transformation in the process flow window and select **Properties**. The Properties dialog box appears.

4. Click the **Report Parameters** tab. The parameters on this tab enable you to specify the style sheet and graph format that affect the look for all of the reports that the corresponding Gallery transformation and report job create. You can create your own style sheet and design template to change the look of the report output. You can also specify the location for the ActiveX Control and the override location for temporary physical files on the server.

   For more information about designating the style sheet that a report uses, see “Working with Gallery Transformations” on page 76.

5. Redeploy and run the report job.

   For more information, see “Deploying and Running Report Jobs” on page 73.

---

### Modifying the Metadata for the Reports Generated by a Report Definition

#### About Modifying Report Definitions for Batch Reports

You might choose to create or modify report definitions for your batch reports if you want to perform the following tasks:

- Change the report content by adding or removing reports from the list of reports in the report definition.
- Change a setting or property that is used in a filter.
- Modify how a report graph looks (graph type) or how many instances of a report are kept (aging).

For more information, see “How to Modify a Report Definition for Batch Reports” on page 40.

#### How to Modify a Report Definition for Batch Reports

To modify the report definition for batch reports, perform the following steps:

1. In Gallery Manager, locate and open one of the batch reports that you want to modify. For more information, see “What Is Gallery Manager?” on page 95.

2. Select **Action ➔ Report Properties** in the Gallery pane to open the Report Properties dialog box and note the following information:

   **Project**
   
   The value in this field is the name of the supplied SAS Enterprise Guide project that is associated with the report.

   **ProcessFlow**
   
   The value in this field is the page of the SAS Enterprise Guide project that is associated with the report. This page includes the ITRM Gallery task that creates the report definition for the report.
**GalleryTask**

The value in this field is the name of the report definition and the ITRM Gallery task that creates the report definition for the report.

3. If you installed the supplied SAS Enterprise Guide projects, they can be accessed by navigating to the location where you installed SAS IT Resource Management. The projects are located at `SASITResourceManagementSASEnterpriseGuideComponents\3.3`. For example, if you installed SAS IT Resource Management on a 64-bit machine, the projects might be located at `C:\Program Files\SASHome\x86\SASITResourceManagementSASEnterpriseGuideComponents\3.3`.

4. Copy the supplied SAS Enterprise Guide project that you want to modify.

**CAUTION:**

Modify a copy of a supplied SAS Enterprise Guide project only. Do not modify a supplied SAS Enterprise Guide project directly. The supplied SAS Enterprise Guide projects include specifications and IT domain intelligence that SAS IT Resource Management provides for reporting. If you modify supplied projects and do not maintain a copy of the original supplied projects, then you will lose the specifications and benefits that these projects provide for future reference. For more information, see “Managing SAS Enterprise Guide Projects for SAS IT Resource Management” on page 180.

5. Verify that you have set up SAS Enterprise Guide and migrated your projects so that they can work with the SAS IT Resource Management 3.3 IT data marts. For more information about how to perform these tasks, see “About Preparing to Work with SAS Enterprise Guide” on page 50.

6. Review the Project Notes and Process Flow Notes for the project if they are available. You can use the information in these notes files to determine the types of reports that the project creates and understand the general conventions that are used to specify the reports.

7. In the copy of the supplied project, modify the ITRM Gallery task that corresponds with the report.

For more information, see “Working with the ITRM Gallery Task” on page 60.

8. Select **Finish** in the ITRM Gallery task to create an updated report definition.

**Note:** Report definitions that you create should be stored in a **User Defined** folder. Report definitions that you create do not and should not overwrite the supplied report definitions that are in a **Supplied** folder.

9. If your modifications included adding a new report definition or changing the name of an existing report definition, then you must also update the Gallery transformation in the corresponding report job to add the new report definition or specify the updated report definition with the new name.

For more information, see “Working with Gallery Transformations” on page 76.

10. Redeploy and run the corresponding report job.

For more information, see “Deploying and Running Report Jobs” on page 73.
Creating New Reports Using a Supplied Project as a Template

Why Use a Supplied Project as a Template When Creating New Reports?

The batch reports that the Adapter Setup wizard jobs create include supplied report definitions that are based on IT domain intelligence. These reports also include standard and consistent styles, colors, and filters that are proven to improve legibility and report categorization in the Gallery Manager. All of these report definitions are specified in the supplied SAS Enterprise Guide projects that are used to create them for the batch reports. These SAS Enterprise Guide projects are supplied by SAS IT Resource Management and stored on the client workstation during installation.

If you want to create a new batch report that the Adapter Setup wizard jobs do not create, then you can use a supplied SAS Enterprise Guide project as a template to build the report definition for your new report. You can make a copy of the supplied project that is most closely associated with the type of report that you want to create and then modify only the parameters that are necessary.

T I P

The supplied SAS Enterprise Guide projects include standard titles, footnotes, axis statements, names, labels, styles, colors, and filters that SAS IT Resource Management supports and recommends for a given adapter and domain category. If you use these supplied projects as templates for the new reports that you create, then you can maintain consistency among the reports that you create and those that SAS IT Resource Management provides.

For example, you might choose to create a new report using a supplied SAS Enterprise Guide project as a template if you want to perform the following tasks:

• Replicate reports for a domain category for which the Adapter Setup wizard does not already provide reports.

• Create reports for a user-written adapter.

For more information, see “How to Create New Reports Using a Supplied Project as a Template” on page 42.

How to Create New Reports Using a Supplied Project as a Template

To create a new report by using a supplied SAS Enterprise Guide project as a template, perform the following steps:

1. Navigate to the location on the client workstation where you installed SAS IT Resource Management. The projects are located at SASITResourceManagementSASEnterpriseGuideComponents\3.3. For example, if you installed SAS IT Resource Management on a 64-bit machine, the projects might be located at C:\Program Files\SASHome\x86\SASITResourceManagementSASEnterpriseGuideComponents\3.3.

2. Identify the supplied SAS Enterprise Guide project that most closely resembles the type of adapter and domain category that you want to work with. You can use one of the following two methods to determine the supplied project that is most appropriate for your new reports:

• Use the supplied project that corresponds to the adapter and domain category for your new report. The name of each supplied project begins with the adapter name followed by the domain category. For example, if you are creating a report for
the DT Perf Sentry adapter and the Server Disk domain category, then you might choose the \texttt{DTPerfSentryServerDisk.egp} supplied project.

- Use a supplied project that creates reports that are similar to the report that you want to create. SAS IT Resource Management does not supply a SAS Enterprise Guide project for every domain category. If a project for your domain category does not already exist, then you can use a project for the same adapter. You can also review the reports that SAS IT Resource Management does provide and identify the supplied project for a report that you want to imitate.

3. Copy the supplied SAS Enterprise Guide project that you want to use as a template.

\textbf{CAUTION:}

\textit{Modify a copy of a supplied SAS Enterprise Guide project only. Do not modify a supplied SAS Enterprise Guide project directly.} The supplied SAS Enterprise Guide projects include specifications and IT domain intelligence that SAS IT Resource Management provides for reporting. If you modify supplied projects and do not maintain a copy of the original supplied projects, then you will lose the specifications and benefits that these projects provide for future reference. For more information, see “Managing SAS Enterprise Guide Projects for SAS IT Resource Management” on page 180.

4. Verify that you have set up SAS Enterprise Guide and migrated your projects so that they can work with the SAS IT Resource Management 3.3 IT data marts. For more information about how to perform these tasks, see “About Preparing to Work with SAS Enterprise Guide” on page 50.

5. Review the Project Notes and Process Flow Notes for the project if they are available. You can use the information in these notes files to determine the types of reports that the project creates and understand the general conventions that are used to specify the reports.

6. In the copy of the supplied project, modify the components as needed to specify the report configurations for the new report.

For more information, see “Working with Supplied SAS Enterprise Guide Projects” on page 45 and “Working with the ITRM Gallery Task” on page 60.

7. Run the SAS Enterprise Guide project and then run the ITRM Gallery task separately to create a new report definition.

8. Create a new report job or modify the Gallery transformation in an existing report job. The Gallery transformation in the report job must specify the name and location of the report definition that the modified SAS Enterprise Guide project creates.

For more information, see “Working with Gallery Transformations” on page 76.

9. Deploy and run the report job.

For more information, see “Deploying and Running Report Jobs” on page 73.

\section*{Creating New Reports from Scratch}

\subsection*{Why Create a New Report from Scratch?}

SAS IT Resource Management and SAS Enterprise Guide enable you to create batch reports from scratch, without using supplied SAS Enterprise Guide projects or reporting components as templates or models. You might choose to create your own reports from scratch if they are so unique that they do not have a similar counterpart provided by SAS IT Resource Management.
To create new reports from scratch, you must identify or create all of the reporting components that are required to generate reports. For more information, see “How to Create a New Report from Scratch”.

**How to Create a New Report from Scratch**

SAS IT Resource Management uses specific naming conventions and locations when naming and saving reporting objects such as tables, information maps, information map filters, data items, report titles, report footnotes, and report definitions. These conventions simplify the management and maintenance of the various objects that are interrelated. For best results, if you choose to create or edit reporting objects, then use the same naming and storage conventions that SAS IT Resource Management uses for consistency and efficiency. For more information, see “About Naming Standards for SAS IT Resource Management Reporting Objects” on page 141 and “About Reporting Standards for SAS IT Resource Management Reports” on page 147.

To create a new report from scratch, perform the following steps:

1. Identify a data source for the report. The Adapter Setup wizard reports use information maps as data sources. However, SAS IT Resource Management supports other SAS data sets as sources such as aggregation tables.

   For more information, see the ”Aggregating Your Data” or “Information Maps” chapters in the *SAS IT Resource Management: Administrator’s Guide*.

2. Create a SAS Enterprise Guide project that includes at least the following components:
   - the input data source
   - one or more report tasks to specify the report parameters
   - one or more ITRM Gallery tasks to specify the report definitions

   For more information, see “Working with Supplied SAS Enterprise Guide Projects” on page 45 and “Working with the ITRM Gallery Task” on page 60.

3. Run the SAS Enterprise Guide project interactively to verify that the report output meets your needs.

4. Then run the ITRM Gallery task manually to create a new report definition.

5. Create a new report job that includes a Gallery transformation. The Gallery transformation must specify the name and location of the report definition that the SAS Enterprise Guide project created.

   For more information, see “Working with Gallery Transformations” on page 76.

6. Deploy and run the report job.

   For more information, see “Deploying and Running Report Jobs” on page 73.
Chapter 5
Working with Supplied SAS Enterprise Guide Projects

About SAS Enterprise Guide Projects

What Are SAS Enterprise Guide Projects? .................................. 45
SAS Enterprise Guide Projects Supplied by SAS IT Resource Management ........ 46
Properties of Supplied SAS Enterprise Guide Reports .......................... 49

Preparing to Work with SAS Enterprise Guide ............................ 50
About Preparing to Work with SAS Enterprise Guide ..................... 50
Setting Up SAS Enterprise Guide for SAS IT Resource Management Data ...... 50
Migrating SAS Enterprise Guide Projects to Work with SAS
IT Resource Management 3.3 .................................................. 52

How to Modify a Report in a Supplied SAS Enterprise Guide Project ........ 57

About SAS Enterprise Guide Projects

What Are SAS Enterprise Guide Projects?

In SAS Enterprise Guide, you can work with projects, process flows, branches, and tasks in order to manage the reporting process.

Here are some of the SAS Enterprise Guide components that are used in SAS IT Resource Management reporting:

• Projects
  Projects are used by SAS Enterprise Guide to manage each collection of related tasks, code, references to data, and results.

• Process Flows
  A process flow is a view within a project that shows a set of related data sets, tasks, and results that are linked and can be executed in a single stream. You can run a portion of the process flow or the entire process flow. A project can have multiple process flows that can be selected from the Project tree.

• Branches
  A branch is a set of related tasks that are linked and can be executed in a single stream. Branches can be accessed from a process flow window in SAS Enterprise Guide.

• Tasks
In SAS Enterprise Guide, tasks generate SAS code and formatted results. Tasks include SAS procedures that can generate many types of reports, from simple data listings to complex analytical procedures.

SAS IT Resource Management supplies an ITRM Gallery task that creates report definitions.

**SAS Enterprise Guide Projects Supplied by SAS IT Resource Management**

During installation, SAS IT Resource Management provides several SAS Enterprise Guide projects. They can be accessed by navigating to the location where you installed SAS IT Resource Management on the client workstation. The projects are located at `SASITResourceManagementSASEnterpriseGuideComponents\3.3`. For example, if you installed SAS IT Resource Management on a 64-bit machine, the projects might be located at `C:\Program Files\SASHome\x86\SASITResourceManagementSASEnterpriseGuideComponents\3.3`.

These projects, when executed, generate reports that provide domain intelligence for IT resources. The following two displays show the tree view and workspace view for the supplied project called SARDisk.egp and the process flow called DayJobDetailDisk.

- The tree view provides a hierarchical representation of data, tasks, results, and other objects that are associated with your projects. All of the process flows that are associated with this project are displayed in the tree view of the project.
Display 5.1  Tree View of the DayJobDetailDisk Process Flow in the SARDisk.egp Project

- The workspace view shows the process flow diagram of the objects in one process flow of your project.
Display 5.2  Workspace View of the DayJobDetailDisk Process Flow in the SARDisk.egp Project
The tree and workspace views of the SARDisk.egp project provide examples of these terms:

- The project name is SARDisk.egp.
- The process flow name is DayJobDetailDisk.
- The first task in the process flow is the information map called DetailDisk.
- The process flow contains two branches that each start with a Map Import task called ImportDetailDisk.
  - The import task in the first branch creates a table that provides the source data for the three report tasks that generate line plots and a treemap.
  - The import task in the second branch creates a table that provides the source data for two report tasks that generate two lines plots.

_Note:_ After the SAS Enterprise Guide project is run, the resulting reports are rendered in HTML.

- An ITRM Gallery task is appended to each branch. This task creates the generated code of the branch as a report definition. When the report definition is run in a report job, it creates output on the SAS Content Server.

**TIP** Many supplied SAS Enterprise Guide projects include Project Notes and Process Flow Notes. The Project Notes file provides useful information about the reports that the project creates for the adapter and domain category. The Process Flow Notes file provides specific information about the columns and filters that are used in the various process flows of the project. You can use the information in these notes files to determine the types of reports that the project creates and understand the general conventions that are used to specify the reports.

**Properties of Supplied SAS Enterprise Guide Reports**

SAS Enterprise Guide reports that are supplied by SAS IT Resource Management conform to a set of reporting standards. These conventions, based on IT intelligence and best practices, designate standard specifications for report footnotes, titles, fonts, colors, filters, and so on.

Supplied projects use process flow names that typically suggest which job the reports should run in (for example, the daily job, the weekly job, or the monthly job). The process flow name also indicates the name of the information map that is used. The supplied SAS Enterprise Guide project called SARDisk.egp includes a process flow named DayJobDetailDisk. The name of this process flow suggests that it contains reports that should run in a daily job and that use the DetailDisk information map. This naming convention enables you to associate reports with their report jobs and identify the information maps and SAS tables on which the reports are based.

If you choose to create or edit IT reports, then it is recommended that you follow these reporting standards so that the reports that you create have the same look as those that SAS IT Resource Management supplies.

For more information, see “Naming Standards for Reporting Objects” on page 141 and “About Reporting Standards for SAS IT Resource Management Reports” on page 147.
Preparing to Work with SAS Enterprise Guide

About Preparing to Work with SAS Enterprise Guide

Before you begin working with the supplied SAS Enterprise Guide projects, you must use the functions of SAS Enterprise Guide in order to perform the following tasks:

- Set up SAS Enterprise Guide so that it can work with SAS IT Resource Management data.
- Migrate SAS Enterprise Guide projects so that they can work with your SAS IT Resource Management 3.3 IT data marts, in which you created the report data.

Note: Supplied SAS Enterprise Guide projects include pointers to information maps. These information maps are created when you run the corresponding information map jobs that the Adapter Setup wizard creates. Before you begin working with a supplied SAS Enterprise Guide project, you should run the Adapter Setup wizard for the corresponding adapter and domain category. You must then run the jobs, including the information map job, to create the information map that the supplied project uses.

Setting Up SAS Enterprise Guide for SAS IT Resource Management Data

In order to work with the data from SAS IT Resource Management, SAS Enterprise Guide needs to access the SAS Metadata Repository. To access a SAS Metadata Repository for use by SAS Enterprise Guide, perform the following steps:

1. Invoke SAS Enterprise Guide. To do so, from the Start menu, select Programs \(\rightarrow\) SAS \(\rightarrow\) Enterprise Guide.
2. From the menu bar, select Tools \(\rightarrow\) Options. The Options dialog box appears. From the list in the left pane, select Administration.
3. If you want to create a profile or change your profile, click **Modify**, which opens the Connections window. Select the profile that you want to change and click **Modify**.

4. The Modify Profile window appears and enables you to create or revise the profile. Enter or revise the following information.
   a. The name of the profile is required. The description is optional.
   b. Specify whether the machine is remote or local by clicking the appropriate button.
   c. Enter the machine and port number of the server that you want to connect to.
   d. Enter the user ID and password for the person who can access this server.
   e. Click **Save** to save all specified values and close the window, or **Cancel** to discard all values and close the window.

5. To connect to the server, select the appropriate profile and click **Set active**. The active server is the source for all resource definitions (such as servers and libraries).

   If the Credentials Required dialog box appears, enter your user ID and password and click **OK**.

   The selected repository is identified by the active repository icon: 

6. Click **Close** to return to the Administration window.

7. Click **OK** to return to the main SAS Enterprise Guide workspace.
Migrating SAS Enterprise Guide Projects to Work with SAS IT Resource Management 3.3

About the Migration Wizard
The Migration Wizard for SAS Enterprise Guide and the SAS Add-in for Microsoft Office enables you to migrate report projects that are created with earlier versions of SAS IT Resource Management and SAS Enterprise Guide. The migrated report projects can then be used with your current version of SAS IT Resource Management and SAS Enterprise Guide.

SAS Enterprise Guide projects supplied by SAS IT Resource Management, and typically those created for use with SAS IT Resource Management, use information maps in the report projects. Therefore, you must change the map paths of the supplied information maps to point to the information maps that you created with the Adapter Setup wizard. The easiest way to change the map paths is to use the Migration Wizard for SAS Enterprise Guide and the SAS Add-in for Microsoft Office.

Prerequisites to Running the Migration Wizard
Before you run the Migration wizard, you must run the staging, aggregation, and information map jobs that create the information maps for the adapter and domain category that you want to work with.

If you installed the supplied SAS Enterprise Guide projects, they can be accessed by navigating to the location where you installed SAS IT Resource Management on the client workstation. The projects are located at SASITResourceManagementSASEnterpriseGuideComponents\3.3. For example, if you installed SAS IT Resource Management on a 64-bit machine, the projects might be located at C:\Program Files\SASHome\x86\SASITResourceManagementSASEnterpriseGuideComponents\3.3.

TIP Make sure the projects are not read-only projects. To do this, right-click each project and select Properties. On the General tab, make sure that the Attributes box is not checked. Then click OK.

TIP Make a copy of the SAS Enterprise Guide projects and migrate only the copied projects. The original projects should be kept unchanged as a backup.

Running the Migration Wizard
To run the Migration wizard, navigate to the location where the current version of SAS Enterprise Guide is installed. Then select MigrationWizard.exe. Click Enter to invoke the Migration wizard. The first page of the Migration wizard appears. This page contains information about why you should use this wizard and what you should do before you run it.
On page 2 of the wizard, verify the connection profile of the application server where your information maps are located. You can click **Modify** to change your connection profile.

On page 3 of the wizard, select the files that you want to migrate. To do so, perform the following steps:

1. To facilitate the selection of files, from the drop-down list in the **Show** field, select **SAS Enterprise Guide Projects (*.egp)**. This action causes only SAS Enterprise Guide projects to be displayed in the **Available files** column.

2. In the **Available files** column, navigate to the location of the SAS Enterprise Guide projects that you want to migrate.

3. Check the boxes next to the projects to be migrated.

4. Click the right arrow to move the projects to the **Selected files** column.

On page 4 of the wizard, information is displayed that explains the next steps of the migration process. Click **Next** to run the process that parses the files. The progress of the wizard is displayed as it locates all the references to the projects that you selected.
Click **Done** when the progress indicator shows that this task is complete.

On page 5 of the wizard, you must enter the new mapping information for the selected projects. To do so, perform the following steps:

1. Use the **Show** field to shorten the number of entries on this page. From the drop-down list, select **Global references only**. (This setting removes the information maps from this page, which significantly simplifies the contents of this page.)
2. Expand the page to the full width of your screen. This action enables you to have space to see the complete path information for the current and new mappings.

3. If necessary, resize the Current Mapping column width so that you can see the complete path. This path is the path that was used in the SAS Enterprise Guide project when it was last saved. It identifies the adapter and domain category for which the project was developed. As shown in the following display, a typical path is quite long (for example, /Shared Data/SAS IT Resource Management/IT Data Marts/VMwareForReporting2/VMware vCenter 1/Domain Categories/Guest System/).

Display 5.7 Expanded Current Mapping Column

4. If you want to globally change all references to the server, click the ellipsis button (…) in the New Mapping column. The Change Resource dialog box appears. Use the Browse button to display the list of servers from which you can select the Server...
name that you want to use in your paths. If you want to apply this change to all the object references that contain this value, check the corresponding box.

5. You must enter the mapping information for your new IT data mart in the **New Mapping** column for each of the project folders that are shown on this page. To do so, perform the following steps:

   a. Select the folder and click the ellipsis button (…) in the **New Mapping** column. The Change Resource dialog box appears.

   b. Use the **Browse** button to display the list of folders to which the projects can be migrated. Expand the **Folders** tree until you locate the IT data mart from which you ran the Adapter Setup wizard for these projects.

   ![Display 5.8 Locating the IT Data Mart](image)

   c. Continue expanding the folders within the IT data mart until you find the location of the adapter and the domain category that corresponds to the path in the **Current Mapping** field. In the Select a Location dialog box, the **Selected location** field displays the complete path for the new location.

   d. Make sure that the box is checked that specifies to apply this change to all object references that contain this value.

6. When you have entered the new mapping information for all the SAS Enterprise Guide project folders, click **Next**.

7. On the Begin the migration process page, you can also enter the path to your Migration Record File. You can also change the path to the Log File, specify whether to create automatic backups of the original files, and specify whether to verify the existence of all resources that were changed.

   **Tip** For best results, specify that the original files should be backed up automatically.
8. Click Finish to perform the migration. The Migrating files window displays the progress of your migration. When the migration is complete, the status of the processing is displayed. If a processing error occurred, you can view the log file. Otherwise, click Done to exit from the Migration wizard. The jobs that contain the projects that were successfully migrated can be opened in the IT data mart and run.

---

How to Modify a Report in a Supplied SAS Enterprise Guide Project

The supplied SAS Enterprise Guide projects are the source of the reports that the Adapter Setup wizard creates. Each report in a supplied SAS Enterprise Guide project corresponds to a report definition that SAS IT Resource Management provides. After you have run the Adapter Setup wizard for a given adapter and run the resulting report jobs, you can review the reports that these jobs create. You can then determine whether the reports that SAS IT Resource Management provides meet the needs of your organization.

Note: If your site does not process data from any of the data sources for which SAS IT Resource Management provides an adapter, then you can use an alternate data source to process a sample set of data to run the Adapter Setup wizard and view the reports that it generates. For example, some data sources that are commonly available in IT enterprises are SAR for UNIX systems, SNMP for IP networks, or a trial license of Demand Technology Performance Sentry for Windows systems.

If you want to modify a supplied report that you view in the Gallery Manager, then you can use the report properties to identify the supplied project that is associated with it. You can then copy the corresponding SAS Enterprise Guide project and modify the copied project as needed. To do so, perform the following steps:

1. In Gallery Manager, locate and open the report that you want to modify.
   For more information, see “Working with the Gallery Manager” on page 95.

2. Select Action ➔ Report Properties in the Gallery pane to open the Report Properties dialog box and note the following information:

   **Project**
   The value in this field is the name of the supplied SAS Enterprise Guide project that is associated with the report.

   **ProcessFlow**
   The value in this field is the page of the SAS Enterprise Guide project that is associated with the report. This page includes the ITRM Gallery task that creates the report definition for the report.

   **GalleryTask**
   The value in this field is the name of the report definition and the ITRM Gallery task that creates the report definition for the report.

3. On the client workstation where SAS IT Resource Management is installed, navigate to `SASITResourceManagementSASEnterpriseGuideComponents\3.3`. For example, if you installed SAS IT Resource Management on a 64-bit machine, the projects might be located at `C:\Program Files\SASHome \x86\SASITResourceManagementSASEnterpriseGuideComponents \3.3`.

4. Copy the supplied SAS Enterprise Guide project that you want to modify.
CAUTION:
Modify a copy of a supplied SAS Enterprise Guide project only. Do not modify a supplied SAS Enterprise Guide project directly. The supplied SAS Enterprise Guide projects include specifications and IT domain intelligence that SAS IT Resource Management provides for reporting. If you modify supplied projects and do not maintain a copy of the original supplied projects, then you will lose the specifications and benefits that these projects provide for future reference. For best results, maintain and save the original copies of all supplied projects and report definitions in the Supplied folder and save your modified copies in the User Defined folder. For more information, see “Managing SAS Enterprise Guide Projects for SAS IT Resource Management” on page 180.

5. If the project includes notes, then review the Project Notes and Process Flow Notes files. You can use the information in these notes files to determine the types of reports that the project creates and understand the general conventions that are used to specify the reports.

6. Modify the reports in the copy of the supplied project. You can use the ProcessFlow and GalleryTask properties that you identified previously to locate the specific branch of components in the project that affect the report.
   For more information, see “Working with Supplied SAS Enterprise Guide Projects” on page 45.

7. Run the ITRM Gallery task to create an updated report definition.
   For more information, see “Working with the ITRM Gallery Task” on page 60.

8. If your modifications included adding a new report definition or changing the name of an existing report definition, then you must also update the Gallery transformation in the corresponding report job to add the new report definition or specify the updated report definition with the new name.
   For more information, see “Working with Gallery Transformations” on page 76.

9. Redeploy and run the corresponding report job.
   For more information, see “Deploying and Running Report Jobs” on page 73.
Chapter 6
Working with the ITRM Gallery Task in SAS Enterprise Guide

About the ITRM Gallery Task

The ITRM Gallery task enables you to use SAS Enterprise Guide to specify and create report definitions. These report definitions include all of the metadata and SAS code from a given branch of your SAS Enterprise Guide project. After the ITRM Gallery task creates the report definition, you can use the Gallery transformation that is available in the SAS IT Resource Management client to include the report definition in your report jobs.

Report definitions provide greater flexibility when executing and specifying your report jobs and output. For example, report definitions perform the following actions:

• run in a report job that can execute on any SAS application server such as Windows, UNIX variants, and z/OS. This provides the flexibility of using the batch capabilities of enterprise class systems instead of a Windows client when running the large number of reports that are necessary for IT performance management and capacity planning activities.

• attach metadata to each report so that the Gallery Manager can locate, subset, and filter all of the reports individually. This metadata includes values that you specify as filters when using the Gallery Manager to view and sort only a portion of the available reports.

• create separate pages, metadata, and filters for each report so that every report can be easily searched within the Gallery Manager.

After you use the ITRM Gallery task to define and create a report definition, the report definition is stored on the SAS Metadata Server. You can use the SAS IT Resource Management client to access the report definition later and include it in a Gallery transformation that is part of a report job. When the report job executes, the report definition generates reports and report metadata that are written to the SAS Content Server. You can then use the Gallery Manager to view these reports or subsets of these reports.
In addition to enabling you to create your own report definitions, SAS IT Resource Management supplies report definitions that were generated from the supplied projects in SAS Enterprise Guide. The supplied report definitions provide extensive domain intelligence about IT resources for the supported adapters. The Adapter Setup wizard uses these report definitions in the report jobs that it creates. You can use these supplied report definitions instead of or in addition to the report definitions that you create with the ITRM Gallery task. The supplied report definitions are loaded into a predefined folder for supplied report definitions on the SAS Metadata Server after SAS IT Resource Management is installed. For more information about supplied projects in SAS Enterprise Guide, see “SAS Enterprise Guide Projects Supplied by SAS IT Resource Management” on page 46.

---

**Working with the ITRM Gallery Task**

**Access and Navigate the ITRM Gallery Task**

To access the ITRM Gallery task, perform the following steps:

1. Open or create a SAS Enterprise Guide project that includes one or more report tasks, custom tasks, or program nodes.
2. Select Tools ➤ Add-In ➤ ITRM Gallery.

To navigate through the pages of the ITRM Gallery task, use the following buttons:

- **Back**
  - displays the previous window in the ITRM Gallery task.
- **Next**
  - displays the next window in the ITRM Gallery task.
- **Save**
  - saves the current specifications set in the ITRM Gallery task and creates an ITRM Gallery task object in the process flow diagram of the SAS Enterprise Guide project. The save option does not create a report definition. It simply saves the ITRM Gallery task object that you can use to create a report definition.

**CAUTION:**

When working with SAS Enterprise Guide, you must always save your projects frequently to keep updates to the tasks in the project. If you select **Save** in the ITRM Gallery task, then the specifications for the ITRM Gallery task are saved for the current instance of the project. However, if you do not also save the SAS Enterprise Guide project, then the updates are lost when the project is re-opened.

- **Finish**
  - performs the same functions as **Save** and creates a report definition that is stored on the SAS Metadata Server.

  **Note:** You must click **Finish** to create a report definition. The save option alone does not create a report definition.

- **Cancel**
  - abandons changes that were made since the last save and closes the current page.
Create Report Definitions Using the ITRM Gallery Task

To name and define report definitions for a SAS Enterprise Guide project, perform the following steps:

1. Open or create a SAS Enterprise Guide project that includes one or more report tasks, custom tasks, or program nodes.

2. Select Tools ⇒ Add-In ⇒ ITRM Gallery from the task list in SAS Enterprise Guide to display the Name page of the ITRM Gallery task.

Display 6.1 ITRM Gallery Task Name and Description Page

3. In the Name field, enter the name of the ITRM Gallery task. This is the name that the ITRM Gallery task assigns to the report definition that it creates. The name must be unique for the current metadata path, or the new ITRM Gallery task will overwrite the report definition that has the same name. The Name field can contain no more than 60 characters.

Note: SAS IT Resource Management supplies sample projects that name ITRM Gallery task objects and report definitions by using descriptive words that indicate the following: the measures that are reported, the filters that are used, and the time period that is reported. For example, a report definition might be named SystemCpuHighUsagePlotIntervalsForTheDay. For best results, use this naming convention or your own to create consistent names that are easy to understand and locate in the SAS Metadata Server.

4. In the Description field, enter a description of the ITRM Gallery task. Entering a description in this field is optional but recommended.

5. In the Specify path for report definition field, specify a metadata path where you want to save the report definition. Click Browse to select the folder that you want to contain the report definition for the reports that are included in the ITRM Gallery task.
The metadata folder that you select resides in the SAS Metadata Repository and is available from the SAS IT Resource Management client. The folder that you select will contain the report definitions for the reports that are included in the ITRM Gallery task.


CAUTION:

Do not save your user-defined report definitions in the folder that is named Supplied in the preceding path. The Adapter Setup wizard uses the report definitions in the Supplied folder when generating reporting jobs. If you add or modify report definitions in the Supplied folder, then the associated Adapter Setup wizard jobs might lose the IT intelligence that SAS IT Resource Management provides. Your modified report definitions might also be overwritten when you install any software updates for SAS IT Resource Management.

6. Use the Include data path in report definition option to enable or disable the storing of the current data path in the report definition. The default and recommended value is No because it provides greater flexibility and portability of report definitions. In this case, the data path value in the report definition is left blank, and the Gallery transformation that uses the report definition will search for the data within the corresponding folder for the given job.

The Yes value indicates that the report definition explicitly specifies the data path as the current data path that was used when the report definition was created. Select Yes only if your data path is unique, unchanging, and outside the job folder for the report definition. The Gallery transformation that uses the report definition will then search for the data within the same data path that was used when the report definition was created.

For more information, see “Specifying a Data Source Location” on page 87.

7. Click Next to access the Options page.

Display 6.2 ITRM Gallery Task Options Page
8. On the Options page, you must select one or more reports from the list of report tasks that are in the current process flow. All of the reports that you select will use the same specifications and report filter settings.

*Note:* If you want to assign different settings to various reports, you must create a separate ITRM Gallery task. For example, line plots use the graph format of ActiveX for dynamic features while tile charts are most useful when Java is used. If you have a project that includes both line plots and tile charts, then you perform the following steps:

- Create at least one ITRM Gallery task for the line plots that use ActiveX.
- Create one ITRM Gallery task for the tile charts that use Java.

9. In the **Specifications** box, specify the following options:

**Graph Format**

determines the type of graph that you want to generate (ActiveX, Java, or PNG) for the report definition. The default value is **ActiveX**.

*Note:* List reports that are included in your ITRM Gallery task ignore this option.

**Expire Reports After N Days**

calculates the expiration date, relative to the system date at the time that the report is generated. If a report is expired and its report job is run again, the expired report is deleted and replaced with the new report. If a report is not expired and its report job is run again, the previous report remains in the system with the new report that is generated. You can specify an expiration range from 1 to 999 days. The default value is **1**. In this case, reports that are older than one day are deleted when the report job is run.

*Note:* This parameter calculates expiration by number of days. When setting the expiration for reports that are run on a schedule other than daily, account for the number of days within the time period in which the reports are run. For example, the expiration value for a weekly report should be some multiple of seven because there are seven days in a week.

10. In the **Report Filters** box, specify the filter values that you want to use when viewing reports in the Gallery Manager. These values do not appear on the report. However, they do appear as filter options in the Gallery Manager.

The options for each filter type can include supplied values and user-defined values. To create, delete, save, or share user-defined values for the filter types, click **Manage User-Defined Settings**. For more information about managing user-defined values, see “Managing User-Defined Settings for Report Filters” on page 65.

**CAUTION:**

Carefully select the appropriate filters for your reports and ensure that you use correct spellings for user-defined values. Assigning an incorrect or misspelled filter to a report does not affect the data or the accuracy of the report content. However, an incorrect filter makes the corresponding report difficult to locate when filtering subsets of reports in the Gallery Manager. In addition, make sure that the values for each of the filters are less than 33 characters in length.

**Domain Category**

specifies the adapter and domain category that you assign to the reports for filtering in the Gallery Manager. The options for this field include the values for the adapters that the Adapter Setup wizard supports as well as any user-defined values. The values are sorted alphabetically in this list. For best results, do not leave this field blank.
Domain Subcategory
specifies the report category, a subset of the domain category that you selected. The options for this field include only the subcategories for the domain category that you selected as well as any user-defined values. If the Domain Category value is blank or if the supplied domain category does not include supplied subcategories, then only the user-defined values for domain subcategory are available.

Job Schedule Frequency
indicates when the corresponding reports should be scheduled to run and specifies the time period that you assign to the reports for filtering in the Gallery Manager. The options for this field include daily, weekly, monthly, quarterly, yearly, and any user-defined values.

Note: This value is a report filter in metadata only. It does not schedule report jobs. You can use this value as an indicator to include this report definition in report jobs that are scheduled to run on an interval that corresponds with this value. This value is also used as a filter in Gallery Manager.

Keywords Available
lists the keywords that you can assign to reports for filtering in the Gallery Manager. This list includes supplied and user-defined keywords. To add keywords to reports, select one or more keywords from the Keywords Available list and then click . The keywords are added to the Selected Keywords list.

To remove keywords from the Selected Keywords list, select one or more variables from the Selected Keywords list and click .

11. Click Finish. All values are saved in the ITRM Gallery task object, a report definition is created on the metadata server, and an ITRM Gallery task object appears in the process flow diagram with a link to all of the selected reports tasks and program nodes. A message box notifies you when the report definition is created successfully.

CAUTION:
Running a SAS Enterprise Guide process flow or project does not automatically run the ITRM Gallery task and create a report definition. You must open the ITRM Gallery task separately and click Finish to create and publish a report definition.

When a report definition is created successfully, it does not appear as a separate object in the process flow or in a format that is viewable from SAS Enterprise Guide. SAS Enterprise Guide manages the ITRM Gallery tasks that create report definitions but it does not manage the report definitions. You can use SAS IT Resource Management and SAS Management Console to view and access the report definitions that the ITRM Gallery tasks create.
The following display shows two ITRM Gallery task objects, boxed in red, in a SAS Enterprise Guide process flow.

Display 6.3  ITRM Gallery Task Objects in a Process Flow

12. Save the SAS Enterprise Guide project.

CAUTION:
Do not create multiple ITRM Gallery tasks in a single process flow and then use the report definitions that they create in multiple report jobs that are run in parallel. Report jobs save reports in root folders of the SAS Content Server that are named according to the corresponding project name and process flow name. If separate jobs attempt to update the same root level folders at the same time, then a conflict can occur. For example, do not create daily and weekly report definitions in a single process flow and then create daily and weekly report jobs that run in parallel.

Managing User-Defined Settings for Report Filters

About the Manage User-Defined Settings Window
When planning to filter and subset your reports, you might need to create domain categories and keyword values that are unique to your business. The ITRM Gallery task enables you to create and manage your own unique filter values that you can assign to report definitions and use later in the Gallery Manager when viewing and searching for reports. You can also share these user-defined filters with other clients that might want to filter reports in a similar way.

The Manage User-Defined Settings window of the ITRM Gallery task enables you to share, add, and delete user-defined values for report filters. The user-defined values that you specify on this window are then available from the Gallery Manager and for report definitions that are created with an ITRM Gallery task in SAS Enterprise Guide.

Create User-Defined Values
To create user-defined values, perform the following steps:

1. Open an ITRM Gallery task in a SAS Enterprise Guide project.
2. Click Next to navigate to the Options page.
3. Click Manage User-Defined Settings.
The Manage User-Defined Settings window appears.

4. From the list on the left of the pane, select the type of filter (for example, Domain Category, Domain Subcategory, Job Schedule Frequency, or Keywords) for which you want to add a value.

5. Enter the new filter value in the field at the top of the window. This field accepts only letters, numbers, hyphens, and underscores.

Note: Misspellings, typing errors, and differences in capitalization standards can create inconsistencies in this field. An error in the value can make the associated reports difficult to find when using the Gallery Manager to filter your reports. Inconsistencies can also lead to multiple filter values that mean the same thing but are listed separately.

6. Click Add to create the filter value.

7. Click Save to add the user-defined value to the list of available filters in the ITRM Gallery task. New filter values appear in the Gallery Manager after they are used in a report definition that is part of a run report job.

8. Save the SAS Enterprise Guide project.

Delete User-Defined Values
When you delete a user-defined value, the value is removed from the list of available filters in an ITRM Gallery task. If an ITRM Gallery task uses the deleted value, then the
setting is replaced with a blank value the next time you open the ITRM Gallery task. However, the deleted value will still be available for selection in the Gallery Manager until all of the reports that include the deleted value are purged from the SAS Content Server. It will also still be in the metadata of report definitions and report output that were generated before the change.

To delete a user-defined value, perform the following steps:

1. From the Manage User-Defined Settings window of the ITRM Gallery task, select the type of filter (for example, Domain Category, Domain Subcategory, Job Schedule Frequency, or Keywords) for which you want to delete a value.

2. Select the value that you want to delete.

3. Click Delete.

4. Click Save to delete the user-defined value from the list of available filters in the ITRM Gallery task and the Gallery Manager.

**Share User-Defined Values between Clients**

To share user-defined values between clients, perform the following steps:

1. From the Manage User-Defined Settings window of the ITRM Gallery task, select General. The General window enables you to import user-defined values from another user and to save or export your user-defined values in a physical file for another user.

2. Specify how you want to share the user-defined values:
   - Click Import Settings to add a set of user-defined values from a shared settings file. An Open File window appears, enabling you to navigate to and select a shared settings file that includes the user-defined values that you want to use.
   - Click Export Settings to save your user-defined values in a physical file that you can share with other clients. A Save File window appears, enabling you to save your user-defined values in a physical file and folder location.

   *Note:* You can also use the Export Settings feature to simply save and back up your settings.

3. Click Save.
Modify Report Definitions Using the ITRM Gallery Task

You can use the ITRM Gallery task to modify a SAS IT Resource Management report definition. The ITRM Gallery task must be run manually (as described in this topic) to create or modify a report definition. Simply running a project, process flow, or a branch in SAS Enterprise Guide does not update the report definitions.

To modify report definitions using the ITRM Gallery task, perform the following steps:

1. Open the appropriate SAS Enterprise Guide project and right-click the corresponding ITRM Gallery task object for the report definition that you want to change.
2. Select Modify <ITRM Gallery Task Name>.
3. Navigate the ITRM Gallery task pages and modify the settings as needed.
4. Click Finish. A message box notifies you when the report definition is created successfully. All new values are saved in the ITRM Gallery task object, and the report definition is updated on the metadata server. You must then run the corresponding report job to see updates in the report output.
   
   Note: Save does not create a report definition. It simply saves the ITRM Gallery task object that you can use to create a report definition later.
5. Save the SAS Enterprise Guide project to save the ITRM Gallery task update.

Note: If you modify report definitions, remember to redeploy the associated jobs.
Chapter 7

Working with Report Jobs and Gallery Transformations

About Report Jobs

What is a Report Job?

Report jobs can be run from the SAS IT Resource Management client or can be deployed and run in a batch process. When run, these jobs create reports and save them to the SAS Content Server. Each report job includes a Gallery transformation that, when executed, generates SAS code to perform the following tasks:
• create reports
• delete and replace associated reports that have expired
• save report output to the SAS Content Server
• update the Gallery Manager cache
• create a summary that shows the URL of all reports generated in SAS Content Server and, at the end of the report job, print that summary

For more information, see “About Gallery Transformations” on page 74.

Report jobs can be generated in two ways:
• automatically, by using the Adapter Setup wizard
• manually, by using the Gallery transformation that is in the ITRM Transformations folder of the Transformations tree in SAS IT Resource Management

Report Jobs Created by the Adapter Setup Wizard

The Adapter Setup wizard creates report jobs that contain Gallery transformations for several of the adapters and domain categories that SAS IT Resource Management supports. For more information about the specific adapters and domain categories for which the Adapter Setup wizard creates reporting jobs, see the “Jobs That the Adapter Setup Wizard Creates for Domain Categories” appendix in the SAS IT Resource Management: Administrator's Guide.

For example, the following image shows the report job that the Adapter Setup wizard created for the Server Disk domain category of the DT Perf Sentry adapter. The report job (Disk Daily Reporting) is located in the Domain Categories subfolder of the IT data mart folder. The Gallery transformation (Disk Daily) is available from the process flow diagram of the open report job.

Display 7.1 Report Job Created by the Adapter Setup Wizard

Using the Adapter Setup wizard is the most convenient way to create report jobs for selected adapters. When generated by the Adapter Setup wizard, report jobs use Gallery transformations that reference supplied report definitions. These report definitions provide extensive domain intelligence about IT resources for the supported adapters. For more information, see the “Adapter Setup Wizard” chapter in the SAS IT Resource Management: Administrator's Guide.
However, you might choose to create your own report jobs or modify those that the Adapter Setup wizard creates. For more information, see “Working with Report Jobs” on page 71.

---

**Working with Report Jobs**

*Create a Report Job*

The Adapter Setup wizard creates report jobs for several adapters and domain categories. You can view these supplied reports here: *Samples of Supplied Reports*. These reports are organized by adapter and domain category.

However, you might need to create or modify your own report job. For example, you might want to create batch reports for a domain category for which SAS IT Resource Management does not already provide reports.

Creating a report job requires that you first create a job and then add a Gallery transformation to the job. To do so, perform the following steps:

1. In the SAS IT Resource Management client, open a job. If you want to work with an existing job, double-click on that job to open it on the Diagram tab of the Job Editor window of SAS IT Resource Management.

   If you need to create a new job, you can invoke the New Object wizard from the File menu of SAS IT Resource Management. For information about how to perform this task, see the “Create a Job” topic in the *SAS IT Resource Management: Administrator's Guide*.

   The new job opens on the Diagram tab of the Job Editor window.

2. Navigate to the ITRM Transformations folder of the Transformations tree of SAS IT Resource Management.

3. Drag the Gallery transformation onto the job in the Diagram tab of the Job Editor window.

   *Note:* A Gallery transformation does not have an input or output object in the process flow diagram of a report job. Thus, a report job can include one Gallery transformation as the only object in the process flow diagram of the job and still be valid.

4. Modify the Gallery transformation parameters as needed to meet the reporting needs of your organization. For more information, see “Add a Gallery Transformation to a Report Job” on page 76. Then save the job.

5. Deploy and run the report job. For more information, see “Deploying and Running Report Jobs” on page 73.

   *Note:* You can deploy and run report jobs to create reports, remove the reports that are expired from the SAS Content Server, and load the new reports onto the SAS Content Server for the Gallery Manager to access.
Modify a Report Job

To edit an existing report job, perform the following steps:

1. In the IT Data Marts tree of SAS IT Resource Management, double-click the report job that you want to edit.
2. Edit the report job.

   To Edit the Properties of the Report Job
   a. Right-click the report job in the IT Data Marts tree.
   b. To rename the report job, select Rename.
   c. To view and modify the properties of the report job, select Properties. For more information about the properties for a report job, see the Help for SAS IT Resource Management.
   d. Click OK. Save the job.

   To Edit the Properties of a Gallery Transformation in the Report Job
   a. Right-click the Gallery transformation in the process flow diagram and select Properties. A Properties dialog box displays and enables you to modify the various parameters that are specified for the Gallery transformation and the code that it generates. For more information, see “Edit a Gallery Transformation” on page 86.
   b. Click OK. Save the job.

   For more information about the specific parameters that are available for configuration in the Gallery transformation, see the detailed steps in “Add a Gallery Transformation to a Report Job” on page 76.

3. Deploy and run the report job. For more information, see “Deploying and Running Report Jobs” on page 73.

Copy a Report Job

To copy a report job, perform the following steps:

1. Navigate to the location of the job in the IT Data Marts tree.
2. Right-click the job.
3. Select Copy.
4. Right-click the folder where you want the copy of the job to reside.
5. Select Paste. A copy of the report job is saved in the folder and is assigned the default name Copy of <original job name>.
6. Double-click the new job to open it in the Diagram tab of the Job Editor.
7. Right-click the Gallery transformation in the process flow and select the Server tab.
8. Specify the name and location of the SAS Content Server for the Gallery transformation.
9. Click OK. Save the job.
**Delete a Report Job**

To delete a report job, perform the following steps:

1. Navigate to the location of the job in the **IT Data Marts** tree.
2. Right-click the job.
3. From the menu that is displayed, select **Delete**.
4. In the confirmation box, click **Yes** to delete the job.

If you delete a report job that has already run, then the reports that the job created will remain on the SAS Content Server until you delete them manually. The only way that a report is programmatically deleted from the SAS Content Server is when the report has expired and its report job is rerun to remove and replace the report. For more information, see “Working with the SAS Content Server” on page 110.

*Note:* If you delete a report job in an IT data mart but the report job has already been deployed, then the deployed job can still be run in batch.

---

**Deploying and Running Report Jobs**

**About Deploying and Running Report Jobs**

After you create or modify a report job, you can deploy and run the job to create reports, delete and replace expired reports, and save reports on the SAS Content Server where the Gallery Manager can access them. Report jobs are the last step in the batch reporting process flow and thus rely on all of the jobs and components that precede it in the data extraction, transformation, loading, and reporting process.

Deploying a job enables you to execute the job outside of SAS IT Resource Management, such as when scheduling a job to run at a specified time. SAS IT Resource Management enables you to deploy as well as run jobs. For more information about how to deploy and run jobs, see the “Jobs” chapter in the *SAS IT Resource Management: Administrator's Guide*.

**Deploy and Run Report Jobs That the Adapter Setup Wizard Creates**

The Adapter Setup wizard creates a set of jobs that compartmentalize each step of the extract, transform, load, and reporting process for IT data. These jobs depend on one another to process the raw data for reporting. For example, aggregation jobs include aggregations that rely on the staged tables that are generated when the staging job is run. As a result, each job should be run only after the jobs that it depends on have been run. The following list shows the types of jobs that the Adapter Setup wizard creates and the dependencies of each. Each job type in the list is dependent on the job type that precedes it.

1. staging job
2. aggregation job
3. information map job
4. reporting job

For more information, see “Working with the Adapter Setup Wizard” on page 19.
Deploy and Run Your Own Report Jobs

You can create, deploy, and run your own report jobs manually, without using the Adapter Setup wizard. However, like the report jobs that the Adapter Setup wizard creates, your report jobs must also rely on other processing components that extract, transform, and load your IT data. For consistency and efficiency, use the same naming conventions and job structure that the Adapter Setup wizard uses when you create your own jobs and components for this process. For information about what the Adapter Setup wizard creates, see the “Adapter Setup Wizard” chapter in the SAS IT Resource Management: Administrator's Guide.

After you confirm that all of the extract, transform, and load components for your report job are prepared and executed, then you can deploy and run your report job.

About Gallery Transformations

What Is a Gallery Transformation?

Gallery transformations are among the final components of the batch reporting process. These transformations are part of report jobs, and they identify one or more of the report definitions that a report job uses to create report output. This process enables you to run report jobs and their report definitions in batch mode.

Although report definitions provide a majority of the specifications for report output, the Gallery transformation enables you to specify (and in some cases, override) a few additional parameters for all of the reports that the corresponding report job creates. A Gallery transformation enables you to specify the following values for all of the reports that the corresponding report job creates:

• SAS Content Server where the corresponding reports will be stored
• style sheet and location
• graph format (overrides the graph format that is specified in the report definition)
• report definitions
• the purging criteria for a report (overrides the expiration date that is specified in the report definition)

The Gallery transformation compiles the specified values and generates the SAS program that will be run as scheduled in the report job. In the following example, a Gallery transformation named System Monthly is in the System Monthly Reporting job for the DT Perf Sentry adapter and the Server System domain category.
**Display 7.2  A Gallery Transformation in a Report Job**

For more information, see “About Report Jobs” on page 69.

**Properties of Gallery Transformations**

To access the Gallery transformation properties, right-click a Gallery transformation in a report job and select **Properties**. A Properties dialog box appears and enables you to view properties and specifications for the SAS Content Server, report parameters, and report definitions.

The Properties dialog box contains the following tabs:

- The **General** tab displays information that identifies the Gallery transformation such as name and description.
- The **Server** tab enables you to specify the name and location of the SAS Content Server for the Gallery transformation and the advanced URL filename parameters.
- The **Report Parameters** tab enables you to view or modify the parameters that apply to the reports that the transformation generates.
- The **Report Definitions** tab enables you to identify the report definitions that you want to use.
The **Options** tab displays information about how to further customize and generate the code.

The **Code** tab enables you to manage the code that is generated by the transformation.

*Note:* This tab should not be used to modify the code that is generated by the Gallery transformation. Changes that you make can result in code that is error prone and is out of alignment with the report definition that was created by SAS Enterprise Guide.

The **Precode and Postcode** tab enables you to specify that user-written code should be inserted at the beginning or end of the current transformation.

The **Notes** tab displays any notes or documents that are associated with the transformation.

The **Extended Attributes** tab displays the custom properties that are available for the transformation.

For more information about the tabs that are available from the Properties dialog box, see the Help for SAS IT Resource Management.

**Gallery Transformations Created by the Adapter Setup Wizard**

The Adapter Setup wizard creates Gallery transformations for several of the adapters and domain categories that SAS IT Resource Management supports. Gallery transformations are saved as components of the reporting jobs that are stored in the IT data mart folders that the Adapter Setup wizard creates. These Gallery transformations reference supplied report definitions that provide extensive domain intelligence about IT resources for the supported adapters. For more information, see the “Adapter Setup Wizard” chapter in the *SAS IT Resource Management: Administrator's Guide*.

Using the Adapter Setup wizard is the most convenient way to create Gallery transformations and report jobs for selected adapters. However, you might choose to create your own Gallery transformations or modify those that the Adapter Setup wizard creates. For more information, see “Working with Gallery Transformations” on page 76.

For more information about the Gallery transformations and report jobs that the Adapter Setup wizard creates, see “Report Jobs Created by the Adapter Setup Wizard” on page 70. For more information about the specific adapters and domain categories for which the Adapter Setup wizard creates reporting jobs, see the “Jobs That the Adapter Setup Wizard Creates for Domain Categories” appendix in the *SAS IT Resource Management: Administrator's Guide*.

---

**Working with Gallery Transformations**

**Add a Gallery Transformation to a Report Job**

The Adapter Setup wizard creates Gallery transformations and report jobs automatically for a number of supplied adapters and domain categories. However, you might need to create your own Gallery transformation and report job. For example, you might want to create batch reports for domain categories for which SAS IT Resource Management does not already provide reports.
To create a Gallery transformation and add it to a report job, perform the following steps:

1. In SAS IT Resource Management, open the report job that is to contain the new Gallery transformation. The job shows on the Diagram tab of the Job Editor window.

   Note: If you want to add a Gallery transformation to a new job, you must first create the job. For more information about how to create a job, see the “Create a Job” topic in the SAS IT Resource Management: Administrator’s Guide.

2. In the Transformations tree of SAS IT Resource Management, expand the ITRM Transformations folder.

   Display 7.3 ITRM Transformations Folder

3. Drag and drop the Gallery transformation onto the Job Editor window. The Gallery transformation appears in the process flow diagram for the job.
4. Right-click the Gallery transformation and select **Properties**.

5. On the **General** tab, specify the name and description of the transformation.

   **Note:** SAS IT Resource Management uses the naming convention `<domain category> <time period>` to name Gallery transformations. For example, a Gallery transformation that generates weekly reports for the Server System domain category of DT Perf Sentry is named **System Weekly**. For best results, use the same naming convention that SAS IT Resource Management uses for consistency and efficiency.

**Display 7.5  General Tab of a Gallery Transformation**

6. On the **Server** tab, specify SAS Content Server parameters for the transformation.
Display 7.6  Server Tab of a Gallery Transformation

The **Server** tab includes the following parameters:

- **SAS Content Server** specifies the name of the SAS Content Server that stores the report output for the Gallery transformation.

- **Repository folder path** specifies the path, relative to the SAS Content Server, in which to store the reports.

- **URL file name parameters** specifies the parameters that pertain to the URL filename, such as Proxy, user ID, or password. For example, the contents of this field could be `user='userID', pass='password'`, and so on. A value is optional in this field and the default value is blank.

  *Note:* The contents of this field are not verified.

7. On the **Report Parameters** tab, specify the style and graph formats for the reports that the transformation creates, the location for the ActiveX Control, and the override location for temporary physical files on the server.
Display 7.7  
Report Parameters Tab of a Gallery Transformation

The **Report Parameters** tab includes the following parameters:

- **Style template** specifies the name of the style template that is used by all of the reports that the Gallery transformation creates. The style template determines graph colors and other attributes inside the graph portion of a report.

  You can use the standard style template that SAS IT Resource Management provides (named **ITRMDefault**) or create your own style template that includes your own custom colors and visual design. For more information, see “About Templates and Style Sheets” on page 88.

- **Location for style sheet** specifies the cascading style sheet (.css file) that is used when viewing a report. It controls colors and other attributes outside of the graph portion of a report.

  Any of the following location types are valid values for this field:

  - a full URL to the style sheet folder on a specified server (such as `http://<server>:8080/<folder name>/`).
  - a URL to a style sheet folder on all the clients where the Web browser was initiated (such as `file://c:/programfiles/<folder name>/`).
  - a relative URL to the style sheet folder on the middle tier where the graphs are installed (such as `/<folder name>/<subfolder name>`). The option to use only the relative path provides portability of this value. For example, if the name or location of the middle tier changes, the location value does not need to change as long as the folder names in the middle tier remain the same.

  The default value (`/SASContentServer/repository/default/sasadav/ITRM/styles/ITRMDefault.css`) provides a path to the default style sheet for SAS IT Resource Management reports. You can create a style sheet that
includes your own custom colors, logos, and visual design. For more information, see “About Templates and Style Sheets” on page 88.

* **Graph format override** specifies the graph format to use when generating the reports, regardless of the graph format indicated in the corresponding report definition. The available formats are ActiveX, PNG, or JAVA type images. A value is optional in this field, and the default value is blank. When this field is blank, the reports use the graph format that is specified in the report definition.

* **Location for graph applet jar files** specifies the path to the SAS code that is used only to render reports that are specified as Java reports. A value is optional in this field, and the default value is /sasweb/graph.

Any of the following location types are valid values for this field:

- a full URL on a specified server.
- a URL to a folder on all the clients where the Web browser was initiated (such as file://c:/programfiles/<folder name>).
- a relative URL to a folder on the middle tier where the graphs are installed (such as /<folder name>/<subfolder name>). The option to use only the relative path provides portability of this value. For example, if the name or location of the middle tier changes, the location value does not need to change as long as the folder names in the middle tier remain the same.

* **Location for ActiveX Control** specifies the path to the ActiveX Control, which is the software that displays an ActiveX graph. In most cases, the ActiveX Control is installed on your system. If it is not installed on your system, you can do one of the following actions:

  - Use the default path to install the control for you. The default path is specified as: /codebase/graph/v93/sasgraph.exe#version=9,3. This path points to a URL location on the SAS Web site from which the ActiveX Control can be installed.

    **TIP** Access to the Internet is necessary in order to install the ActiveX Control from the SAS Web site.

  - Enter the path to a location from which the ActiveX Control can be installed.

* **Override location for temporary physical files on server**

Temporary disk space is used to store reports that are generated by a report job. After the reports have been published to the SAS Content Server, these files and any associated folders are deleted. The default value for this field is blank.

If the override path exists and is specified, it is used as the location for the reports generated by the report job. If it is not specified or if it does not exist, the following paths are used, based on your operating environment:

- For Windows operating environments, SAS IT Resource Management uses one of the following paths to the temporary files. The path is selected from this list in the following order:

  - the value of the TEMP environment variable (for the user)
• the value of the TEMP environment variable (for the system)
• the value of the USERPROFILE environment variable
• .

For UNIX operating environments, the path is selected from this list in the following order:
• the value of the TEMP environment variable
• /tmp
• the value of the HOME environment variable
• .

For z/OS operating environments, the path is selected from this list in the following order:
• The value of the FILETEMPDIR option if it is specified, if it exists, and if FILESYSTEM=HFS
• /tmp
• .

Reset reinstates this parameter to the value that was established when SAS IT Resource Management was installed.

Note: If the macro variable ITRMDebug is set to a value of 1 in your report job, the files and any associated folders are not deleted.

The Report Parameters tab also enables you to reset the parameter values on the tab to their original default values. To do so, select Reset next to a specific field to reset the value for that parameter to the default value. Or, select Reset to defaults to reinstate the default value for all parameters on the tab.

8. On the Report Definitions tab, you can specify the report definitions and expiration date criteria for the reports that the transformation creates.

Display 7.8 Report Definitions Tab of a Gallery Transformation
The **Report Definitions** tab includes a Report Definitions table at the top of the page. This table provides a detailed list of the report definitions that the Gallery transformation uses to generate reports.

**Display 7.9  Report Definitions Table on the Report Definitions Tab**

This table includes the following parameters:

- **Report Definition Name** specifies the name of the report definition.

- **Report Definition Folder** specifies the folder where the report definition is stored.

- **Data Source Folder** specifies the folder where the data source for the report is located. If this field is blank, then the report job looks for the data source in the data path that is specified in the report definition or in the same IT data mart folder as the report job, respectively.

You can double-click a **Data Source Folder** cell to open the Select a Location dialog box. This dialog box enables you to navigate to and select a folder that contains the data source for the corresponding report definition.

For more information, see “Specifying a Data Source Location” on page 87.

The **Report Definitions** tab enables you to add report definitions to the Gallery transformation. To do so, perform the following steps:

a. Click **Add**. The Select Report Definitions dialog box appears.

b. Navigate to the report definition folders that corresponding to the adapter and domain category that you are using.

   The report definitions that the Adapter Setup wizard uses are in **Supplied** folders at Shared Data/SAS IT Resource Management/3.3 IT Report Definitions/<adapter>/<domain category>/Supplied/<time period (such as Day, Week, or Month)>.

   The report definitions that you have modified or created on your own are, by default, in **User Defined** folders at Shared Data/SAS IT Resource Management/3.3 IT Report Definitions/<adapter>/<domain category>/User Defined/<time period (such as Day, Week, or Month)>.

   **Note:** The supplied SAS Enterprise Guide projects that you can use to create your own report definitions provide this default location. However, you can specify a different location for the report definition. For best results, use the default **User Defined** folders as detailed above for consistency and efficiency.
The following display shows the supplied report definitions that the Adapter Setup wizard uses for Day reports of the Server Disk domain category of the DT Perf Sentry adapter.

**Display 7.10  Select Report Definitions Dialog Box**

![Select Report Definitions Dialog Box]

- c. Select one or more report definitions that you want to add to the Gallery transformation.
- d. Click **OK**. The report definition appears in the **Report Definitions** table at the top of the **Report Definitions** tab.

To remove a report definition from the **Report Definitions** table, perform the following steps:

- a. Select a report definition from the **Report Definitions** table at the top of the **Report Definitions** tab.
- b. Click **Remove**. The report definition is removed from the **Report Definitions** table.

The **Properties of report definition** box provides additional information about the report definition that is selected in the **Report Definitions** table.

**Display 7.11  Properties of Report Definition Box of the Report Definitions Tab**

<table>
<thead>
<tr>
<th>Properties of report definition:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Domain category: DTPerfSentry_ServerSystem</td>
</tr>
<tr>
<td>Schedule Frequency: Weekly</td>
</tr>
<tr>
<td>Keywords: Top</td>
</tr>
<tr>
<td>Data source: Weak/System</td>
</tr>
<tr>
<td>Report author: Supplied</td>
</tr>
</tbody>
</table>
Report definition names are unique within a domain category. However, they are not unique across all domain categories. The only means of distinguishing between two report definitions with the same name is by viewing their properties. You can use the information in the Properties of report definition box to confirm that you have selected the correct report definition for your report job.

Table 7.1 Properties of Report Definitions on the Report Definitions Tab

<table>
<thead>
<tr>
<th>Property</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data path</td>
<td>(Optional) Specifies the path to the data source.</td>
</tr>
<tr>
<td>Data source</td>
<td>Specifies the data source such as an information map. Verify that the data source is in the same folder as the report job. If it is not, verify that the data source is in the data path of the report definition or in the Data Source Folder of the Gallery transformation.</td>
</tr>
<tr>
<td>Domain category</td>
<td>Specifies the adapter and domain category for the report definition. For example, the value DTPerfSentry_ServerDisk indicates that the report definition corresponds to the Server Disk domain category of the DT Perf Sentry adapter. This value is a primary filter that is specified for the report definition in the ITRM Gallery task. Verify that the adapter and domain category is correct for the IT data that you are using and the reports that you want to create.</td>
</tr>
<tr>
<td>Domain subcategory</td>
<td>(Optional) Specifies the domain subcategory that corresponds to the domain category for the report definition. This value is a primary filter that is specified for the report definition in the ITRM Gallery task.</td>
</tr>
</tbody>
</table>
| Expire after        | Specifies the number of days that the corresponding reports are stored on the SAS Content Server before they are expired. If a report is expired and its report job is run again, the expired report is deleted and replaced with the new report.  

*Note:* The Override Expiration Date options in the Gallery transformation can override this value. |
<p>| Gallery task        | Specifies the name of the ITRM Gallery task that created the report definition. The ITRM Gallery task and the report definition have the same name. |
| Keywords            | Specifies the keywords that the report definition assigns to the reports that it creates. Keywords are primary filters that are specified for the report definition in the ITRM Gallery task. |
| Process flow        | Specifies the name of the process flow that includes the ITRM Gallery task that created the report definition. |
| Project             | Specifies the name of the SAS Enterprise Guide project that includes the ITRM Gallery task that created the report definition. |</p>
<table>
<thead>
<tr>
<th>Property</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Report author</td>
<td>Specifies the user ID of the person who created the report definition. If the value is <strong>Supplied</strong>, then the report definition was supplied by SAS IT Resource Management and is used by the Adapter Setup wizard.</td>
</tr>
</tbody>
</table>
| Schedule frequency | Specifies when the corresponding reports for the report definition should be scheduled to run. This value is a primary filter that is specified for the report definition in the ITRM Gallery task.  

*Note:* This value is a report filter in metadata only. It does not affect the schedule for the corresponding report job. However, for best results, you should schedule the corresponding report job to run according to this filter. For example, if the schedule frequency is **Weekly**, then schedule the report job to run weekly. |

For more information about the naming standards that SAS IT Resource Management uses for reporting components, see “About Naming Standards for SAS IT Resource Management Reporting Objects” on page 141.

The **Override Expiration Date** group box provides the ability to override the expiration date that is specified in the report definition.

**Display 7.12 Override Expiration Date Options on the Report Definitions Tab**

The following override options take effect the next time the report job is deployed and run.

- **Delete report content based on the expiration date in the report definition** causes the expiration date that is specified in the report definition to take effect. This option is the default.
- **Delete report content that is older than specified days** enables you override the expiration data that is specified in the report definition and enter the number of days that must elapse before the reports are deleted.

9. Click **OK**. The Gallery transformation icon in the process flow diagram of the report job appears with a green check to indicate that it is complete and ready for execution.

10. Deploy and run the report job. For more information, see “About Report Jobs” on page 69.

**Edit a Gallery Transformation**

To edit an existing Gallery transformation, perform the following steps:

1. In the **IT Data Marts** tree of SAS IT Resource Management, double-click the job that contains the Gallery transformation that you want to edit.

2. Right-click the Gallery transformation in the process flow diagram and select **Properties**. A Properties dialog box displays and enables you to modify the various
parameters that are specified for the Gallery transformation and the code that it generates.

For more information about the specific parameters that are available for configuration in the Gallery transformation, see the detailed steps in “Add a Gallery Transformation to a Report Job” on page 76.

3. Click **OK** to save your changes.

4. Deploy and run the report job. For more information, see “About Report Jobs” on page 69.

---

**Delete a Gallery Transformation**

To delete a Gallery transformation from a job, perform the following steps:

1. In the **IT Data Marts** tree in SAS IT Resource Management, double-click the job that contains the Gallery transformation that you want to delete.

2. Right-click the Gallery transformation in the process flow diagram and select **Delete**. The Gallery transformation object is deleted from the job.

3. Click **OK** to save your changes.

4. Deploy and run the report job. For more information, see “About Report Jobs” on page 69.

---

**Specifying a Data Source Location**

SAS IT Resource Management provides flexibility and portability of report jobs, Gallery transformations, and report definitions by enabling you to specify the location of the source data for a report in various ways.

Here are the ways that you can specify the data source location and how the report job uses these paths to find the data source:

- In the Gallery transformation and ITRM Gallery task, do not specify a data path.

If a data source location is not specified within the Gallery transformation or report definition from an ITRM Gallery task, then the report job looks for the data source in the same IT data mart folder as the report job. This is the default and recommended scenario.

**TIP** The Adapter Setup wizard stores data sources (or information maps) in the same folder as their corresponding report jobs. Thus, a Gallery transformation that the Adapter Setup wizard creates does not include values in the **Data Source Folder** column, and the report definitions that the Adapter Setup wizard uses do not include data path locations. For consistency and portability of your reporting components, save your information maps in the same folder as their corresponding report jobs and do not specify a data source location in your Gallery transformations or report definitions.

- In a Gallery transformation, specify a data path by using the **Data Source Folder** field for a report definition. For more information, see “Add a Gallery Transformation to a Report Job” on page 76.
If you enter a data path in this field, then the report job uses this path, regardless of whether a data source location is specified in the report definition from the ITRM Gallery task. If this field is blank, then the report job checks the corresponding report definition to identify a data source location.

The default value is blank.

- In an ITRM Gallery task, specify a data path by selecting Yes for the option Include data path in report definition. For more information, see “Create Report Definitions Using the ITRM Gallery Task” on page 61.

If you select Yes to include the data path in the report definition, then the path is hard coded with the report definition and the data path appears in the Properties of report definition box of the Gallery transformation. The report job uses this path, unless the corresponding Gallery transformation includes a value for the Data Source Folder that overrides the report definition.

By default, the ITRM Gallery task does not specify a data path in the report definition that it creates.

About Templates and Style Sheets

What Are Templates and Style Sheets

The visual appearance of the reports that SAS IT Resource Management creates is controlled by the following two style components:

- template
describes the default visual aspects (colors, fonts, lines, markers, and so on) of the report graph. The template resides on the server.

- style sheet
describes the default visual aspect of report elements that are outside of the graph area such as borders, banners, titles, footnotes, and so on. The style sheet is a *.css file that resides on the client workstation and on the middle tier.

SAS IT Resource Management provides a default template and style sheet for your IT reports. The Adapter Setup wizard and the supplied SAS Enterprise Guide projects use the default template and style sheet to specify the visual style of the reports that they create.

About the Default Template for SAS IT Resource Management Reports

SAS IT Resource Management provides a default template file named tmplitrmar.sasbim that includes a default template named ITRMDefault. This default template includes updates to a parent template called styles.analysis that SAS provides. These updates include specifications for graph colors in charts and plots.

During installation, SAS IT Resource Management saves the default template files and their source code in folders on the server tier.

Here are the locations of the source code for the templates, based on operating system:

- Windows: \sashome\SASFoundation\9.3\itrmmvadata\sasmisc
- UNIX: \sashome\SASFoundation/9.3/misc/itrmmvadata
• z/OS: &prefix.ITRM.CPMISC

Here are the locations of the template, based on operating system:
• Windows: <sashome>\SASFoundation\9.3\itrmmvadata\sashelp
• UNIX: <sashome>/SASFoundation/9.3/sashelp
• z/OS: &prefix.nnnn.SASHELP where nnnn is the country encoding. For example, if nnnn=ENW0 for English, then the location is &prefix.ENW0.SASHELP.

About the Default Style Sheets for SAS IT Resource Management Reports

Default style sheets for SAS IT Resource Management reports are named ITRMDefault.css. These style sheets include report specifications that are unique to SAS IT Resource Management. For example, the report banners represent SAS IT Resource Management and the title fonts as well as border colors complement the visual properties that are specified in the default template for SAS IT Resource Management reports.

SAS IT Resource Management provides two default style sheets. One style sheet specifies the properties for the reports that the supplied SAS Enterprise Guide projects generate. The other style sheet specifies the properties for batch reports. These two style sheets include identical specifications except for the report banner.

The default style sheet that is used in the supplied SAS Enterprise Guide projects includes a SAS IT Resource Management banner. This enables you to see the banner when you run reports interactively with SAS Enterprise Guide. This default style sheet is saved in the same location as the SAS Enterprise Guide style sheets on the client workstation. For example, for a Windows 32-bit system, the location for the style sheet is in the <SAS install location>\SAS\EnterpriseGuide\5.1\Styles folder (such as C:\Program Files\SAS\EnterpriseGuide\5.1\Styles for Windows).

Note: If you installed a version later than SAS Enterprise Guide 5.1, insert that version number in the previous two paths. For example, if you installed SAS Enterprise Guide 5.2, the location of the style sheet would be <SAS install location>\SAS\EnterpriseGuide\5.2\Styles.

The default style sheet that batch reports use is stored on the SAS Content Server, and it does not include specifications for a report banner. This enables the batch reports to be generated without a banner and thus be easier to view in the Gallery Manager. This version of the style sheet is saved in the Web application server directory on the middle tier at <Web application root>/SASContentServer/repository/default/sasdav/ITRM/styles/.

For more information about how to include your own corporate logo in a banner on an interactive style sheet, see the “Editing Styles: Using Background and Banner Images” topic in the SAS Enterprise Guide Help.
Working with Templates and Style Sheets

Overview

You can use the default templates and style sheets that SAS IT Resource Management provides or create your own. For best results, if you choose to create your own template or style sheet, use the defaults as a parent or model and make only the necessary adjustments for your custom needs.

TIP Before you modify a template, style sheet, or any other reporting component that SAS IT Resource Management provides, make a copy of the supplied component as a backup and modify the copy.

SAS IT Resource Management enables you to identify the templates and style sheets that you want to use for reports. However, these components are created and specified with other SAS products. For example, you can use Base SAS to create and specify a template by invoking and specifying the TEMPLATE procedure. You can use SAS Enterprise Guide to work with style sheets.

As you work with templates and style sheets for your IT reports, refer to the documentation in the appropriate SAS product for more information. For more information about how to work with templates, see the documentation for the TEMPLATE procedure in the SAS Output Delivery System: User's Guide at http:\support.sas.com. For more information about how to work with style sheets, see the Help for SAS Enterprise Guide.

Create or Specify a Different Template for Batch Reports

To create or specify a different template for batch reports, perform the following steps:

1. Use Base SAS to create a new template by modifying the template source file. For best results, save the new source file and template file with the new name in the same location as the default template at <SAS install location>
\SAS \SASFoundation\9.3\itrrmvdat\sasmisc (such as C:\Program Files\SAS\SASFoundation\9.3\itrrmvdat\sasmisc) and <SAS install location>\SAS\SASFoundation\9.3\itrrmvdat\sashelp.

   For more information about modifying a report template, see the documentation for PROC TEMPLATE at http:\support.sas.com.

2. Modify the Gallery transformation in your report jobs to specify the new template name.

3. Redeploy your report jobs.

Note: For best results, use the same template when working with SAS Enterprise Guide interactively. For more information about working with style sheets in SAS Enterprise Guide, see the Help for SAS Enterprise Guide.
Create or Specify a Different Style Sheet for Batch Reports

If you want to use a style sheet other than the one that is already specified in your report jobs, perform the following steps:

1. Make a copy of the default style sheet and use a text editor or SAS Enterprise Guide to modify the style sheet specifications. For more information about working with style sheets in SAS Enterprise Guide, see the Help for SAS Enterprise Guide.

2. Copy your new style sheet to one of the following supported locations:
   - the Web application server directory on your middle tier (such as `<webapp root>/SASContentServer/`).
   - a folder on all clients where the Web browser is initiated (such as `file://c:/programfiles/<folder name>/`).
   
   *Note:* For ease-of-use and portability of report jobs, use the Web application server location.

3. Modify the Gallery transformation in your report jobs to point to the new style sheet name and location.

4. Redeploy your report jobs

*Note:* For best results, use the same style sheet when working with SAS Enterprise Guide interactively. For more information about working with style sheets in SAS Enterprise Guide, see the Help for SAS Enterprise Guide.
Part 3

Viewing and Managing Batch Reports

Chapter 8

Working with the Gallery Manager ........................................ 95

Chapter 9

Working with the SAS Content Server ................................. 109
Chapter 8
Working with the Gallery Manager

What Is Gallery Manager?

Gallery Manager is a Web application that is available with SAS IT Resource Management. This application enables users to view, organize, filter, save, and e-mail SAS IT Resource Management reports. You can use Gallery Manager to group reports into galleries and then further filter or subset the reports for viewing.

Gallery Manager enables you, based on your login permissions, to designate gallery folders as public or private. These settings control who has access to the gallery folders and galleries that you create. You can save reports as Favorites and keep them for viewing later or e-mail them to others.
How to Get Help and Documentation for Gallery Manager

This chapter provides a brief overview and introduction to the Gallery Manager. However, more documentation is available for this application.

You can use the following two types of documentation to find more information about the features, benefits, and capabilities of the Gallery Manager:

Embedded Help

Help pop-ups and tooltips provide brief descriptions of various tasks and fields to help you use Gallery Manager effectively.

To access a Help pop-up for more information about a current topic, click the Help icon (<?> when it appears next to a field or area in the user interface. You can also place the mouse pointer over an element in the user interface to view the associated tooltip for more information.

SAS IT Resource Management: Gallery Manager User's Guide

This document, available as a PDF file, provides detailed information about the concepts and tasks that are related to using Gallery Manager. To access this document, click Help ÷ User's Guide (PDF) in the application.

Additional documentation and references are also available from the Help menu in Gallery Manager. To access these resources, click Help in the Gallery Manager application and select from the following menu options:

- SAS on the Web includes the following two help options:
  - About IT Resource Management — Gallery Manager provides more information about the version of the application and related details.

How Gallery Manager Works

Organizing Reports

You can organize SAS IT Resource Management reports with the following two components:

- Galleries

A gallery is a group of reports that share common filter values. You can organize SAS IT Resource Management reports by creating a gallery that includes all of the reports that meet a specific criterion. For example, you might create a gallery to
include all available reports for a particular machine, adapter data source, or keyword.

Gallery Manager also enables you to further subset or filter the reports in a gallery for viewing. Thus, you can quickly view a smaller set of reports in a gallery to measure and analyze the utilization, availability, performance, and statistical trends of IT resources for your enterprise.

- Gallery Folders

A gallery folder is a container for galleries and other gallery folders. These folders function like typical folders in a tree. You can use these folders to group related galleries and gallery folders. For example, you might create a single gallery folder to include all of your galleries for DT Perf Sentry reports.

### Viewing Reports

Gallery Manager provides three gallery views that enable you to view and sort the reports in different ways:

- **The Table view** displays the reports and their associated metadata in a grid. You can quickly scan these reports for similarities and double-click an individual report to view a large image of it in a separate browser window.

  **Display 8.1  A Gallery in the Table View**

  ![Table View](image)

- **The Thumbnail view** displays a thumbnail of each report and enables you to minimize, expand, and arrange the reports in the gallery.
Display 8.2  A Gallery in the Thumbnail View

• The Flow view displays the reports as moveable pages so you can navigate through a sequence of reports that are stacked together.

Display 8.3  A Gallery in the Flow View
Copying and E-mailing Reports

Gallery Manager enables you to copy reports of particular interest into **Favorites** folders. Until deleted manually, report copies in the **Favorites** folders are saved on the SAS Content Server in a physical folder that is unique to each Gallery Manager user. The report copies in the **Favorites** folders are not purged, expired, or updated as part of any subsequent executions of their associated report jobs. You can e-mail the reports that are in **Favorites** folders.

The Gallery Manager Interface

Log On as a Registered User

To log on to Gallery Manager, perform the following steps:

1. In the address bar of your Web browser, enter the URL for Gallery Manager and press ENTER. The logon window for Gallery Manager appears.  
   
   **Note:** Contact your system administrator if you do not have the URL for Gallery Manager.

   ![Display 8.4 Gallery Manager Log On Window](image)

2. Enter a user ID and password. Your user ID might be case-sensitive, depending on the operating system that is used to host the application server. Your password is case-sensitive.

3. Click **Log On**. The Gallery Manager interface appears.

Your First Look at the Gallery Manager Interface

The Gallery Manager interface is divided into several parts that enable you to manage your gallery folders and galleries. The following image shows a Gallery Manager interface and its five primary parts:
1. Gallery Manager banner
2. Browse pane
   Note: The Filters pane (not shown above) also resides in this area of the Gallery Manager interface. When you select a gallery in the Browse pane, you can use the icons at the top of the pane to toggle back and forth from the Browse pane to the Filters pane.
3. Gallery pane
4. Favorites pane
5. Status bar
   Note: Each pane includes an Action button that provides task options that are related to the objects in the pane.

**Gallery Manager Banner**

The Gallery Manager banner provides identifiers (the application name and SAS logo), a link to more Gallery Manager documentation, and the **Log Off** option. These features help you identify and use the application effectively.

**Browse Pane**

The Browse pane, located on the left side of the Gallery Manager interface, includes a tree view of gallery folders and galleries that you can browse and navigate. This pane appears by default when you open the Gallery Manager.
The Browse pane consists of a tree view that has the following two main folders:

- **My Galleries** contains folders and galleries that a user creates and defines. The content of the **My Galleries** folder is different for each individual user based on the gallery folders and galleries that the user creates.

  *Note:* A **My Galleries** folder is not available to users who are not members of the IT Resource Management Administrator or IT Resource Management User groups.

- **Public Galleries** contains folders and galleries that are designated as public. All Gallery Manager users can see the folders and galleries in the **Public Galleries** folder.

The Browse pane shares space with the Filters pane. The icons at the top of these panes enable you to toggle back and forth from the Browse pane to the Filters pane. If the Filters pane is visible, then click the Browse icon () to view the Browse pane.

**Filters Pane**

The Filters pane, located on the left side of the Gallery Manager interface, enables you to subset the view of reports in a gallery by one or more criteria. This process reduces the number of reports that are shown in the Gallery pane so that you can limit the display to those specific reports that meet the filter criteria that you specify.

To access the Filters pane, select a gallery in the Browse pane and then click the Filters icon ().
The Filters pane shares space with the Browse pane. The icons at the top of these panes enable you to toggle back and forth from the Filters pane to the Browse pane.

**Gallery Pane**

The Gallery pane is the center pane of the Gallery Manager interface. This pane enables you to view the details about the gallery folders and galleries that you select in the Browse or Favorites panes. The Gallery pane also enables you to view the reports that you select in a gallery.

The information in the Gallery pane varies based on whether you select to view gallery folders, a gallery, or a report. Here are the ways that the Gallery pane displays information based on the object that you select:
• If you select a gallery folder in the Browse pane, then the Gallery pane displays the name of the gallery folder in its banner. The Gallery pane also displays the next level of gallery folders or galleries that the selected folder contains.

In the following example, the My Galleries folder is selected in the Browse pane. This folder’s first level of contents (the Sample Reports gallery and the DEVA Machine Galleries folder) is displayed in the Gallery pane.

Display 8.7 Contents of a Gallery Folder Displayed in the Gallery Pane

• If you select a gallery in the Browse pane, then the Gallery pane displays the name of the gallery in its banner. The Gallery pane also displays information about each report in the gallery or each report that meets the filter criteria that you specified on the Filters pane. The status bar provides the number of reports that are available in current instance of the Gallery pane.

The Gallery pane provides three formats for viewing reports. You can click one of the View icons at the top of the Gallery pane to select the view that you want to use when viewing the reports. In each view, you can double-click any report to open it in a separate browser window.

Display 8.8 View Icons in the Gallery Pane

Here are the three views that the Gallery pane provides for viewing the reports in a gallery:

• **Table view** displays a list or grid of the reports. This is the default view.

The following image shows a gallery named My Sample Reports in the banner and the associated reports in the gallery are listed in the Table view.
Display 8.9  A Gallery Displayed in the Table View

- **Thumbnail view** displays small images or thumbnails of the reports. The following image shows a gallery named **My Sample Reports** in the banner and the associated reports in the gallery are displayed in the Thumbnail view.

Display 8.10  A Gallery Displayed in the Thumbnail View

- **Flow view** displays images of the reports in a stacked sequence. The following image shows a gallery named **My Sample Reports** in the banner and the associated reports in the gallery are displayed in the Flow view.
Favorites Pane

The Favorites pane is located on the right side of the Gallery Manager interface. It contains copies of the reports that you choose to save for your personal records or to e-mail others. The Favorites pane enables you to create and name Favorites folders. In these folders, you can organize and store the report copies that show data of a particular interest.

Display 8.12  Favorites Pane

Status Bar

The status bar, located at the bottom of the Gallery Manager interface, displays the user ID that is logged on the application. This bar also displays various messages that relate to the current processes, views, or user actions that are running on the application.
For example, the following status bar provides the number of reports that are contained in the selected gallery and the current user ID that is logged on the application.

Display 8.13 Status Bar

| Selected gallery has fetched 741 reports | Logged in as admadm |

**Action Buttons**

Each pane of the Gallery Manager includes an *Action* button. This button enables you to perform tasks that are related to the given pane. The options that are available for each *Action* button vary based on the permissions of the user, the pane where the button resides, and the capabilities of the selected objects in the respective pane. For example, the *Action* button for the Browse and Filters panes enables you to perform the following tasks that are related to gallery folders and galleries:

- Create a new gallery folder or gallery.
- Edit, copy, or delete a gallery folder or gallery.
- Mark a gallery folder as public or private.

*Note:* This option is available only if the selected gallery folder is in the first level of the *My Galleries* folder.

These options vary based on the current Gallery Manager selections. For example, if nothing is selected in the Browse pane when you click the *Action* button in that pane, then the *Edit, Copy, Delete, Public, and Private* options are not available.

In addition, the *Action* buttons in other panes enable you to perform different tasks that are related to their respective pane. For example, the *Action* button in the Favorites pane provides task options that are related to Favorites folders and reports.

**Sample Reports**

During the SAS IT Resource Management installation, 30 sample reports are saved on your SAS Content Server. These reports provide an example of the different types of reports that SAS IT Resource Management can create. They also enable you to practice using Gallery Manager before you have generated your own reports.

To create a gallery of these sample reports, perform the following steps:

1. Open Gallery Manager.
2. In the Browse pane, click the arrow next to the *Action* button and select *New Gallery*.
3. Enter a *Name* and *Description* for the new gallery.
4. Click *Next*.
5. Click the arrow next to *Keywords* to expand the folder.
6. Select *ITRMDomainIntelligence* and click the right arrow to move this selection to the *Selected Items* list.

*Note:* All sample reports include the keyword *ITRMDomainIntelligence*. If this keyword does not appear as an available option in your Gallery Manager session, then the sample reports are no longer on your SAS Content Server. For
information about how to delete the sample reports, see “Delete Sample Reports” on page 111.

7. Click **Finish** to create the gallery.
Chapter 9
Working with the SAS Content Server

About the SAS Content Server

What Is the SAS Content Server?

The SAS Content Server, a Web-based Distributed Authoring and Versioning (WebDAV) server, is a content repository that stores digital content (such as documents, reports, and images) that is created and used by several SAS client applications. SAS IT Resource Management, and other SAS products such as SAS Web Report Studio and SAS Information Delivery Portal, use SAS Content Server for storage of their reports and supporting files.

How Does SAS IT Resource Management Use the SAS Content Server?

SAS IT Resource Management uses the SAS Content Server to store reports and report metadata that is the output of report jobs.

SAS IT Resource Management enables you to create report jobs with the Adapter Setup wizard or manually. These report jobs include Gallery transformations that specify the repository folder path, relative to the SAS Content Server, in which to store the reports. When these report jobs run, the resulting report outputs are considered batch reports. These reports are generated and stored on the SAS Content Server in corresponding subfolders of the `sas dav/ITRM` folder.

The default folder path that SAS IT Resource Management uses to store the report output corresponds to the project name, process flow name, and ITRM Gallery task name that are associated with the report. For example, the Adapter Setup wizard stores reports in the following standard location on the SAS Content Server: `sas dav/ITRM/`
How Gallery Manager Uses the SAS Content Server

Gallery Manager reads the IT reports that are stored in the SAS Content Server, enabling you to view and manage all of the reports that are stored within the ITRM folder. Gallery Manager connects to the ITRM folder on the SAS Content Server and stores each of the reports within that folder in a cache memory for easy retrieval. When you use the Gallery Manager to create a gallery or view available reports, the Gallery Manager enables you to view and work with all of the reports within the ITRM folder.

Working with the SAS Content Server

Overview of Working with the SAS Content Server

Gallery Manager enables you to view and work with the SAS IT Resource Management reports that are on the SAS Content Server. However, if you are a system administrator, then you might need to clean up and delete reports folders that are no longer in use. For example, although report jobs purge old reports by default, some report jobs might be discontinued and become obsolete. In this case, you might delete these reports manually.

CAUTION:
Do not delete the ITRM folder or the styles folder in the SAS Content Server. SAS IT Resource Management and the Gallery Manager use the ITRM folder to store and retrieve IT reports. SAS IT Resource Management reports use the ITRMDefault style sheet that is stored in the styles folder. If you remove the ITRM folder, then the Adapter Setup wizard report jobs no longer work and the Gallery Manager cannot start. If you remove the styles folder, then your reports might lose their SAS IT Resource Management styles.

For more information about working with the SAS Content Server, see the chapter about administering the SAS Content Server in the SAS Intelligence Platform: Web Application Administration Guide.

How Does the Gallery Manager Cache Work?

Gallery Manager enables you to access, view, and manage all of the SAS IT Resource Management reports that are stored within the ITRM folder or its subfolders. Gallery Manager scans the ITRM folder on the SAS Content Server to retrieve report metadata.
that it stores in cache memory. Using this cache enables Gallery Manager to retrieve reports from the SAS Content Server more quickly.

The Gallery Manager cache is updated during the following events:

- when the Gallery Manager starts.
- when a SAS IT Resource Management report job is run.
- when you force a Gallery Manager cache update. To do so, enter `http://<YourMidTierName>:<port number>/ITRMGalleryManager/WebdavUpdate.do?job=job1&status=COMPLETED` in the address field of your Web browser and press ENTER.

When the Gallery Manager cache is being updated, a message appears at the bottom of the user interface.

**Tip** For best results, make sure that the cache update is invoked when users are not logged on to Gallery Manager.

### Back Up Reports on the SAS Content Server

To back up your SAS IT Resource Management reports, you must back up the SAS Content Server that stores the reports. If you are a system administrator, then back up the SAS Content Server before you manually delete any reports from the SAS Content Server.

For more information about backing up reports, see Appendix 10, “Best Practices and Troubleshooting Tips” in the *SAS IT Resource Management: Administrator's Guide*.

### Delete Sample Reports

SAS IT Resource Management provides 30 sample reports during installation. These sample reports provide examples of the type of reports that SAS IT Resource Management provides. They also enable you to see how the Gallery Manager works before you begin processing your own data. For more information, see “Sample Reports” on page 106.

After you have viewed the sample reports and have generated your own reports, you might choose to delete these sample reports from the SAS Content Server if you no longer need them. You can do so from the SAS Content Server Admin Console, which is located at `http://<YourMidTierName>:<port number>/SASContentServer/dircontents.jsp?path=/sas dav/ITRM`. The sample reports are in a folder called `SampleReports`. For more information, see the chapter about administering the SAS Content Server in the *SAS Intelligence Platform: Web Application Administration Guide*.

If you remove reports manually from the SAS Content Server, be sure to refresh the cache. To perform this task, enter `http://<YourMidTierName>:<port number>/ITRMGalleryManager/WebdavUpdate.do?job=job1&status=COMPLETED` in the address field of your Web browser and press ENTER.

**Tip** For best results, make sure that the cache update is invoked when users are not logged on to Gallery Manager.
Part 4

Interactive Reporting and Using the SAS Portal and SAS BI Dashboard

Chapter 10
About Interactive Reporting ........................................... 115

Chapter 11
Using SAS Enterprise Guide Interactively .......................... 117

Chapter 12
Using SAS Web Report Studio Interactively ......................... 121

Chapter 13
Using SAS Add-In for Microsoft Office Interactively .............. 127

Chapter 14
Using SAS Portal for Communicating IT Domain Intelligence .... 131

Chapter 15
Using SAS BI Dashboard ................................................. 135
Chapter 10
About Interactive Reporting

Overview of Interactive Reporting

The recommended method for generating, managing, and viewing SAS IT Resource Management reports is to run the report jobs that were created by the Adapter Setup wizard or by user-specified Gallery transformations. The report jobs are typically run in batch mode and the resulting reports are managed and viewed in Gallery Manager. However, there are situations that require reports to be generated interactively (for example, when performing specific IT performance analysis or when developing a new report). SAS provides the following solutions that enable you to run or view reports interactively:

• SAS Enterprise Guide
• SAS Web Report Studio
• SAS Add-In for Microsoft Office
• SAS Information Delivery Portal
• SAS BI Dashboard

These solutions are discussed briefly in the following chapters of this reporting guide.
Chapter 11
Using SAS Enterprise Guide Interactively

Overview of SAS Enterprise Guide

What Is SAS Enterprise Guide?

SAS Enterprise Guide is a Microsoft Windows client application that provides a guided mechanism to exploit the power of SAS. SAS Enterprise Guide uses projects to manage a collection of related data, tasks, code, and results. With projects, you can run multiple tasks on the same group of data files and create interactive or ad hoc reports.

All report definitions that are supplied by SAS IT Resource Management were generated using SAS Enterprise Guide projects similar to those that SAS IT Resource Management provides. For more information, see “SAS Enterprise Guide Projects Supplied by SAS IT Resource Management” on page 46.

SAS Enterprise Guide provides comprehensive report definition and reporting services that SAS IT Resource Management uses to generate analysis and intelligence about your IT resources. Report definitions can be run interactively within SAS Enterprise Guide, or they can be packaged using the ITRM Gallery task and scheduled to run in batch mode. For more information about report definitions and the ITRM Gallery task, see “About the ITRM Gallery Task” on page 59.

How to Start SAS Enterprise Guide


The Welcome to SAS Enterprise Guide dialog box appears.
You can select any of the options in the Welcome window.

Note: Make sure you have access to the project that you want to work with.

**Accessing IT Data Marts Using SAS Enterprise Guide**

Before you begin working with SAS Enterprise Guide projects, you must use the functions of SAS Enterprise Guide in order to perform the following tasks:

- Set up SAS Enterprise Guide so that it can work with SAS IT Resource Management data.
- Migrate SAS Enterprise Guide projects so that they can work with your SAS IT Resource Management 3.3 IT data marts, in which you created the report data

For more information about how to complete these tasks, see “Preparing to Work with SAS Enterprise Guide” on page 50.

**Accessing SAS IT Resource Management Projects with SAS Enterprise Guide**

The report projects that are supplied by SAS IT Resource Management are available on each client where SAS IT Resource Management is installed. They can be accessed by navigating to the location where you installed SAS IT Resource Management. The projects are located at `SASITResourceManagementSASEnterpriseGuideComponents\3.3`. For example, if you installed SAS IT Resource Management on a 64-bit machine, the projects might be located at `C:\Program Files\SASHome\x86\SASITResourceManagementSASEnterpriseGuideComponents\3.3`.

Only copies of those projects that are supplied by SAS IT Resource Management should be edited. Copy the projects to a location on your client and then work with those
projects by navigating to them in the Server List window. Then, double-click the project to open it.

Note: If the Server List window is not displayed on your desktop, click View on the SAS Enterprise Guide menu bar. From the drop-down list, select Server List.


---

**Locating SAS Enterprise Guide Documentation**

From the menu bar of SAS Enterprise Guide, you can click Help to access the Help and a getting started tutorial. You can also access the following resources by selecting Help ⇒ SAS on the Web:

- the home page for SAS Enterprise Guide
- the product documentation page for SAS Enterprise Guide
- SAS online resources for statistics education
- SAS Technical Support resources
- the form for submitting feedback about any SAS product
- hotfixes for SAS Enterprise Guide
- the SAS home page

These Web pages open in your default Web browser.

For information about administrative tasks that are associated with SAS Enterprise Guide, use the A-Z index at [http://support.sas.com/documentation/index.html](http://support.sas.com/documentation/index.html) to locate the documentation that is available for this product.
Overview of SAS Web Report Studio

About SAS Web Report Studio

SAS Web Report Studio is a Web-based query and reporting application that is provided by the business intelligence components of the SAS Intelligence Platform. It is designed for users who want to generate reports, view them, and share them with others on the Web. The application provides several ways to create reports by using a wizard and templates. It can also execute stored processes.

SAS Web Report Studio uses as its reporting data source information maps that translate technical data structures into user-friendly business terminology. Specific to SAS IT Resource Management, information maps are supplied for most aggregated tables and can be created for any other tables available in the IT data mart. Information maps can be created through the SAS IT Resource Management Information Map transformation that is available from the SAS IT Resource Management client or directly through SAS Information Map Studio.

Log On to SAS Web Report Studio as a Registered User

To log on to SAS Web Report Studio, perform the following steps:

1. To display the SAS Web Report Studio logon window, click on the URL that is supplied by your system administrator or paste it into the address field of your browser. For example, you might enter http://server01.abc.com:8080/SASWebReportStudio. The following window appears.
2. In the **User name** field, enter your user ID.

   In the **Password** field, enter the password for the user ID that you just entered.

   *Note*: Your password is case-sensitive. Your user ID might be case-sensitive, depending on the operating system that is used to host the Web application server. If you need assistance, contact your system administrator.

3. Click **Log On**.

   The following display shows the SAS Web Report Studio window that appears after you log on.
The following actions, which correspond to the numbers on the preceding display, can be invoked from this window:

1. Click **Log Off** to exit SAS Web Report Studio. When you select log off, you are logged off all environments, including the SAS OLAP server and other Web environments.

2. Click **Preferences** to personalize your use of SAS Web Report Studio.

3. Select the **Help** menu to get help on using SAS Web Report Studio.

4. Click **New report** to create a new report using the **Edit** tab.

5. Click **New using Report Wizard** to access the Report Wizard. The wizard guides you in defining a query; selecting a table and graph for the layout; and adding optional features such as group breaks, a header, and a footer.

6. Click **New using Template** to access the Select a Template dialog box. When you select a template, you start creating your report with a predefined layout.

7. Click **More Reports** to access the Open dialog box. The **Open** dialog box enables you to search for reports, and it lists reports, stored processes, folders, and information maps.

8. Click **Open** to access the **Open** dialog box. The **Open** dialog box enables you to search for reports, and it lists reports, stored processes, and folders.

9. Click **New** to create a new report using the **Edit** tab.

10. Select the **File** menu to access task options, such as **Open and Manage Files**.

*Note:* For more information about these actions, see the *SAS Web Report Studio: User’s Guide*. 
Access SAS IT Resource Management Information Maps to Generate a Report in SAS Web Report Studio

To create a report by using SAS Web Report Studio with an information map as the data source, perform the following steps:

1. From the menu bar of the Welcome window of SAS Web Report Studio, select File ➪ Open. Alternatively, you can click Open on the Welcome window.

   The Open dialog box is displayed.

   **Display 12.2  The Open Dialog Box**

   ![Open Dialog Box](image)

   2. You can search in Shared Data/SAS IT Resource Management/IT Data Marts for the information map that you want to use as the data source. To navigate through these folders, select the folder and click Open. Alternatively, you can double-click the folder to display its contents.

   3. Double-click the information map in the Open dialog box. The new report opens in View mode.
Note: When the information map is run, it accesses the corresponding data items that are in the source tables of aggregation data that are the input to the job that generated the information map.

---

E-mailing SAS IT Resource Management Reports

Reports can be shared with others or kept in private folders based on security settings. Certain pages of reports can be distributed to authorized users via e-mail. For information about how to e-mail reports, see Chapter 25, “Sharing Reports” in the SAS Web Report Studio: User's Guide.

---

Locating SAS Web Report Studio Documentation

There are two ways to access Help from within SAS Web Report Studio:

- Select Help ⇒ Contents or Help ⇒ Using this Window.

  Note: The Contents tab enables you to access the SAS Web Report Studio: User's Guide.

- Click Help, which is available from any SAS Web Report Studio dialog box or wizard page.

For information about administrative tasks that are associated with SAS Web Report Studio, use the A-Z index at http://support.sas.com/documentation/index.html to locate the documentation that is available for this product.
Chapter 13
Using SAS Add-In for Microsoft Office Interactively

SAS Add-In for Microsoft Office and SAS IT Resource Management Data . . . . 127
   About SAS Add-In for Microsoft Office .................................................. 127
   How to Access SAS Add-In for Microsoft Office ........................... 127
Using SAS Add-In for Microsoft Office to Access SAS IT
   Resource Management Data ................................................................. 128
     Use SAS Tools to Analyze Your Data in Microsoft Excel .................... 128
     Create Stored Processes ................................................................. 129
     Execute a Stored Process from SAS Add-In for Microsoft Office .......... 129
     Publish Results to a Central Location ............................................... 130
     Locating SAS Add-In for Microsoft Office Documentation ................... 130

SAS Add-In for Microsoft Office and SAS IT Resource Management Data

About SAS Add-In for Microsoft Office
The SAS Add-In for Microsoft Office extends the functionality of Microsoft Excel, Microsoft Word, and Microsoft PowerPoint by enabling you to access SAS analytics and SAS reporting functionality without any SAS programming experience.

The SAS add-in includes approximately 80 SAS tasks that enable you to perform a variety of analyses. Examples of analyses that you can perform include linear and nonlinear regressions, multivariate analyses, time series analyses, one-way frequencies, and summary statistics. The SAS add-in enables you to refresh these analyses so that your results include the most up-to-date information. You can also easily share the results with others at your site.

How to Access SAS Add-In for Microsoft Office
As the SAS IT Resource Management client is installed, the SAS add-in is installed on your computer. As such, a SAS tab is automatically integrated into the Ribbon in Microsoft Excel, Word, and PowerPoint 2010. The SAS tab enables you to access SAS analytics and reporting functionality directly from these Microsoft Office programs without having to open a separate SAS interface.

When you select the SAS tab from the Microsoft Excel menu bar, the Ribbon menu bar with SAS options and functionality is displayed:
As shown in the following two displays, similar functions and options are available when the SAS tab is selected from the menu bars of Microsoft Word and Microsoft PowerPoint.

**Display 13.2  SAS Tab Functionality in the Microsoft Word Ribbon**

**Display 13.3  SAS Tab Functionality in the Microsoft PowerPoint Ribbon**

*Note:* The instructions and screenshots in this chapter are specific to Microsoft Office 2007-2010. If you are using Microsoft Office 2000-2003, you can perform the tasks described in this chapter. However, the SAS options are located in the SAS menu rather than the SAS tab.


---

**Using SAS Add-In for Microsoft Office to Access SAS IT Resource Management Data**

**Use SAS Tools to Analyze Your Data in Microsoft Excel**

When you open Microsoft Excel 2010, you should see a SAS tab in the Ribbon. You access the SAS add-in from the menu options on this tab.

You can perform a variety of tasks using the SAS add-in. The following process briefly explains how you would run a SAS analysis:

1. Open Microsoft Excel.

2. Select the data source that you want to work with. In Excel, you can use data in an existing Excel worksheet or in a SAS data source. If you select a SAS data source, you can choose to filter and sort the data before the analysis.

   *Note:* If the SAS data source is open in an Excel worksheet, then the task uses the filter and sort criteria that you specified when opening the data source.

3. Select the analysis that you want to perform.
Note: After you select the analysis, you might be prompted to log on to the SAS server if you have not previously logged on during the current session. You must be connected to a SAS server to run an analysis or to access a SAS data source.

4. Select the options in the analysis that you want to use and then run the analysis.

5. Specify the location of the output. For example, in Excel, you can choose to include the results in the existing worksheet, in a new worksheet, or in a new workbook. The results automatically open in Excel in the location that you chose.

Note: The SAS add-in is also available in Microsoft Word and PowerPoint.

Create Stored Processes

SAS Add-In for Microsoft Office enables users to run stored processes and customize the appearance of results that are returned by Microsoft Word or Microsoft Excel. A stored process is a SAS program that is hosted on a server and described by metadata. Stored processes can be written by anyone who is familiar with the SAS programming language or with the aid of a SAS code generator such as SAS Enterprise Guide. The basic steps to creating a stored process are as follows:

• Write the stored process.
• Choose or define a server.
• Register the metadata.

For information about how to perform these steps to create a stored process, see the SAS 9.3 Stored Processes: Developer’s Guide, which can be found at http://support.sas.com/documentation/index.html. Use the A-Z index to locate this documentation.

Execute a Stored Process from SAS Add-In for Microsoft Office

To run a stored process from SAS Add-In for Microsoft Office, perform the following steps:

1. If you are using Microsoft Office 2007-2010, select the SAS tab in the Ribbon.
   If you are using Microsoft Office 2000-2003, select SAS ⇒ Reports.
   The Reports window appears.

2. Select the stored process that you want to run and click Open. If the stored process that you want to run is not available, you might want to refresh your list of stored processes.
   Note: You can also run the stored process by right-clicking the stored process and selecting Open from the pop-up menu.

3. Specify information for any prompts that appear. These prompts for user-supplied values are defined when the stored process is created.

After you have specified values for any required parameters, the results of the stored process open in the worksheet, document, or presentation.

Note: If the stored process produces streaming results and your image format is not set to ActiveX, then any graphs that the stored process generates cannot be displayed. For more information, see the Help for SAS Add-in for Microsoft Office.
Publish Results to a Central Location

By publishing a document, you can share it with others without having to e-mail it. If you publish the document to a metadata repository, then you can perform an impact analysis on the document. Impact analysis enables you to see where a data source came from and the items that are dependent on this source. This analysis enables you to know how changing a data source might affect other documents.

Note: To publish a document, the SAS support personnel at your site must have installed SAS Web Report Studio on the same metadata server.

Locating SAS Add-In for Microsoft Office Documentation

From the SAS Ribbon bar of Microsoft Word, Excel, or PowerPoint, you can click Help to access the SAS Help for the products that are included in SAS Add-In for Microsoft Office. In addition, SAS Add-In for Microsoft Office: Getting Started with Data Analysis can be found at http://support.sas.com/documentation/index.html.

Use the A-Z index to locate the documentation that is available for this product.
Chapter 14
Using SAS Portal for Communicating IT Domain Intelligence

Overview of SAS Information Delivery Portal

About SAS Information Delivery Portal

The SAS Information Delivery Portal (or simply, the portal) is a Web application that provides a single, easy-to-use interface from which you can access a broad range of enterprise information. This information includes reports, charts, Web applications, documents, and links to internal or external Web pages. The portal gives you access to information that is produced through the analytical capabilities of SAS, and provides a single access point to SAS output.

Your organization can use the portal to deliver important and timely business intelligence efficiently to employees, customers, partners, and vendors. The portal provides a secure environment for your business intelligence so that users see only the information that they have security rights to access.

The portal's personalization features enable you to create and customize your own Web pages and content. You can organize your personal portal so that it contains only the information that you need, in the format that makes the most sense to you. From the portal, you can subscribe to publication channels that deliver continually updated information to your desktop. The portal also provides a secure environment for sharing information with other users.

How to Access SAS Information Delivery Portal

To open the SAS Information Delivery Portal, open your Web browser and point it to the portal's URL address. To obtain the URL, contact your administrator.

To identify yourself to the portal, you must log on with your user name and password. (If you do not have a user name and password, contact your administrator to obtain them.)
After you log on, you can do the following tasks:

• Personalize your view of the portal by adding pages, portlets, and content items and modifying or rearranging them to meet your unique needs. Each time you log on, your own personalized view of the portal is displayed.

• Search for and view protected content that your user name and password authorize you to access.

• Launch other applications that might be available from the portal, without the need to re-enter your user name and password.

The logon procedure varies depending on how your organization has installed the portal. Use either the portal logon procedure or the Web server logon procedure, as appropriate.

• If your organization uses the portal’s logon feature, open your browser and point to the portal’s URL. When the portal's logon page appears, enter your User Name and Password. Then click Log On to open your personal portal.

• Organizations that use the Web Server Logon, have different logon procedures. After you have logged on to the Web server, open your personal portlet by pointing your browser to the portal's URL.

Note: The portal supports only one user session per browser instance. Different portal users can have different sessions in separate browser instances, but not in separate tabs in the same browser instance.

**How to Log Off from the Portal**

When you are finished using the portal, you should log off in order to close your portal session. Logging off releases the system resources that you were using. (Your portal session continues to use system resources until the session expires, even if you closed the browser window.)

To log off, click Log Off in the banner. Then close the browser window.

**How to Content Is Organized in the Portal**

The following figure is an example of a portal.

Note: Your organization might customize the portal so that it looks different from the example shown here.
The navigation bar contains links for your portal Web pages. You open a different page by clicking its name in the navigation bar. In the display, the portal's Home page is the active Web page. Notice that the Home link is highlighted on the navigation bar.

Portlets are the rectangular display components of a portal page that contain links, graphs, reports, and other information that is available in the portal. You can edit the contents of some portlets. To edit, remove, or minimize a portlet, use the icons in the portlet title bar.

The banner provides links that enable you to customize your portal and personalize your portal by means of the Options button. The banner also provides search, log off, demonstration, and help features.

The portal links enable you to view information or launch applications that are available to you through the portal by clicking any active link that is displayed inside a portlet.

For information about the type of content that the portal can contain and how to add, view, and manage the portal's content, see the documentation that is available for SAS Information Delivery Portal.
Locating SAS Information Delivery Portal Documentation

To access Help from within SAS Information Delivery Portal, click Help in the banner.

For more information about SAS Information Delivery Portal, use the A-Z index at http://support.sas.com/documentation/index.html to locate the documentation that is available for this product.
Chapter 15
Using SAS BI Dashboard

Overview of SAS BI Dashboard

About SAS BI Dashboard

Log On to SAS BI Dashboard

Locating SAS BI Dashboard Documentation

Overview of SAS BI Dashboard

About SAS BI Dashboard

Dashboards provide a way to view data. Users can quickly view critical information in a compact, easy to interpret interface. Dashboards can display key performance indicators in one place to help users monitor information throughout an enterprise. By using the new dashboard designer and dashboard viewer, you can create a single dashboard that contains multiple indicators instead of creating a portal page with multiple dashboard portlets. Coordinating the look and feel of your dashboard and indicators is easier than ever.

A dashboard is a container that is nested within a portlet and that contains one or more indicators. An indicator is a composite of one or more related objects. Each indicator has a data source, one or more gauges, hyperlinks to additional information, and range settings for the gauges. Dashboards display critical information in such a way that the information can be interpreted and monitored at a glance. Dashboards can also contain links to other pertinent information, important summary and highlights, and personalized information such as weather, news, and stock news. Here is an example dashboard that contains three dashboards that use different data sources:
The SAS BI Dashboard enables users to use dashboards to monitor key performance indicators that convey how well an organization is performing. As shown in the preceding display, dashboards include graphics, text, colors, and hyperlinks. The preceding dashboard shows multiple indicators, each with its own data model underneath. These indicators are driven by six different SQL queries, but the data models could be all information maps, all scorecards, or some combination of these types. This dashboard displays gauges, graphs, bar charts, line plots, and a map.

Dashboards are created, maintained, and viewed through an easy-to-use Web-based interface. All content is displayed in a role-based, secure, customizable, and extensible environment. Information consumers and performance analysts can customize how information appears on their personal dashboards.

SAS BI Dashboard enables users to create their own dashboards from a variety of data sources, including information maps and SAS data sets. Users can link dashboards to SAS business intelligence objects or to external URLs, and users can customize the visualization of the data in a number of ways. For more information about the SAS BI Dashboard, see the **SAS BI Dashboard: User’s Guide**.

**Log On to SAS BI Dashboard**

The SAS BI Dashboard is accessed from within the SAS Information Delivery Portal. The current logon information from the portal is provided to the SAS BI Dashboard. Therefore, the SAS BI Dashboard appears immediately, without the need to log on. For more information, see the Help for SAS Information Delivery Portal.

To access SAS BI Dashboard, open the SAS Information Delivery Portal and log on. To do so, perform the following steps:
1. Open your Web browser and point it to the portal's URL address. To obtain the URL, contact your portal administrator.

2. To identify yourself to the portal, log on with your user name and password. If you do not have a user name and password, contact your system administrator to obtain them.

   The logon procedure varies depending on how your organization has installed the portal. Use either the portal logon procedure or the Web server logon procedure, as appropriate.

3. If your organization uses the portal's logon feature, do the following:
   a. Open your browser and point to the portal's URL.
      
      Note: To obtain the Web address, contact your portal administrator.
   b. On the logon page, type your user name and password.
   c. Click Log On. Your personal portal opens. Typically, most portal users see a page that contains a collection portlet (My Collection) and a bookmark portlet (Bookmarks).

Locating SAS BI Dashboard Documentation

Online Help for the SAS BI Dashboard is available from within the product. For more information, see the SAS BI Dashboard: User's Guide, which is available at [http://support.sas.com/documentation/index.html](http://support.sas.com/documentation/index.html). Use the A-Z index to locate the documentation for this product.
Part 5

Appendixes

Appendix 1
*Naming Standards for Reporting Objects* .......................... 141

Appendix 2
*Reporting Standards for SAS IT Resource Management Reports* . 147

Appendix 3
*Troubleshooting and Debugging Tips* .............................. 155

Appendix 4
*Best Practices* ......................................................... 177

Appendix 5
*Report Conversion Guide* ............................................ 187
About Naming Standards for SAS IT Resource Management Reporting Objects

About Naming Standards for SAS IT Resource Management

Naming Standards and Location of Objects

Information Maps

Supplied SAS Enterprise Guide Projects

Gallery Transformations and Report Jobs

About Naming Standards for SAS IT Resource Management Reporting Objects

SAS IT Resource Management uses specific naming conventions and locations when naming and saving the various reporting components that it supplies and creates. These conventions simplify the management and maintenance of the objects that are interrelated for IT reporting in SAS Enterprise Guide, the SAS IT Resource Management client, and Gallery Manager.

For consistency and efficiency, if you choose to create or edit SAS Enterprise Guide projects, report definitions, Gallery transformations, or any other reporting component for your IT resource data, then use the same naming and storage conventions that SAS IT Resource Management uses.

Naming Standards and Location of Objects

Information Maps

The following table describes the standard naming conventions and storage locations that SAS IT Resource Management uses when creating and saving the various objects that are associated with information maps.
<table>
<thead>
<tr>
<th>Object</th>
<th>Naming Convention</th>
<th>Location</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>information map</td>
<td>An information map has the same name as its corresponding source table. (Example: MonthShiftDisk)</td>
<td>In the IT Data Marts tree: <code>&lt;IT data mart name&gt;</code> ⇔ <code>&lt;adapter type&gt;&lt;number&gt;</code> ⇔ Domain Categories ⇔ <code>&lt;domain category&gt;</code>.</td>
<td>Mixed case with no spaces.</td>
</tr>
<tr>
<td>information map filter</td>
<td>Includes descriptive words that show the performance area first, then a descriptor, the type of metric, and a statistic. (Examples: MemoryUsagePctW Mean, PagesFreedRateMax)</td>
<td>In the Information Map transformation that is part of the information map job. Information map filters are available on the Information Map Parameters tab of the Information Map transformation properties.</td>
<td></td>
</tr>
<tr>
<td>Object</td>
<td>Naming Convention</td>
<td>Location</td>
<td>Notes</td>
</tr>
<tr>
<td>------------------------------------</td>
<td>-------------------</td>
<td>--------------------------------------------------------------------------</td>
<td>--------------------------------------------</td>
</tr>
<tr>
<td>information map filter</td>
<td>Includes descriptive words and components that are based on the following guidelines:</td>
<td>In the Information Map transformation that is part of the information map job. Information map filters are available on the Information Map Parameters tab of the Information Map transformation properties.</td>
<td>Mixed case with no spaces.</td>
</tr>
<tr>
<td>(statistic type)</td>
<td>• The first two characters (if the filter is based on a rank column from a joined table) show which level the column comes from. For example, D_ for Day level table, W_ for Week level table, M_ for Month level table, or nothing when it is not from a joined table.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• The text string Top or Bot corresponds to ascending or descending order.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• The data item name on which the column is based, when appropriate, is included.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• The text string DescRank or AscRank is included to show the rank order when appropriate.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>(Examples: BotMemoryAvailable MB, TopCpuBusyPct)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>information map job</td>
<td>&lt;domain category&gt; Information Map (Example: Disk Information Map)</td>
<td>In the IT Data Marts tree: &lt;IT data mart name&gt; ≔ &lt;adapter type&gt;&lt;number&gt; ≔ Domain Categories ≔ &lt;domain category&gt;.</td>
<td></td>
</tr>
</tbody>
</table>
**Supplied SAS Enterprise Guide Projects**

The following table describes the standard naming conventions and storage locations that SAS IT Resource Management uses to name and save the various objects that are associated with the supplied SAS Enterprise Guide projects.

<table>
<thead>
<tr>
<th>Object</th>
<th>Naming Convention</th>
<th>Location</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>process flow</td>
<td><code>&lt;TimePeriod&gt;</code>&lt;Job&gt;&lt;DataSourceName&gt; (Example: DayJobDetailSystem)</td>
<td>An active Gallery transformation is in the reporting job. A template to create your own Gallery transformation is in the Transformations tree in ITRM Transformations.</td>
<td>Transformation names cannot contain double quotation marks.</td>
</tr>
<tr>
<td>ITRM Gallery task</td>
<td><code>&lt;Resource&gt;</code>&lt;FilterDescription&gt;<code>&lt;GraphType&gt;</code>&lt;TimePeriod&gt; (Example: SystemCpuHighUsagePlotForTheDay)</td>
<td>The last object in a branch of a process flow in a SAS Enterprise Guide project.</td>
<td>The ITRM Gallery task name is the same as the report definition that it creates.</td>
</tr>
</tbody>
</table>
### Gallery Transformations and Report Jobs

The following table describes the standard naming conventions and storage locations that SAS IT Resource Management uses to name and save Gallery transformation, report jobs, and their reporting components.

<table>
<thead>
<tr>
<th>Object</th>
<th>Naming Convention</th>
<th>Location</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gallery transformation</td>
<td><code>&lt;DomainCategory&gt; &lt;Time Period&gt;</code></td>
<td>An active Gallery transformation is in the report job. A template to create your own Gallery transformation is in the Transforms tree in ITRM Transformations.</td>
<td></td>
</tr>
<tr>
<td>reporting job</td>
<td><code>&lt;domain category&gt; &lt;time period&gt; Reporting</code></td>
<td>In the IT Data Marts tree: <code>&lt;IT data mart name&gt; &lt;adapter type&gt; &lt;number&gt; &lt;Domain Categories &lt;domain category&gt;</code></td>
<td></td>
</tr>
</tbody>
</table>
### About Reporting Standards for SAS IT Resource Management Reports

SAS IT Resource Management uses several reporting standards to design and specify the properties for various types of report. These conventions provide a consistency in the look of SAS IT Resource Management reports while espousing best practices for rendering IT reports. The reports that SAS IT Resource Management supplies include the types of reporting standards:

- standards for report elements
- standard specifications for report tasks

For best results, if you choose to create or edit your own IT reports, then use the same reporting standards that SAS IT Resource Management uses for consistency and efficiency.

---

**Appendix 2**

**Reporting Standards for SAS IT Resource Management Reports**

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>About Reporting Standards for SAS IT Resource Management Reports</td>
<td>147</td>
</tr>
<tr>
<td>Standards for SAS IT Resource Management Report Elements</td>
<td>148</td>
</tr>
<tr>
<td>Titles</td>
<td>148</td>
</tr>
<tr>
<td>Footnotes</td>
<td>149</td>
</tr>
<tr>
<td>Axis</td>
<td>150</td>
</tr>
<tr>
<td>Colors</td>
<td>150</td>
</tr>
<tr>
<td>Group BY</td>
<td>151</td>
</tr>
<tr>
<td>Reference Lines</td>
<td>151</td>
</tr>
<tr>
<td>Fonts</td>
<td>151</td>
</tr>
<tr>
<td>Formats</td>
<td>151</td>
</tr>
<tr>
<td>Symbols</td>
<td>151</td>
</tr>
<tr>
<td>Standard Specifications for Report Tasks</td>
<td>152</td>
</tr>
<tr>
<td>Line Plots</td>
<td>152</td>
</tr>
<tr>
<td>2XY Plots</td>
<td>152</td>
</tr>
<tr>
<td>Needle Plots</td>
<td>152</td>
</tr>
<tr>
<td>Box Plots</td>
<td>153</td>
</tr>
<tr>
<td>Bar Lines</td>
<td>153</td>
</tr>
<tr>
<td>Bar Charts</td>
<td>153</td>
</tr>
<tr>
<td>List Data</td>
<td>153</td>
</tr>
</tbody>
</table>
Standards for SAS IT Resource Management
Report Elements

**Titles**

Many reports have the following two titles:

- Title1 shows the report metrics.
- Title2 provides information about the level of data that is being reported.

*Note:* The BY line and the axis of the report also help the report viewer to determine the level of data that is being reported.

The following figure provides an example of Title1 and Title2 in a SAS IT Resource Management report with a BY Line.

**Figure A2.1** Titles and BY Line in a SAS IT Resource Management Report

![CPU Busy Percent Daily Hours for the Week](image)

StartOfWeek=03/21/2010 Machine=bigdipper

The following table provides information about how Title2 standards map to the aggregation level for the report.

<table>
<thead>
<tr>
<th>Job</th>
<th>Title2 Sample</th>
<th>Aggregation Level</th>
</tr>
</thead>
<tbody>
<tr>
<td>Day Job</td>
<td>Intervals for the Day</td>
<td>Detail</td>
</tr>
<tr>
<td></td>
<td>Hours for the Day</td>
<td>DayHour</td>
</tr>
<tr>
<td></td>
<td>Hours for last 3 Days</td>
<td>DayHour</td>
</tr>
<tr>
<td></td>
<td>Hours for last 7 Days</td>
<td>DayHour</td>
</tr>
<tr>
<td></td>
<td>Shifts for the Day</td>
<td>DayShift</td>
</tr>
<tr>
<td></td>
<td>For the Day</td>
<td>Day</td>
</tr>
<tr>
<td>Job</td>
<td>Title2 Sample</td>
<td>Aggregation Level</td>
</tr>
<tr>
<td>--------------------</td>
<td>-----------------------------</td>
<td>-------------------</td>
</tr>
<tr>
<td>Week Job</td>
<td>Daily Hours for the Week</td>
<td>DayHour</td>
</tr>
<tr>
<td></td>
<td>Daily Peak Hours for the Week</td>
<td>DayHour</td>
</tr>
<tr>
<td></td>
<td>Daily Shifts for the Week</td>
<td>DayShift</td>
</tr>
<tr>
<td></td>
<td>Days for the Week</td>
<td>Day</td>
</tr>
<tr>
<td></td>
<td>Days for last 4 Weeks</td>
<td>Day</td>
</tr>
<tr>
<td></td>
<td>Weekly Hours for last 4 Weeks</td>
<td>WeekHour</td>
</tr>
<tr>
<td></td>
<td>Weekly Hours for the Week</td>
<td>WeekHour</td>
</tr>
<tr>
<td></td>
<td>By Shift and Week</td>
<td>WeekShift</td>
</tr>
<tr>
<td></td>
<td>For the Week</td>
<td>Week</td>
</tr>
<tr>
<td></td>
<td>By Week</td>
<td>Week</td>
</tr>
<tr>
<td>Month Job</td>
<td>Daily Hours for the Month</td>
<td>DayHour</td>
</tr>
<tr>
<td></td>
<td>Daily Peak Hours for the Month</td>
<td>DayHour</td>
</tr>
<tr>
<td></td>
<td>Daily Shifts for the Month</td>
<td>DayShift</td>
</tr>
<tr>
<td></td>
<td>Days for the Month</td>
<td>Day</td>
</tr>
<tr>
<td></td>
<td>Days for last 2 Months</td>
<td>Day</td>
</tr>
<tr>
<td></td>
<td>Monthly Hours for the Month</td>
<td>MonthHour</td>
</tr>
<tr>
<td></td>
<td>Monthly Hours for last 3 Months</td>
<td>MonthHour</td>
</tr>
<tr>
<td></td>
<td>By Shift and Month</td>
<td>MonthShift</td>
</tr>
<tr>
<td></td>
<td>For the Month</td>
<td>Month</td>
</tr>
<tr>
<td></td>
<td>By Month</td>
<td>Month</td>
</tr>
</tbody>
</table>

**Footnotes**

Use a footnote to indicate that a filter was used to subset the report data. Here are some examples:

- Server with high CpuBusyPctWMean for the day
- Server with high CpuBusyPctWMean for the week
- Server with high CpuBusyPctWMean for the month
- Server with high CpuBusyPctWMean for one or more days
• Servers with highest CpuBusyPctWMean for the day
• Servers with highest CpuBusyPctWMean for one or more days

Use the following default as the second line of the footnote:

Generated on %TRIM(%SYSFUNC(DATE(), NLDATE20.)) at %SYSFUNC(TIME(), NLTIMAP20.)

The following figure provides an example of a footnote in a SAS IT Resource Management report.

Display A2.1  Footnote in a SAS IT Resource Management Report

Server with high CpuBusyPctWMean for the week
Generated on May 27, 2010 at 01:52:56 PM

Axis

To imitate the axis standards for SAS IT Resource Management reports, implement the following specifications:

• Specify a generic axis label for reports that contain legends, when you are plotting multiple statistics, or when the default labels on the axis are ambiguous.
• Turn off minor tick marks.
• For reports with hour on the horizontal axis, use 0 to 23 by 1.
• For reports with hour on the vertical axis, use 0 to 24 by 2.
• For reports with time on the horizontal axis, use “00:00”t to “24:00”t by “02:00”t.
• For reports with percentages on the vertical axis, use 0 to 100 by 20.

Colors

A template named ITRMDefault is used for default colors in SAS IT Resource Management reports. However, most reports do not require that colors be specified explicitly in the report task.

Most of the colors that are defined in the ITRMDefault template were selected from the autumn color scheme and from a set of the SAS Enterprise Guide window default colors.

If you want to specify a color in a report task, the following colors (in SAS Enterprise Guide) complement the colors in the ITRMDefault template:

• blue gray
• dark yellow
• light orange
• teal
• pale blue
• lavender
• tan
• gold
• light yellow
• lime
• light green

Use black for needle plots that include a symbol for a standard deviation metric.

**Group BY**

Be consistent with the placement of BY variables in your reports. SAS IT Resource Management reports use the following order to place BY variables in reports:

1. date, if used
2. date-related ID columns such as DayOfDay
3. other classification columns

**Reference Lines**

To imitate the reference line standards for SAS IT Resource Management reports, implement the following specifications:

• Use reference lines when possible.
• When plotting two metrics on the left and right axis, use a reference line for the most important metric that is plotted on the left vertical axis.
• Use values 20, 40, 60, 80 and 100 when using a reference line for a percent metric.
• Do not specify values when using reference lines if you do not know the minimum and maximum values for the metric.
• Use the style **Dashed**.
• Use the color **Gray - 25%**.
• Include a footnote about the reference if needed.

**Fonts**

SAS IT Resource Management reports use the default fonts for SAS Enterprise Guide.

**Formats**

SAS IT Resource Management reports use the default formats that are inherited from their aggregation tables or information maps.

**Symbols**

To imitate the symbols standards for SAS IT Resource Management reports, implement the following specifications:

• Use the dot symbol with size 8.
• Use the triangle symbol when plotting a standard deviation statistic.
• Use symbols when they do not overcrowd the graph.
Standard Specifications for Report Tasks

**Line Plots**

To imitate the standards for SAS IT Resource Management line plots, implement the following specifications:

- Use line width of 3.
- Break the plot line at missing values.
- Use the symbol dot with size 8 when plotting a small number of points.

**2XY Plots**

To imitate the standards for SAS IT Resource Management 2XY plots, implement the following specifications:

- Use a standard line plot, not an overlay.
- Plot the most important variable on the left. If both variables are important, plot percent variables on the left.
- Specify a corresponding color in the task for the labels of axis variables, if appropriate.

**Needle Plots**

To imitate the standards for SAS IT Resource Management needle plots, implement the following specifications:

- Use needle plots when you want to plot two or three statistics of a single metric.
- Do not use needle plots if you expect a small number of points, such as in a current week report that can have as few as one point on the first day of the week.

Needle plots are used in the following two formats: One that shows two statistics and one that shows three:

- needle plots that show two statistics.
  
  For the reports that show two statistics, use the following guidelines:
  
  - Both statistics should be needle lines with a size of 12 to 16.
  - The size should be as large as possible without bleeding onto the axis line.
  - The variable with the larger number should always be first. The variable with the smaller number should be second. For example, Maximum is always larger than or equal to Mean, which is equal to or larger than Minimum.

- needle plots that show three statistics.
  
  For reports that show three statistics, use the following guidelines:
  
  - The two most important statistics should be needle lines with a size of 12 to 16.
  - The size should be as large as possible without bleeding onto the axis line.
• The statistic with the larger number should be first. The smaller statistics should be second. The third statistic, such as the standard deviation, should have an interpolation of scatter. For example, **Maximum** is always larger than or equal to **Mean**, which is equal to or larger than **Minimum**.

• Use the dot symbol when plotting a standard deviation. The dot should be black and size 9 to 12. The dot symbol should be narrower than the needle width.

**Box Plots**

To imitate the standards for SAS IT Resource Management box plots, implement the following specifications:

• Use extreme high and low for the whisker length percentile.

• Specify the color in the task to be light orange.

**Bar Lines**

To imitate the standards for SAS IT Resource Management bar lines, implement the following specifications:

• Use bar lines when you want to plot two statistics of a single metric or of two different metrics, where the bar is the most important statistic or metric.

• Specify complementary colors in the task for the variable labels because a legend is not available.

• Chart the most important statistic or the percent statistic on the left hand side, if possible.

• Verify the statistic that is used in the advanced window.

• Use line width of 3.

• Use the symbol dot with a size of 8.

**Bar Charts**

To imitate the standards for SAS IT Resource Management bar charts, implement the following specifications:

• Chart one bar for each discrete variable.

• When the bar chart has a subgroup or is an interleave bar chart, you can add code to the task to include a legend. Use the insert code feature to add the code.

**List Data**

To imitate the standards for a SAS IT Resource Management data list, modify the labels to add spaces between capitalized words. This ensures that the header row of the HTML page can wrap and that the columns can resize as you enlarge and shrink the HTML page.
Appendix 3
Troubleshooting and Debugging Tips

How to Verify the SAS IT Resource Management Enterprise Guide Installation and Configuration .................................................. 156
  Where Is SAS IT Resource Management Installed? .......................... 156
  Verifying the Presence of the ITRM Style Sheet, ITRM Banner, and EG Options Components in Your SAS Enterprise Guide Installation .................................................. 156
  Verifying the Correct Location of the ITRM Templates .......................... 157

Why SAS Enterprise Guide Reports Do Not Display Correctly ................. 157
  Determining Why the Report’s Style Sheet, Banner, or Template Are Incorrect .......................... 157
  Determining Why Java Applet Graphs Do Not Display Correctly .................. 159
  Determining Why ActiveX Graphs Do Not Display Correctly .................. 163

Why Are Reports Missing from the Gallery Manager? ........................... 165
  Are the Gallery Manager Filters Defined Correctly? ........................... 165
  Are the Reports Stored on the SAS Content Server? ........................... 166
  Does the Cache Need to Be Refreshed? ........................................ 167
  Did the Report Jobs Run Correctly? ........................................ 167

Why Report Jobs Are Not Generating Reports ..................................... 168
  Overview of Report Jobs Not Generating Reports ............................. 168
  Possible Causes of Missing Data ........................................ 168
  How to Determine Why Data Is Missing ........................................ 169

Removing Duplicate Reports That Are Stored on the SAS Content Server ... 170

Invalid User ID or Password Error Message Is Received ........................ 171

Invalid User ID and Password Embedded in Generated Code of Report Jobs .... 171

Error Message: Select a SAS Content Server ................................... 172

How to Debug a Middle-tier Connection Problem in a Report Job ............... 172

How to Access Gallery Manager Reports in the SAS Content Server ........... 174

How to Refresh the Cache for Gallery Manager Reports .......................... 174

How to Back Up Reports .................................................................. 175

Technical Support ........................................................................ 175
How to Verify the SAS IT Resource Management Enterprise Guide Installation and Configuration

Where Is SAS IT Resource Management Installed?

The SAS IT Resource Management installation loads several files into locations that are needed for reporting functions. The files that are discussed in the following topic are installed in multiple subfolders in these two locations:

- C:\Program Files\SASHome\x86\SASITResourceManagementSASEnterpriseGuideComponents\3.3
- C:\Program Files\SASHome\x86\SASITResourceManagementGalleryTask

The files are then copied to the locations that are listed as follows where they are used by the product.

Verifying the Presence of the ITRM Style Sheet, ITRM Banner, and EG Options Components in Your SAS Enterprise Guide Installation

The following values for EGRoot, UserProfile, and SASRoot pertain to the 64-bit version of SAS Enterprise Guide on Windows 7. They show the default paths that are used to locate the ITRM style sheet, ITRM banner, EG Options file, dynamic link library (DLL), helpfiles, and EG projects that are needed for SAS Enterprise Guide.

EGRoot = C:\Program Files\SASHome\SASEnterpriseGuide\5.1
UserProfile = C:\Users\<MyUserID>
SASRoot = C:\Program Files\SASHome

Note: Substitute the locations for EGRoot, UserProfile, and SASRoot based on your installation of SAS IT Resource Management for the values in the paths shown here for the ITRM style sheet, ITRM banner, and EG options components. In addition, if you installed a version later than SAS Enterprise Guide 5.1, insert that version number in the path for EGRoot. For example, if you installed SAS Enterprise Guide 5.2, the location of EGRoot would be EGRoot = C:\Program Files\SASHome\EnterpriseGuide\5.2.

Default location for the ITRM Style Sheet

<EGRoot>\Styles\ITRMDefault.css

Note: For information about style sheets, see “About the Default Style Sheets for SAS IT Resource Management Reports” on page 89.

Default location for the ITRM Banner file

<EGRoot>\Styles\ITRMBanner.png

Note: For information about banners, see “About the Default Style Sheets for SAS IT Resource Management Reports” on page 89.

Default location of the EG Options file

<EGRoot>\EGOptions.xml

<UserProfile>\AppData\Roaming\SAS\EnterpriseGuide\5.1\EGOptions.xml
Note: If you installed a version later than SAS Enterprise Guide 5.1, insert that version number in the previous path. For example, if you installed SAS Enterprise Guide 5.2, the previous path would be `<UserProfile>\AppData\Roaming\SAS\EnterpriseGuide\5.2\EGOptions.xml`.

Note: Open the EGOptions.xml file with a text editor and verify that it contains the string ITRMDefault. If the string ITRMDefault is not found in either of the two previous locations, find the version of EGOptions.xml that was created during the installation of SAS IT Resource Management. Then, install it into the two locations above. For information about the location of these subfolders, see “Where Is SAS IT Resource Management Installed?” on page 156.

**Default location for ITRM Gallery Task and Help Files**

- `<EGRoot>\Custom\ITRMGallery.dll`
- `<EGRoot>\Custom\itrm_gallerytask.chm`

**Default location for ITRM EG Projects**

- `<SASRoot>\x86\SASITResourceManagementSASEnterpriseGuideComponents\3.3`

Note: For information about these topics, see “Accessing SAS IT Resource Management Projects with SAS Enterprise Guide” on page 118.

**Verifying the Correct Location of the ITRM Templates**

SAS IT Resource Management provides a default template file named tmplitrm.sas7bitm that includes a default template named ITRMDefault. This default template includes updates to a parent template called styles.analysis that SAS provides. These updates include specifications for graph colors in charts and plots.

Note: For information, see “About the Default Template for SAS IT Resource Management Reports” on page 88.

The following value for SASServerRoot pertains to the 64-bit version of SAS Enterprise Guide on Windows 7:

```
SASServerRoot = C:\Program Files\SASHome\SASFoundation\9.3
```

Verify that your installation of SAS IT Resource Management includes this component. The default location for this file is here: `<SASServerRoot>\itrmmvadata\sashelp\tmplitrm.sas7bitm`.

Note: Substitute the location of the templates based on your installation of SAS IT Resource Management for the value of SASServerRoot.

---

**Why SAS Enterprise Guide Reports Do Not Display Correctly**

**Determining Why the Report’s Style Sheet, Banner, or Template Are Incorrect**

If your reports do not use the correct style or colors, you might not have the correct SAS Enterprise Guide ITRM files installed, or they might not be installed correctly. To determine whether this is the problem, perform the following steps:
Verify that you are using the correct version of the SAS Enterprise Guide options file.

1. From the menu bar of SAS Enterprise Guide, select **Tools ➤ Options**.
2. Select **Tasks ➤ Custom Code**.
3. Verify that the **Insert custom SAS code box before task and query code** is checked.
4. Click the **Edit** button that is associated with the **Insert custom SAS code box before task and query code** check box.

**Display A3.1 Custom Code Dialog Box**

```
/* Insert custom code before task code here */
ods path sasuser.templat (update) sashelp.tmplITRM (read) sashelp.tmplmst (read);
```

5. Verify that the following ODS path statement is present in the Edit window (as shown in the previous step):

```
ods path sasuser.templat (update) sashelp.tmplITRM (read)
    sashelp.tmplmst (read);
```

6. If you do not see the ODS path statement, you might not have the correct SAS Enterprise Guide options file installed, or it might not be installed correctly.

If this is the case, verify that the ITRM style sheet, ITRM banner, and EG Options components for your SAS Enterprise Guide are installed correctly. To do so, see “Verifying the Presence of the ITRM Style Sheet, ITRM Banner, and EG Options Components in Your SAS Enterprise Guide Installation” on page 156.
Verify that you are using the SAS IT Resource Management style sheet and banner.

1. From the menu bar of SAS Enterprise Guide, select Tools ➪ Style Manager. The following window appears:

   **Display A3.2  Style Manager Window of SAS Enterprise Guide**

2. In the Style Manager window, verify that the following conditions are satisfied:
   - In the Style List group box, **ITRMDefault** is selected as the default style sheet.
   - In the Preview pane, the ITRM banner is displayed.

3. If ITRMDefault does not appear in the list of available styles, see “Verifying the Presence of the ITRM Style Sheet, ITRM Banner, and EG Options Components in Your SAS Enterprise Guide Installation” on page 156.

### Determining Why Java Applet Graphs Do Not Display Correctly

If your Java Applet graphs are not displaying correctly, the problem might be caused by an incorrect codebase, version of JRE, or graph format.

**Verify that you are using the correct codebase.**

1. From the menu bar of SAS Enterprise Guide, select Tools ➪ Options. Then click Graph.

2. Set the **Graph Format** to Java and make sure that the **URL for archive** field is set to http://www2.sas.com/codebase/graph/v93.
3. If you do not have access to the external Web or if you encounter performance issues using the default path, then change the URL to point to your local middle tier, such as `http://Your_Middle_Tier:Port_Number/sasweb/graph`.

4. Make sure that the graph format is set back to your default format. Then click **OK** to save your settings.

**Verify that the Java Console is enabled.**

1. Navigate to the Java Control Panel.
Display A3.4  Java Control Panel

2. Select the Advanced tab to display the following screen:
3. Click **Show console**.
   
   *Note:* If you need more help locating this window, contact your system administrator.

4. Click **OK** to close the Java Console Panel.

### Generate the Java graph.

To generate a Java graph, perform the following steps:

1. Perform one of the following actions:
   
   - In the Results > Graph window of your EG Options file, set **Graph Format** to **Java**. Click **OK** to save **Java** as the default graph format. Then, in the report task Properties window, check **Use preferences from Tools -> Options**.
   
   - In the report task Properties window, check **Customize result formats, styles, and behavior** and set the **Graph Format** to **ActiveX**.
Display A3.6  Report Properties with Graph Format Set to Java

Note: For best results, also check the HTML box and select the ITRMDefault style sheet.

2. Generate your Java graph.

3. If you are not able to view your Java graph, find the Java Console Panel. The panel displays the version of Java that you are using. Correct any errors or exceptions that are displayed.

Determine whether you are using the version of the Java Runtime Environment (JRE) that SAS recommends for your version of SAS. See the SAS Third-Party Software Reference at http://support.sas.com/resources/thirdpartysupport/.

Determining Why ActiveX Graphs Do Not Display Correctly

If your ActiveX graphs are not displaying correctly, the problem might be caused by an incorrect codebase, version of ActiveX, or graph format.

Verify that you are using the correct codebase.

1. From the menu bar of SAS Enterprise Guide, select Tools ⇒ Options. Then click Graph.

2. Set the Graph Format to ActiveX and make sure that the URL for the codebase field is set to this path: http://www2.sas.com/codebase/graph/sasgraph.exe#version=9,3.
3. If you do not have access to the external Web or if you encounter performance issues using the default path, then change the URL to point to your local middle tier. For example, your middle tier location might be: http://Your_Middle_Tier:Port_Number/sasweb/graph/sasgraph.exe#version=9.3.

4. Make sure that the Graph Format is set back to your default. Then click OK to save your settings.

Generate the ActiveX graph.

To generate an ActiveX graph, perform the following steps:

1. Perform one of the following actions:
   - In the Results > Graph window of your EG Options file, set Graph Format to ActiveX, as shown in the preceding display. Then in the report task Properties window, check Use preferences from Tools -> Options. Click OK to save ActiveX as the default graph format.
   - In the report task Properties window, check Use preferences from Tools -> Options, as shown in the following display:
Why Are Reports Missing from the Gallery Manager?

To determine why reports are missing from the Gallery Manager, consider the following potential resolutions.

Are the Gallery Manager Filters Defined Correctly?

1. Log off from the Gallery Manager and log back on.

2. Invoke the new Gallery wizard to create a new gallery that shows at least one report that should be generated by the report job.

   a. On page 2 of the wizard, select one domain category, one subcategory, one schedule frequency, and one keyword (if applicable) that matches one of the reports in your report job.

Additional information can be found here:


Display A3.8 Use Preferences from Tools - Options

Note: For best results, also check the HTML box and select the ITRMDefault style sheet.

2. Generate your ActiveX graph.

   Note: If ActiveX Control is not installed on your machine, you are prompted to install it. Accept the prompt.
b. On page 3 of the wizard, note how many reports are found. If one or more reports are found, click Next. On step 4 of the wizard, note how many reports are found.

If no reports are found, go to the previous step and increase the number of occurrences to 999 and repeat. (For information about how to change the number of occurrences, see Step 3 of the “Create a Gallery” topic in *SAS IT Resource Management: Gallery Manager User's Guide*.)

3. If you are still not able to find any reports that should be generated from your report job, perform the following steps:
   a. Try to determine whether the Gallery Manager can find any reports or whether the problem is limited to a subset of reports.
   b. For more troubleshooting suggestions, see “Are the Reports Stored on the SAS Content Server?”.

---

### Are the Reports Stored on the SAS Content Server?

1. Use the SAS Content Server Admin Console to traverse the SAS Content Server folder structure to search for at least one report that should be generated by the report job. (The SAS Content Server Admin Console is located at `http://<YourMidTierName>:<Port Number>/SASContentServer/direcontents.jsp?path=/sasdav/ITRM`. Log on using any user ID that has Read access to the SAS Content Server.)

2. Traverse the folder structure until you reach the folder that contains the actual report.

   ![Display A3.9 SCS Admin Console Contents](image)

   **Note:** The SAS Content Server folder names in the preceding display that are under the `sasdav/ITRM` folder correspond to the name of the EG project, the EG process flow, and the report definition that was used to define the report.

3. If the report is not in the SAS Content Server, check the report job log to make sure that the reports generated without errors. Investigate and eliminate the cause of the errors and rerun the report job. For more troubleshooting suggestions, see “Why Report Jobs Are Not Generating Reports” on page 168. You might have to rerun the report job with debugging turned on. Save the report job log and contact Technical Support.

   • For more information about how to turn debugging on for the Gallery Manager, see “How to Debug a Middle-tier Connection Problem in a Report Job” on page 172.

4. If the report is in the SAS Content Server, perform the following steps:
   a. Restart the Gallery Manager to refresh the cache. For information about how to do this, see “How to Refresh the Cache for Gallery Manager Reports” on page 174.
   
   b. Check whether there are errors in the Gallery Manager log. (The log is located at `<YourSASConfigFolder>\Lev1\web\Logs\GalleryManager3.3`). If
there are errors in the Gallery Manager log, save a copy of the log and contact Technical Support. For information about how to do so, see “Technical Support” on page 175.

**Does the Cache Need to Be Refreshed?**

The Gallery Manager maintains an internal index, or cache, of the reports that are stored on the SAS Content Server. The reports that are associated with the Gallery Manager are only those that are generated by SAS IT Resource Management report jobs. When SAS IT Resource Management report jobs run successfully, the cache is updated correctly. However, in some cases, such as network connection failures, you might not be able to see new reports. Similarly, you might see a 404 error message that refers to reports that were deleted because the cache was not updated correctly.

**Display A3.10  Example of an HTTP Status of 404**

To force an update of the cache, see “How to Refresh the Cache for Gallery Manager Reports” on page 174.

**Did the Report Jobs Run Correctly?**

Check the report job log to make sure that the reports were generated without errors. Investigate and eliminate the cause of the errors and rerun the report job. For more troubleshooting suggestions, see “Why Report Jobs Are Not Generating Reports”.
Why Report Jobs Are Not Generating Reports

Overview of Report Jobs Not Generating Reports

If your report jobs are not generating reports, the following conditions might need to be resolved:

- You might be experiencing a problem with your middle-tier connection. For information about how to correct this problem, see “How to Debug a Middle-tier Connection Problem in a Report Job” on page 172.

  *Note:* If your server and network are experiencing problems, make sure those problems are resolved before you rerun the report job.

- An information map might have been moved. To resolve this problem, make sure that the information maps that are used by the report job are accessible and referencing the correct data source.

  To locate the information map, review the report job log and find the report definition that is associated with the first error. Search backward in the log until you find the following text string:

  ```
  --- Report: ReportDefinitionNameHere
  ```

  Continue searching backward until you find the source code for the report definition. The source code of the report definition identifies the information map that is the data source for this report definition. The source code begins with the following comment:

  ```
  /*---- Report: ReportDefinitionNameHere ----*/
  ```

- Data that is required by the report is missing from the data source. To resolve this problem, see Possible Causes of Missing Data.

Possible Causes of Missing Data

Warnings or error messages in your SAS log can help determine why your report jobs fail to generate reports. For example, you might see this warning message in the SAS log:

```
NOTE: Input data set is empty.
WARNING: Report definition did not generate a graph.
Make sure that your input data source contains data.
```

Any one of the following three scenarios can produce a warning or an error message in the SAS log. To determine which of these scenarios is responsible for causing the problem, see “How to Determine Why Data Is Missing” on page 169.

- A report definition is using an information map with a filter that subsets data that does not yet exist.

  Most of the report definitions that SAS IT Resource Management supplies use information map filters to subset the data for reporting. In some cases, the filters result in missing data and some SAS/GRAPH procedures generate warnings or errors that can be prevented only by rerunning the report when data is available.
For example, most report definitions that are designed to run on a weekly basis are designed to run at the beginning of the week for the previous week. When the IT data mart does not contain any data for the previous week, the report definition does not produce any reports. The same is true for monthly reports. Most monthly reports are designed to be run at the beginning of a month for the previous month. In these cases, you should wait until the IT data mart contains the data for the designated time period before scheduling the job.

Another example where you might be missing data is when you first start to run daily jobs. (Daily jobs report on the last whole day for which there is data. These jobs do not report on data if at least one completed day is not present in the data source.) In some cases, you might have specified a cutoff time for completing the day. If there is no data that is equal to or greater than that cutoff time, then there is no data for the current day. In addition, because this was the first time you ran the daily reporting job, there is no previous day’s data. Therefore, your report will not be generated.

Note: This scenario no longer applies after the first day. From day 2 onward, the data for a completed (previous) day will be available.

- A report definition is using a filter that always results in missing data for a particular report.
  In this case, you might need to update or eliminate the filter to ensure that data is available for a specific report definition.

- A report definition reports on a specific metric that is not collected at a particular site.
  In this case, you should modify the report to use a metric that is available or eliminate the report definition from the report job.

**How to Determine Why Data Is Missing**

Warnings or error messages that are written to your SAS log can help you resolve why data is missing. To locate the problem, perform the following steps:

1. Review the report job log and find the report definition that is associated with the first error. Search backward in the log until you find the following text string:

   ```--- Report: ReportDefinitionNameHere```

2. If you find data in the aggregation table for the data items that are used by the report definition, you need to determine whether an information map filter is responsible for the absence of data. To do so, perform the following actions:

   a. Find the supplied project, process flow, and gallery task that was used to create the report definition.
      You can find this information in the SAS log. Continue searching backward until you find the source code for the report definition. The source code begins with the following comment:

      ```*/---- Report: ReportDefinitionNameHere ----*/```

   b. Using a copy of the supplied project, connect to your data source.
      Note: You might need to use the migration wizard if the project was not previously used to connect to the data source.

      For information about this wizard, see “Migrating SAS Enterprise Guide Projects to Work with SAS IT Resource Management 3.3” on page 52.
c. In SAS Enterprise Guide, run the branch that includes the report definition that caused the warning or error.

If you see the same warning or error, then open the data source that is used in the report task that caused the warning or error.

d. If the data source is empty, you need to determine whether a filter is responsible for the missing data. To do so, modify the information map, remove all filters, and rerun the information map and the report task. Check the resulting output to see whether the data is now present in the data set.

e. If eliminating the filter solves the problem, then you need to determine which of the following courses of action you want to take:
   • eliminate one or more of the filters
   • modify the expression of the filter
   • process additional dates of data

f. If eliminating the filter still produces no data, then determine whether the measure is not being processed and make necessary adjustments to the report definition. For example, use another measure or eliminate the report definition from the report job.

g. Make any required changes. Then, create a user-defined report definition, update the report job to use the new report definition, and redeploy the report job.

Removing Duplicate Reports That Are Stored on the SAS Content Server

If you rerun a report job multiple times in a day without processing additional days of data in between, then the report job generates multiple instances of the same reports on the SAS Content Server. These reports remain on the SAS Content Server until they expire and the corresponding report job is rerun.

To eliminate duplicate reports from the SAS Content Server, you can perform one of the following tasks:

• Allow the duplicate reports to expire as you continue to run the report job that added them.

• Remove the reports manually by using the SAS Content Server Administrator Console. For more information, see the chapter about administering the SAS Content Server in the *SAS Intelligence Platform: Web Application Administration Guide*.

  *Note:* Update the cache after deleting reports from the SAS Content Server. For information about how to do this, see “How to Refresh the Cache for Gallery Manager Reports” on page 174.

• Override the expiration date by using the Gallery transformation and rerunning the job. Use caution when implementing this option. Depending on your settings, this implementation can delete duplicates as well as all previous versions of the report that were created by the report job.

  *Note:* You can change the expiration date on the **Report Definitions** tab of the Gallery transformation. Access this tab by right-clicking the transformation.
Invalid User ID or Password Error Message Is Received

**TIP** This topic pertains only to reports that were created in SAS IT Resource Management 3.2 and migrated to SAS IT Resource Management 3.3. It does not apply to reports that are created in SAS IT Resource Management 3.3.

To correct this problem, make sure that the user has permission to access the metadata server, the SAS Content Server, and the Gallery Manager. If the user’s password was recently changed, then the report job might need to be redeployed. For information about how to specify a user ID and password, see “Invalid User ID and Password Embedded in Generated Code of Report Jobs” on page 171.

**Note:** To verify that your user ID and password enable you to access the SAS Metadata Server, run the METAOPERATE Procedure, specifying the `ACTION=Status` argument. (For more information about this procedure, see *SAS Language Interfaces to Metadata*.)

Invalid User ID and Password Embedded in Generated Code of Report Jobs

**TIP** This topic pertains only to reports that were created in SAS IT Resource Management 3.2 and migrated to SAS IT Resource Management 3.3. It does not apply to reports that are created in SAS IT Resource Management 3.3.

The SAS IT Resource Management Gallery Transformation embeds the metadata server user ID and encoded password of the SAS Data Integration Studio user into the generated code that is produced for inclusion in the report jobs. If the user ID or password is changed, then the generated code must change for all of the corresponding jobs.

There are two ways to handle this issue:

1. Redeploy the jobs with the updated credentials. To do so, perform the following steps:
   a. Open the SAS IT Resource Management client with the correct credentials.
   b. Redeploy the reporting jobs. The newly deployed jobs will have the correct credentials.

2. Use an autoexec file to set the user ID and password. To do so, perform the following steps:
   a. Add the following statements to the autoexec file for the deployed jobs:

      ```
      %global metauser metapass;
      %let metauser=<userid>;
      %let metapass=<password>;
      ```

      **Note:** The password can be entered in open text or can be encoded using the PWENCODE procedure.
b. If the deployed jobs are being run with the batch server, then add this code to the autoexec_usermods.sas file for the batch server.

c. If the jobs are being run with native SAS (using the SAS command or in interactive SAS), then create an autoexec file that contains the preceding code and use the -autoexec option.

For more information about the configuration file and how autoexec files should be set up so that they can be located by SAS, see the SAS documentation for your operating environment.

---

Error Message: Select a SAS Content Server

When a report job runs, it creates reports and stores reports on the SAS Content Server. If a copy of a report job is made, and an attempt is made to open the copy of the report job, the following error message is displayed: Select a SAS content server.

Note: The error can also occur for a report job of a data mart that is imported.

The message is issued because the association to a valid SAS Content Server is lost. To correct this situation, perform the following steps:

1. Double-click the new job to open it in the Diagram tab of the Job Editor.
2. Right-click the Gallery transformation in the process flow and select the Server tab.
3. Specify the name and location of the SAS Content Server for the Gallery transformation.
4. Click OK and save the job.

---

How to Debug a Middle-tier Connection Problem in a Report Job

**CAUTION:**

The command to restart services should be issued only with the approval of an SAS IT Resource Management administrator. Everyone using Gallery Manager might be affected by this action.

If your report job shows an error that appears to be related to a middle-tier connection problem, verify that the SAS Content Server and the Gallery Manager are available. To do so, perform these two steps:

1. Connect to the SAS Content Server Administrative Console at http://<YourMiddle-TierName>:<port number>/SASContentServer/dircontents.jsp?path=/sasdav. If you are not able to connect to the SAS Content Server Administrative Console, restart the managed servers that are associated with SAS Remote Services, the SAS Content Server, and the Gallery Manager in the Web application server.

Note: The names of these servers depend on the set up of the middle tier. They are typically named server1, server10, and so on.
2. Logon to Gallery Manager at `http://<YourMiddle-TierName>:<port number>/ITRMGalleryManager`. If you are not able to connect to Gallery Manager, then restart the server that is associated with the Gallery Manager.

If you had to restart any services, then rerun the report job. If you continue to see the same middle-tier connection errors after restarting the middle-tier connection services, then follow the steps below to continue debugging the middle tier using a small, temporary report job.

**TIP**  
To simplify debugging, perform these steps using a small, temporary report job.

Then run the jobs, save the logs, and contact the SAS Technical Support Division. For information about how to do so, see “Technical Support” on page 175.

If after restarting any services, you encounter a different type of error, then see “Why Report Jobs Are Not Generating Reports” on page 168.

1. In the SAS IT Resource Management client, open your IT data mart. Then navigate to the folder that contains the report job that caused the error.

2. Create a new report job in the same folder. Add any report definition from the original job.

3. Click the **Code** tab in the Job Editor. Click Code generation mode and select User written body.

   **Display A3.11  Select the Code Generation Mode**

4. Search through the SAS log for the following text:

   ```
   /* setup */
   %global ITRMErr;
   %global ITRMDebug;
   %global ITRMNoWebdavUpdate;
   
   Add the following debugging statements after the previous `%global ITRMNoWebdavUpdate;` code.

   ```
   /* Add debugging statement */
   %let ITRMDebug=1;
   /* Disable Gallery Manager communications */
   %let ITRMNoWebdavUpdate=1;
   ```
Then, run the report job. Save the log.

5. Run the report job a second time with the following set of debugging statements:

```plaintext
/* Add debugging statement */
%let ITRMDebug=1;
/* Enable Gallery Manager communications */
%let ITRMNoWebdavUpdate=0;
```

6. Save the log and contact the SAS Technical Support Division. For information about how to do so, see “Technical Support” on page 175.

---

**How to Access Gallery Manager Reports in the SAS Content Server**

You can access the reports on the cache from the SAS Content Server Admin Console, which is located at `http://<YourMiddle-TierName>:<port number>/SASContentServer/dircontents.jsp?path=/sasdav/ITRM`.

If you remove reports manually from the SAS Content Server, be sure to refresh the cache.

---

**How to Refresh the Cache for Gallery Manager Reports**

Gallery Manager maintains an internal index or cache of the SAS IT Resource Management reports that are stored on the SAS Content Server. Refreshing the cache might resolve issues with reports not appearing in the SAS Content Server. For example, if you remove reports manually from the SAS Content Server, you need to refresh the cache.

**CAUTION:**

*Refreshing the cache should be done only with the approval of an ITRM administrator.* Refreshing the cache affects everyone using Gallery Manager. Make sure that this command is invoked when users are not logged on to Gallery Manager.

You can refresh the cache for the Gallery Manager reports in two ways.

- Restart the Gallery Manager service.
- Enter `http://<YourMiddle-TierName>:<port number>/ITRMGalleryManager/WebdavUpdate.do?job=job1&status=COMPLETED` in the address field of your Web browser and press ENTER.

*Note:* For more information, see the chapter about administering the SAS Content Server in the *SAS Intelligence Platform: Middle-Tier Administration Guide*. 
How to Back Up Reports

To back up your SAS IT Resource Management reports, you must back up the SAS Content Server that stores the reports. For more information about backing up reports, see "How to Back Up SAS IT Resource Management" in the Best Practices Appendix of the SAS IT Resource Management: Administrator’s Guide.

Technical Support

- If you need assistance with the software, we ask that only the on-site SAS support personnel call our Technical Support Division. For U.S. and Canadian customers, support is provided from our corporate headquarters in Cary, North Carolina. You can call (919) 677-8008, Monday through Friday. Customers outside of the U.S. can obtain local-language technical support through the local office in their countries. Customers in these locations should contact their local office for specific support hours. See http://support.sas.com/techsup/contact/index.html for contact information for local offices.

- Before calling, you might want to explore the SAS Institute Technical Support Web site at http://support.sas.com/techsup/. The Technical Support Web site offers a Knowledge Base, FAQs, Technical Support Documents and more that can answer your questions. This Web site also provides a mechanism for reporting problems.
Appendix 4
Best Practices

Run Report Jobs at Night or during Low Usage Periods

Limit the Reports That the Filters Can Retrieve When Creating a Gallery

Add a User-Defined Report Occurrence to the Gallery Manager

Managing SAS Enterprise Guide Projects for SAS IT Resource Management
  About SAS Enterprise Guide Projects for SAS IT Resource Management
  Add, Update, or Delete Report Definitions

Designing Reports for Batch Jobs

Create Tile Charts with Web Links

Override Report Expiration Dates to Purge Reports from the
SAS Content Server

Back Up Your Data and Reports

Schedule Report Jobs Based on the Available Data

Run Report Jobs at Night or during Low Usage Periods

The beginning and end of SAS IT Resource Management reporting code includes a flag to inform Gallery Manager that the report job has started and ended. If you run multiple jobs during the day while you are also working with the Gallery Manager, the report job runs might overlap. In that case, the subsequent Gallery Manager cache updates can be delayed as they overlap.

For best results, run multiple report jobs at night or when there is little activity on the Gallery Manager. This ensures that there is little or no overlap of separate report jobs running, which can delay the update of the cache.

Note: Run your report jobs only after the corresponding aggregation jobs are complete.
Limit the Reports That the Filters Can Retrieve When Creating a Gallery

When you create a gallery in Gallery Manager, you use primary and secondary filters to subset the reports that are on the SAS Content Server. By default, primary filters must reduce the number of reports to no more than 30,000 before you can continue with the next step to subset the reports further with secondary filters. Secondary filters must reduce the number of reports to no more than 20,000 before you can finish creating the gallery.

The default limits are specified to help manage the size of galleries and avoid unnecessarily large report sets that make it difficult to locate specific reports. However, you can specify the default limits to meet the needs of your organization if you need larger or smaller galleries.

To specify your own default limits, perform the following steps:

1. Open SAS Management Console with administrator login credentials. (To update the default report limits for the primary and secondary filters, use the SAS Administrative ID, which is sasadm.)

2. On the Plug-ins tab, expand Application Management ⇒ Configuration Manager ⇒ SAS Application Infrastructure.

   Note: The Configuration Manager is installed as part of the SAS Web Infrastructure Client. If you do not see this plug-in in SAS Management Console, then you can install it in the Software Deployment Wizard by selecting Install Additional Software and selecting the SAS Web Infrastructure Client.

3. Expand SAS Application Infrastructure.

4. Right-click ITRM Gallery Manager 3.3 and select Properties.

5. On the Advanced tab, specify the following parameters:
   - `itrmgm.PrimaryRptCnt` specifies the limit for primary filters.

   Note: The values for these parameters can be any valid integer.

6. Restart the Gallery Manager application.

Add a User-Defined Report Occurrence to the Gallery Manager

To add a user-defined report occurrence such as StartofQtr or StartOfYear as filter options to the Gallery Manager, perform the following steps:

1. Open SAS Management Console with administrator login credentials. (To update the default report limits for the primary and secondary filters, use the SAS Administrative ID, which is sasadm.)

2. On the Plug-ins tab, expand Application Management ⇒ Configuration Manager ⇒ SAS Application Infrastructure.
3. Expand **SAS Application Infrastructure**.

4. Right-click **ITRM Gallery Manager 3.3** and select **Properties**.

5. On the **Advanced** tab, add the user-defined report occurrence to the `itrmgm.DateByVariables` parameter. As shown in the following example, you can add **Date**, **StartOfWeek**, **StartOfMonth**, **StartOfQtr**, **StartOfYear** to the **Property value** field.

**Display A4.1  Advanced Tab of the Properties Window**

6. Restart the Gallery Manager application.

7. In the Create Gallery and Edit Gallery wizards, you can select these additional date-based periods to use as filters for the gallery that you are working with. Therefore, you can display the corresponding date-based **BY** variable in that gallery.
About SAS Enterprise Guide Projects for SAS IT Resource Management

The reports that are available from Gallery Manager and used for the purposes of performance management and capacity planning have their beginnings in SAS Enterprise Guide projects. These projects and their tasks produce reports that must be managed to ensure the integrity of the operational reporting environment for SAS IT Resource Management.

SAS makes the following recommendations as best practices for managing the SAS Enterprise Guide projects that SAS IT Resource Management provides at installation. These best practices assume that the SAS Enterprise Guide projects are maintained by several people referred to as “report developers” in this appendix.

The best practices described here provide suggestions for managing the following two sources of SAS Enterprise Guide projects:

- supplied projects
  Supplied projects, also called supplied SAS Enterprise Guide projects, are delivered with the SAS IT Resource Management solution. These projects are installed on each client machine to which SAS Enterprise Guide is deployed during the installation of SAS IT Resource Management.
The projects can be accessed by navigating to the location where you installed SAS IT Resource Management. The projects are located at `SASITResourceManagementSASEnterpriseGuideComponents\3.3`. For example, if you installed SAS IT Resource Management on a 64-bit machine, the projects might be located at `C:\Program Files\SASHome\x86\SASITResourceManagementSASEnterpriseGuideComponents\3.3`.

Supplied projects are assumed to be owned and managed by SAS. When updates to the SAS IT Resource Management solution are released, the entire contents of this folder might be overwritten to deliver product enhancements.

**User projects**

User projects are those SAS Enterprise Guide projects that are created by users of the SAS IT Resource Management solution and stored in a location other than that of the supplied projects. A suggested location is in a folder called `User` that is located under the folder where the supplied projects are stored. For example, you might store your user-created projects at `C:\Program Files\SASHome\x86\SASITResourceManagementSASEnterpriseGuideComponents\3.3\User`.

The report definitions that are created by these SAS Enterprise Guide projects differ in the following ways:

- Supplied report definitions that are delivered with the SAS IT Resource Management solution are written to the SAS Metadata Server and are stored in folders such as `Shared Data/SAS IT Resource Management/3.3 IT Report Definitions/<Adapter Name>/Supplied/<Time Period>`.

- User report definitions that are generated from user projects should be written to a location other than that of the supplied report definitions. A suggested location is `/Shared Data/SAS IT Resource Management/3.3 IT Report Definitions/<Adapter Name>/User Defined/<Time Period>`.

**Note:** As SAS releases updates to supplied SAS Enterprise Guide projects and corresponding report definitions, you can run the jobs that the Adapter Setup wizard generates and view the report output in Gallery Manager. Any updates that SAS delivers can be incorporated into your production reporting jobs by executing the best practices that are described in the following topic.

### Add, Update, or Delete Report Definitions

The following steps enable you to add, update, or delete report definitions that SAS IT Resource Management uses:

- In SAS Enterprise Guide, you can use the ITRM Gallery task to add or update report definitions. You can also delete an ITRM Gallery task.

- In the SAS IT Resource Management client, you can add, update, or delete report definitions that are in your report jobs.

1. Locate the SAS Enterprise Guide projects that are used to produce reports from the operational SAS IT Resource Management System.

2. Make copies of the supplied SAS Enterprise Guide projects and establish a set of master SAS Enterprise Guide projects for your site. Store these master copies of the projects in a location that is accessible by all report developers.
3. Use the Migration Wizard for SAS Enterprise Guide to update the mapping to the information map or SAS table that serves as the source data for the report. For more information, see “Preparing to Work with SAS Enterprise Guide” on page 50.

4. Use any method of version control to manage a set of master SAS Enterprise Guide projects. All report developers can use the master copies to make their own copies of the projects and publish their results after they have implemented and promoted changes to the report definitions that they produce.

5. Report developers perform the following steps when working with a SAS Enterprise Guide project:
   a. Check out a copy of a master SAS Enterprise Guide project.
   b. In SAS Enterprise Guide, select **File** ⇒ **New** ⇒ **Notes** to create a version notes file of the project. If a notes file already exists, then open the existing file.
   c. Add the following entries to this notes file:
      - Project Updated By
      - Date of Changes
      - Tasks Modified

6. You can perform these actions:
   - use the ITRM Gallery task to create new or update existing report definitions
   - delete an ITRM Gallery task or a report
     
     **Note:** Deleting the ITRM Gallery task does not delete the corresponding report definition.

   After you implement your changes, validate them.

7. If you added or modified ITRM Gallery tasks, publish the corresponding report definitions to the SAS Metadata Server. To do so, perform the following steps:
   
   **Note:** The suggested path for new report definitions is `/Shared Data/SAS IT Resource Management/3.3 IT Report Definitions/<Adapter Name>/User Defined/<Time Period>`.
   
   a. Right-click an ITRM Gallery task and select **Modify <ITRM Gallery task name>**.
   b. Click **Next** to navigate to page 2 of the ITRM Gallery task wizard.
   c. Click **Finish**. The new report definition is created and published to the SAS Metadata Server.

   **Note:** This step is not needed if you deleted an ITRM Gallery task.

8. Save and close the SAS Enterprise Guide project.

   **Note:** If your site uses a method of version control to manage a set of master SAS Enterprise Guide projects, make sure that you check in the project.


   Use the **IT Data Marts** tree to navigate to the report job in the appropriate IT data mart, adapter, and domain category folders. This location should be where you want to perform one of the following actions:
   - select a new report definition in the report job
   - deselect a report definition in the report job
10. Open the report job.
   Right-click the Gallery transformation and select Properties.

11. • If you are selecting a new report definition, select the Report Definitions tab and
    add the report definition as needed.
    • If you are deselecting a report definition, select the Report Definitions tab and
      delete the report definition as needed.

12. Select the Notes tab and add the following entries to the notes:
    • Transformation Updated By
    • Date of Changes
    • Report Definition Changes (such as Added: <report definition name>,
      Updated: <report definition name> or Deleted: <report definition name>

13. Save and close the Gallery transformation.


---

**Designing Reports for Batch Jobs**

When you design reports and create a report definition that will run in a batch job,
consider the following questions:

• Is the report definition intended to run in a daily, weekly, or monthly job?
• How long do you want to keep the generated report in the SAS Content Server?

Based on your answers to these questions, specify the appropriate values in the ITRM
Gallery task.

For example, if you design a report that should run daily and replace the previous
version in the SAS Content Server, then specify the following values in the ITRM
Gallery task:

• On Page 1 of the ITRM Gallery task, specify a path for the report definition that
  includes the subfolders User Defined and Day.
• On Page 2 of the ITRM Gallery task, specify the following values:
  • Select Daily in the Job Schedule Frequency field.
  • Specify a value of 1 for the Expire Reports After field.

Specifying these values help you find daily report definitions when creating report jobs.
These values in the report definition also help you find the desired reports when viewing
them with Gallery Manager.

---

**Create Tile Charts with Web Links**

The Tile Chart task in SAS Enterprise Guide supports Web links. However, when you
specify the URL for a web link, you must use a known location for the root URL.
For example, if your root URL is \url{http://www.MySite/BaseLineReports/}, then the following URLs are valid web link URLs:

- \url{http://www.MySite/BaseLineReports/{&1}}
- \url{http://www.MySite/BaseLineReports/{&2}}
- \url{http://www.MySite/BaseLineReports/{&1}/{&2}}

### Override Report Expiration Dates to Purge Reports from the SAS Content Server

By default, report jobs generate reports and purge expired versions of the same reports. You can use the Gallery transformation in report jobs to override report expiration dates and remove all previous versions of reports in the SAS Content Server.

To override report expiration dates for all reports in a report job, perform the following steps:

1. Open the report job for the reports that you want to purge.
2. Open the appropriate Gallery transformation.
3. On the **Report Parameters** tab, select **Delete report content that is older than specified days**: and specify the value as 1.
4. Save and close the report job.
5. Redeploy the report job.

The next time the report job runs, it generates a new version of the reports and remove all reports that are more than one day old.

### Back Up Your Data and Reports

For more information about backing up your data and reports, see Appendix 10, “Best Practices and Troubleshooting Tips” in the *SAS IT Resource Management: Administrator’s Guide*.

### Schedule Report Jobs Based on the Available Data

Before you run report jobs, ensure that the available data in your IT data mart is sufficient and complete for the type of report job that you want to run. Here are some recommendations to ensure that you have an appropriate set of available data to run various report jobs:

- Ensure that the aggregation jobs that a report job depends on has executed and completed.
- Schedule weekly report jobs to run at the beginning of the week to generate reports for the previous week.
• Schedule monthly report jobs to run at the beginning of the month to generate reports for the previous month.

• Ensure that you have data in your data mart for the last week and the last month before you schedule weekly and monthly jobs.
# Appendix 5
## Report Conversion Guide

### Converting Reports
- About Converting Reports .............................................. 188
- Global and Individual Report Tasks and Options ..................... 190
- Stack Columns Task (Reference 1) .................................... 192
- Custom User Code to Accumulate Stacked Data (Reference 2) ....... 193

### Creating Bar and Pie Charts Using SAS Enterprise Guide
- About Bar and Pie Charts ............................................... 195
- Bar Chart and Pie Chart Notes ........................................ 196
- Example 1 ....................................................................... 198
- Example 2 ....................................................................... 199
- Example 3 ....................................................................... 200
- Example 4 ....................................................................... 201
- Example 5 ....................................................................... 202
- Example 6 ....................................................................... 203
- Example 7 ....................................................................... 204
- Example 8 ....................................................................... 205
- Example 9 ....................................................................... 206

### Creating Line and Other Plots Using SAS Enterprise Guide
- About Line and Other Plots ............................................... 207
- Line and Other Plot Notes ................................................. 208
- Example 10 ..................................................................... 209
- Example 11 ..................................................................... 210
- Example 12 ..................................................................... 211
- Example 13 ..................................................................... 212
- Example 14 ..................................................................... 213
- Example 15 ..................................................................... 214
- Example 16 ..................................................................... 215
- Example 17 ..................................................................... 216
- Example 18 ..................................................................... 217
- Example 19 ..................................................................... 218
- Example 20 ..................................................................... 219

### Creating Tabular Reports Using SAS Enterprise Guide
- About Tabular Reports ...................................................... 219
- Example 21 ..................................................................... 221
- Example 22 ..................................................................... 222
- Example 23 ..................................................................... 223
- Example 24 ..................................................................... 224
- Example 25 ..................................................................... 225
- Example 26 ..................................................................... 226
- Example 27 ..................................................................... 227
Converting Reports

About Converting Reports

A primary enhancement of SAS IT Resource Management 3.3 is the incorporation of world-class data management, reporting, and report distribution capabilities that are available from SAS. In previous releases, SAS IT Resource Management relied upon a custom reporting interface to perform the following tasks:

- Summarize data by time periods that were specified at report generation time.
- Define and set report options.
- Generate a specific set of report types.

SAS Enterprise Guide has long been available to SAS IT Resource Management customers as a reporting tool option, but the primary reporting capability was the IT Resource Management report macros. Beginning with SAS IT Resource Management 3.1.1, SAS Enterprise Guide became the primary reporting tool for the SAS IT Resource Management solution. Legacy report macros for SAS IT Resource Management are no longer delivered.

This document provides a guideline for converting reports that are generated by the SAS IT Resource Management 2.7 reporting tools (the report macros) to new and enhanced reports using SAS IT Resource Management 3.3 and the SAS Enterprise Guide reporting tool.

Note: The contents of this appendix apply to SAS IT Resource Management 3.2 and any later versions. Therefore, references to SAS IT Resource Management 3.2 also apply to later versions.

Here are some similarities between using the SAS IT Resource Management 2.7 reporting tool and using SAS IT Resource Management 3.2 and SAS Enterprise Guide to generate reports in SAS IT Resource Management 3.2:

- Both reporting tools provide an interface that enables you to generate reports quickly and easily without requiring SAS programming skills.
- Both reporting tools enable you to write and submit SAS code to generate reports.
- Both reporting tools support a variety of SAS graph types and options.
- Both reporting tools generate the SAS code that is necessary to create the desired reports.
- Both reporting tools support the creation of report definitions that can be run in batch mode.

However, there are differences between using the SAS IT Resource Management 2.7 reporting tool and using SAS IT Resource Management 3.2 and SAS Enterprise Guide to generate reports in SAS IT Resource Management 3.2:

- The SAS IT Resource Management 2.7 reporting tools performed data manipulation tasks that were sometimes time consuming. Whenever possible, data manipulation
tasks are now accomplished while data is staged and aggregated by SAS IT Resource Management. This results in information map data sources that are report ready and can serve as input to SAS Enterprise Guide and SAS Web Report Studio.

- SAS Enterprise Guide delivers a user-friendly interface from which a significant set of report tasks and task options are selected. The user interface for SAS Enterprise Guide is far superior to the SAS IT Resource Management 2.7 user interface for report generation.

- SAS Enterprise Guide supports a much larger set of report types and options than those that are available in the SAS IT Resource Management 2.7 report macros. It also offers many data management and analytical procedures that are not available in SAS IT Resource Management 2.7.

SAS Enterprise Guide supports reporting from report-ready data that is accessible through information maps. Using information maps is the recommended method for accessing data in SAS IT Resource Management 3.2.

The following table shows the SAS IT Resource Management 2.7 macros and the SAS Enterprise Guide tasks that can be used to generate equivalent reports in SAS IT Resource Management 3.2. Much of the existing functionality that is available through SAS IT Resource Management 2.7 reporting macros is provided by SAS Enterprise Guide. The data manipulation capabilities are now handled by staging and aggregation processes of SAS IT Resource Management.

<table>
<thead>
<tr>
<th>SAS IT Resource Management 2.7 Report Macro</th>
<th>SAS Enterprise Guide Report Task or Feature That Is Used to re-create the Report for SAS IT Resource Management 3.2</th>
</tr>
</thead>
<tbody>
<tr>
<td>%CPCHART</td>
<td>Bar chart and pie chart tasks</td>
</tr>
<tr>
<td>%CPCHRT</td>
<td>Bar chart and pie chart tasks</td>
</tr>
<tr>
<td>%CPPLOT1</td>
<td>Line plot, scatter plot, area plot, and box plot tasks</td>
</tr>
<tr>
<td>%CPPLOT2</td>
<td>Line plot task</td>
</tr>
<tr>
<td>%CPTABRPT</td>
<td>Summary tables task</td>
</tr>
<tr>
<td>%CPPPRINT</td>
<td>List data task</td>
</tr>
<tr>
<td>%CPSRCRPT</td>
<td>Program Node task</td>
</tr>
<tr>
<td>%CPG3D</td>
<td>3-D Scatter plot task</td>
</tr>
<tr>
<td>%CPGTPLT</td>
<td>Document builder feature</td>
</tr>
<tr>
<td>%CPSETHAX</td>
<td>SAS Enterprise Guide report option for selected reports</td>
</tr>
<tr>
<td>%CPIDTOPN</td>
<td>Information map filter or Query task</td>
</tr>
</tbody>
</table>
SAS IT Resource Management 2.7 Report Macro

<table>
<thead>
<tr>
<th>SAS Enterprise Guide Report Task or Feature That Is Used to re-create the Report for SAS IT Resource Management 3.2</th>
</tr>
</thead>
<tbody>
<tr>
<td>%CPRUNRPT</td>
</tr>
<tr>
<td>Stored process feature</td>
</tr>
<tr>
<td>%CPSPEC</td>
</tr>
<tr>
<td>Tile chart task</td>
</tr>
<tr>
<td>%CPEXCEPT</td>
</tr>
<tr>
<td>Information map filter or Query task</td>
</tr>
<tr>
<td>%CPHTREE</td>
</tr>
<tr>
<td>Gallery Task</td>
</tr>
<tr>
<td>%CPMANRPT</td>
</tr>
<tr>
<td>Gallery Task</td>
</tr>
<tr>
<td>%CPWEBINI</td>
</tr>
<tr>
<td>Gallery Task</td>
</tr>
<tr>
<td>%CPXHTML</td>
</tr>
<tr>
<td>Gallery Task</td>
</tr>
<tr>
<td>%CPENTCYP</td>
</tr>
<tr>
<td>Obsolete</td>
</tr>
</tbody>
</table>

For detailed information about creating specific reports and setting report task options using SAS Enterprise Guide, see the following sections.

**Global and Individual Report Tasks and Options**

**About Report Tasks and Options**

To create reports with SAS Enterprise Guide, use the report task that is associated with the report that you want to create. You can set the options for the report in one of the following three ways:

- Set global options in the Options window. These options apply to all tasks in the SAS Enterprise Guide project.
- Set options in each individual report task.
- Set options in the ITRM Gallery task when working with report definitions that will run in batch mode.

The report options and their respective functions are labeled clearly and are described in the Help for SAS Enterprise Guide. Report tasks with similar options use similar Options windows.

**Global Report Task Options**

In SAS Enterprise Guide, there are a few report task options that can be set for all report tasks in your project. To set one of these options, select **Tools ➤ Options** from the menu bar. Then, on the left pane of the Options window, select the category of report options that you want to configure. The following list shows some of the global options that you can set.

- **Graph** enables you to specify the graph format (such as ActiveX or PNG) and graph dimensions (such as height and width).
- **Tasks General** enables you to specify the report title and footnote.
• **Viewer** enables you to specify how you want to view report output (such as SAS Enterprise Guide or your local browser).

• **Custom Code** enables you to specify options related to using custom code.

**Global Color, Pattern, and Symbol Options Using SAS Templates**

In SAS Enterprise Guide, pattern and symbol options can be set at the individual report task level. However, you can set these options once for the entire project using SAS templates and style sheets. Global options can be set using this method and can still be overridden in an individual report task for a specific task. To set these global graph options, perform the following steps:

1. Use SAS to create your custom SAS template.
2. Use SAS Enterprise Guide to create your custom style sheet with the same name as your custom SAS template.
3. Set the custom style sheet as the default style.
4. Run your report tasks.

Reports that do not have these graph options set for the report task will use the colors, patterns, and symbols that are set in your SAS template. For details about how to create a custom SAS Template and style sheet, see “About Templates and Style Sheets” on page 88.

**Individual Report Task Options**

Most report task options are set individually by specifying values for each report task. To set values for the report task options in an individual report task, perform the following steps:

1. Right-click a report task and select **Modify <report task name>**.
2. Select from the various menu options in the left pane, and specify values for the corresponding parameters.

Click **Help** to view the Help on any specific option in the current window.

**Top N and Bottom N Reporting**

In SAS IT Resource Management 2.7, some report types support the Top N and Bottom N reporting option. For other report types, using the macro %CPIDTOPN is required.

You can use SAS Enterprise Guide to report on the top or bottom contributors for a specific column in SAS IT Resource Management 3.2. To do so, you can use a filter to select the top or bottom contributors for a specific rank column that is created when data is aggregated by SAS IT Resource Management. Information map filters can be defined (using Information Map transformations in SAS IT Resource Management or using SAS Information Map Studio) and selected (using the **Filter** tab of the Information Map window) in SAS Enterprise Guide. Filters can also be specified within SAS Enterprise Guide Query tasks.

**Report Output**

In SAS Enterprise Guide, you can generate graph output to the SAS Enterprise Guide window or to a local browser. You can specify your preference by selecting **Tools → Options** from the menu bar. You can also generate graph output by publishing to a Web server or to a file system.
You can use the ITRM Gallery task to create report definitions that are submitted in report jobs. The report jobs generate reports in the SAS content server and are displayed with the Gallery Manager.

You can also use SAS Management Console to define channels and then select a channel when publishing from SAS Enterprise Guide. In addition, if you use the SAS Report format, a report can be published to a repository and SAS Web Report Studio. For more information about publishing SAS Enterprise Guide reports, see SAS Enterprise Guide Help.

**Print a Report**

To print a report from the SAS Enterprise Guide window select **File ⇒ Print** or right-click on the SAS Enterprise Guide report window and select **Print**. You can also use your Web browser print capabilities to print reports when viewing them from a browser in SAS Enterprise Guide, SAS Information Delivery Portal, and Gallery Manager.

**Stack Columns Task (Reference 1)**

The Stack Columns task in SAS Enterprise Guide enables you to stack your data so that multiple columns of data can become multiple rows of data. This step is required for re-creating certain charts and plots that are available in SAS IT Resource Management 2.7.

The following example shows where two analysis variables are stacked. Assign the variables from the **Variables to assign** box to the appropriate role in the **Task roles** box.

Next, select **Column Naming** to open the Column Naming window and change the default column names and labels for the new columns that are created. This step is optional. However, changing the default column labels is recommended because they are very long and can cause unexpected errors for some graph types.
For more information about working with the Stack Columns task, see the SAS Enterprise Guide Help.

**Custom User Code to Accumulate Stacked Data (Reference 2)**

The Stack Columns task in SAS Enterprise Guide enables you to reshape your data so that multiple columns of data can become multiple rows of data. This step is required for re-creating certain charts and plots that are available in SAS IT Resource Management 2.7.

However, custom user code is required if you also want to accumulate the data. This step is required for re-creating stacked plots that are available in SAS IT Resource Management 2.7.

You can add custom user code to the Stack Columns task by selecting Preview code ⇒ Insert Code. Your custom code must follow the RUN statement that follows the TRANSPOSE procedure code that is generated by SAS Enterprise Guide.

The following image shows the User Code window. You can insert custom user code wherever an “insert code” icon appears. The “insert code” icon at the bottom of the image shows where you should insert your custom user code to accumulate your data.
The custom user code that is required to accumulate your data is a DATA step that accumulates the output from PROC TRANSPOSE. The next display shows a code fragment that includes PROC TRANSPOSE and a DATA step for accumulating your stacked data.

Note that when writing the DATA step, some information is derived from PROC TRANSPOSE. The following information is derived from PROC TRANSPOSE:

- The list of BY variables must equal the list of BY variables of PROC TRANSPOSE.
- The required variable for the FIRST function will be derived from the BY variable list of PROC TRANSPOSE. The variable that is selected determines how your data is accumulated. Use the following rules to determine which variable to select for the FIRST function:
  - If you want to accumulate analysis variables (as shown in “Example 16” on page 215), then select the last BY variable from PROC TRANSPOSE for the FIRST function of your DATA step.
• If you want to accumulate a class variable (as shown in “Example 18” on page 217), then use the next to last BY variable from PROC TRANSPOSE for the FIRST function of your DATA step.

The following example shows how to accumulate an analysis variable.

```
data _LAST_; set _LAST_; by Date Stenam Machine; retain SaveVal; if FIRST.Machine then SaveVal=0; Average=sum(Average.SaveVal); SaveVal=Average; drop saveval; run;
```

Creating Bar and Pie Charts Using SAS Enterprise Guide

This section discusses the means by which bar and pie charts were created with SAS IT Resource Management 2.7 and the recommended means by which they are created using SAS IT Resource Management 3.2.

About Bar and Pie Charts

The following table shows the eight chart types that are available in SAS IT Resource Management 2.7 and the corresponding SAS Enterprise Guide task that is available to generate those chart types in SAS IT Resource Management 3.2.

**Table A5.2** SAS IT Resource Management 2.7 Chart Types and Corresponding SAS Enterprise Guide Tasks

<table>
<thead>
<tr>
<th>Chart Type</th>
<th>SAS Enterprise Guide Task</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vertical Bar</td>
<td>Bar Chart task</td>
</tr>
<tr>
<td>Horizontal Bar</td>
<td>Bar Chart task</td>
</tr>
<tr>
<td>Vertical Bar 3-D</td>
<td>Bar Chart task</td>
</tr>
<tr>
<td>Horizontal Bar 3-D</td>
<td>Bar Chart task</td>
</tr>
<tr>
<td>Pie</td>
<td>Pie Chart task</td>
</tr>
</tbody>
</table>
In SAS Enterprise Guide, the bar orientations (vertical and horizontal) are task subtype options that are available in the Bar Chart task. The bar dimensions (two-dimensional and three-dimensional) are appearance options in the Bar Chart and Pie Chart tasks.

This section provides more details about the SAS IT Resource Management 2.7 macros that create various types of bar and pie charts and the equivalent SAS Enterprise Guide steps that are required to re-create these types of reports.

The %CPCHART macro creates the following three bar chart types:
- one analysis column and one class column ("Example 1" on page 198)
- one analysis column, one class column, and one group column ("Example 2" on page 199)
- one analysis column, one class column, and one subgroup column ("Example 3" on page 200)

The %CPCCHRT macro creates the following four bar chart types:
- multiple analysis columns ("Example 4" on page 201)
- multiple analysis columns and one group column ("Example 5" on page 202)
- multiple analysis columns, one group column, and one subgroup column ("Example 6" on page 203)
- multiple analysis columns, one group column, and one stack column ("Example 7" on page 204)

The %CPCHART macro creates a pie chart of one analysis column and one class column ("Example 8" on page 205).

The %CPCCHRT macro creates a pie chart type of multiple analysis columns ("Example 9" on page 206).

The following sections show how to re-create these bar chart and pie chart types using SAS Enterprise Guide.

**Bar Chart and Pie Chart Notes**

Here are some notes that you might consider when working with bar charts and pie charts:

- Do not confuse the **Group bars by** role that is available in some chart tasks, with the **Group charts by** role. The **Group charts by** role is a role that is available in most report tasks. It enables you to create a different report page for each value of the **Group charts by** column.

- The **Transpose** task can be substituted for the **Stack Columns** task. For more information about the differences between the **Stack Columns** task and the **Transpose** task, see SAS Enterprise Guide Help.
• The graph examples in the following sections typically show two analysis columns wherever multiple analysis columns are supported.

• Some graph titles might refer to SAS IT Resource Management 2.7 terminology to help you make the transition from 2.7 to 3.2. For example, a class column that is assigned to a subgroup role in 2.7 might be assigned to a stack role in 3.2 to achieve the same results.
Example 1

**Bar Chart with One Analysis Column and One Class Column**

1. Select the Bar Chart task.
2. Select the **Simple Vertical Bar** chart type.
3. Assign one analysis column to the **Sum of** role.
4. Assign one class column to the **Column to chart** role.
5. (Optional) Assign one or more class columns to the **Group charts by** role.
Example 2

Bar Chart with One Analysis Column, One Class Column, and One Group Column

1. Select the Bar Chart task.
2. Select the Grouped Vertical Bar chart type.
3. Assign one analysis column to the Sum of role.
4. Assign one class column to the Column to chart role.
5. Assign one class column to the Group bars by role.
6. (Optional) Assign one or more class columns to the Group charts by role.
Example 3

Bar Chart with One Analysis Column, One Class Column, and One Subgroup Column

1. Select the Bar Chart task.
2. Select the Stacked Vertical Bar chart type.
3. Assign one analysis column to the Sum of role.
4. Assign one class column to the Column to chart role.
5. Assign one class column to the Stack role.
6. (Optional) Assign one or more class columns to the Group charts by role.
Example 4

**Bar Chart with Two Analysis Columns**

1. Select the Bar Chart task.
2. Select the **Multiple Measures Vertical Group** chart type.
3. Assign the columns that you want to chart to the **Sum of** role.
4. (Optional) Assign one or more class columns to the **Group charts by** role.
Example 5

**Bar Chart with Two Analysis Columns and One Group Column**

1. Select the Bar Chart task.
2. Select the **Multiple Measures Vertical Group** chart type.
3. Assign the columns that you want to chart to the **Sum of** role.
4. Assign one class column to the **Column to chart** role.
5. (Optional) Assign one or more class columns to the **Group charts by** role.
Example 6

Bar Chart with Two Analysis Columns, One Group Column, and One Subgroup Column

1. Select the Stack Columns task located in the Data category to transpose your data.

2. Assign the two analysis columns that you want to chart to the **Columns to Stack** role.

3. Assign all of the class columns used in your report (including **Group charts by** columns) to the **Group Analysis by** role.

4. Rename your new column labels. For information about how to do this, see “Stack Columns Task (Reference 1)” on page 192.

5. Run the Stack Columns task to transpose your data.

6. Select the Bar Chart task.

7. Select the **Grouped/Stacked Vertical Bar** chart type.

8. Assign the new transposed analysis column to the **Sum of** role.

9. Assign the new transposed class column to the **Column to chart** role.

10. Assign one class column to the **Group bars by** role.

11. Assign one class column to the **Stack** role.

12. (Optional) Assign one or more class columns to the **Group charts by** role.

*Note:* The difference between this bar chart example and “Example 7” on page 204 is in the column role assignments.
Example 7

Bar Chart with Two Analysis Columns, One Group Column, and One Stack Column

1. Select the Stack Columns task located in the Data category to transpose your data.
2. Assign the two analysis columns that you want to chart to the **Columns to Stack** role.
3. Assign all of the class columns used in your report (including **Group charts by** columns) to the **Group Analysis by** role.
4. Rename your new column labels. For information about how to do this, see “Stack Columns Task (Reference 1)” on page 192.
5. Run the Stack Columns task to transpose your data.
6. Select the Bar Chart task.
7. Select the **Grouped/Stacked Vertical Bar** or the **Grouped/Stacked Horizontal Bar** chart type.
8. Assign the new transposed analysis column to the **Sum of** role.
9. Assign one class column to the **Column to chart** role.
10. Assign one class column to the **Group bars by** role.
11. Assign the new transposed class column to the **Stack** role.
12. (Optional) Assign one or more class columns to the **Group charts by** role.

*Note:* The difference between this bar chart example and “Example 6” on page 203 is in the column role assignments.
Example 8

Pie Chart with One Analysis Column and One Class Column

1. Select the Pie Chart task.
2. Select the Simple Pie chart type.
3. Assign one analysis column to the Sum of role.
4. Assign one class column to the Column to chart role.
5. (Optional) Assign one or more class columns to the Group charts by role.
Example 9

Pie Chart with Two Analysis Columns

1. Select the Stack Columns task located in the Data category to transpose your data.
2. Assign the two analysis columns that you want to chart to the Columns to Stack role.
3. Assign all of the class columns used in your report (including Group charts by columns) to the Group Analysis by role.
4. Rename your new column labels. For information about how to do this, see “Stack Columns Task (Reference 1)” on page 192.
5. Run the Stack Columns task to transpose your data.
6. Select the Pie Chart task.
7. Select the Simple Pie chart type.
8. Assign the new transposed analysis column to the Sum of role.
9. Assign the new transposed class column to the Column to chart role.
10. (Optional) Assign one or more class columns to the Group charts by role.
Creating Line and Other Plots Using SAS Enterprise Guide

This section discusses the means by which line and other plots were created with SAS IT Resource Management 2.7 and the recommended means by which they are created using SAS IT Resource Management 3.2.

About Line and Other Plots

The following table shows the 15 plot types or options that are available in SAS IT Resource Management 2.7 and the corresponding SAS Enterprise Guide tasks that are available to generate those chart types in SAS IT Resource Management 3.2.

<table>
<thead>
<tr>
<th>Plot Type</th>
<th>SAS Enterprise Guide Task</th>
</tr>
</thead>
<tbody>
<tr>
<td>2XY</td>
<td>Line Plot task</td>
</tr>
<tr>
<td>Line</td>
<td>Line Plot task</td>
</tr>
<tr>
<td>Join</td>
<td>Line Plot task</td>
</tr>
<tr>
<td>Needle</td>
<td>Line Plot task</td>
</tr>
<tr>
<td>Smooth</td>
<td>Line Plot task</td>
</tr>
<tr>
<td>Spline</td>
<td>Line Plot task</td>
</tr>
<tr>
<td>Standard Deviation</td>
<td>Line Plot task</td>
</tr>
<tr>
<td>Step Center</td>
<td>Line Plot task</td>
</tr>
<tr>
<td>Percent</td>
<td>Line Plot task</td>
</tr>
<tr>
<td>Scatter</td>
<td>Scatter Plot task</td>
</tr>
<tr>
<td>Stack</td>
<td>Area Plot task</td>
</tr>
<tr>
<td>Stack Percent</td>
<td>Area Plot task</td>
</tr>
<tr>
<td>Box Plot</td>
<td>Box Plot task</td>
</tr>
<tr>
<td>Hi-Low plot</td>
<td>Box Plot task</td>
</tr>
<tr>
<td>Regression</td>
<td>Various regression plots in the Analyze category of plots</td>
</tr>
</tbody>
</table>
This section provides more detail about the SAS IT Resource Management 2.7 macro that creates various types of plots and the equivalent SAS Enterprise Guide steps that are required to re-create these types of reports.

The %CPPLOT1 macro is used to create the following plot types:

- one analysis column and one class column as shown in the following examples:
  - line plot ("Example 10" on page 209)
  - step plot ("Example 11" on page 210)
  - box plot ("Example 12" on page 211)
  - hi-low plot ("Example 13" on page 212)
- multiple analysis columns (scatter plot – "Example 14" on page 213)
- multiple analysis columns and one class column as shown in the following examples:
  - line plot ("Example 15" on page 214)
  - line stack plot ("Example 16" on page 215)
- one analysis column, one class column, and one group column as shown in the following examples:
  - line plot ("Example 17" on page 216)
  - line stack plot ("Example 18" on page 217)

The %CPPLOT2 macro creates a line plot that is named 2XY Plot with Multiple Analysis Columns and One Class Column ("Example 19" on page 218).

**Line and Other Plot Notes**

Here are some notes that you might consider when working with plot reports:

- Do not confuse the Group role that is available in some plot tasks, with the Group charts by role. The Group charts by role is a role that is available in most report tasks. It enables you to create a different report page for each value of the Group charts by column.
- The graph examples in the following sections typically show two analysis columns wherever multiple analysis columns are supported.
Example 10

Line Plot with One Analysis Column and One Class Column

1. Select the Line Plot task.
2. Select the Line Plot subtask.
3. Assign one analysis column to the Vertical role.
4. Assign one date or time class column to the Horizontal role.
5. (Optional) Assign one or more class columns to the Group charts by role.
Example 11

Step Plot with One Analysis Column and One Class Column

1. Select the Line Plot task.
2. Select the Step Plot subtask.
3. Assign one analysis column to the Vertical role.
4. Assign one date or time class column to the Horizontal role.
5. (Optional) Assign one or more class columns to the Group charts by role.
Example 12

**Box Plot with One Analysis Column and One Class Column**

1. Select the Box Plot task.
2. Select the Box Plot subtask.
3. Assign one analysis column to the **Vertical** role.
4. Assign one date or time class column to the **Horizontal** role.
5. (Optional) Assign one or more class columns to the **Group charts by** role.
Example 13

Hi-Low Plot with One Analysis Column and One Class Column

1. Select the Box Plot task.
2. Select the Hi-Low subtask.
3. Assign one analysis column to the Vertical role.
4. Assign one date or time class column to the Horizontal role.
5. (Optional) Assign one or more class columns to the Group charts by role.
Example 14

Scatter Plot with Two Analysis Columns

1. Select the Scatter Plot task.
2. Select any of the Scatter Plot subtasks.
3. Assign one analysis column to the **Vertical** role.
4. Assign one analysis column to the **Horizontal** role.
5. (Optional) Assign one or more class columns to the **Group charts by** role.
Example 15

*Line Plot with Two Analysis Columns and One Class Column*

1. Select the Line Plot task.
2. Select the Multiple vertical column line plots using overlay subtask.
3. Assign two analysis columns to the **Vertical** role.
4. Assign one date or time class column to the **Horizontal** role.
5. (Optional) Assign one or more class columns to the **Group charts by** role.
Example 16

Stack Plot with Two Analysis Columns and One Class Column

1. Select the Stack Columns task located in the Data category to transpose and accumulate your data.

2. Assign the two analysis columns that you want to plot to the **Columns to Stack** role.

3. Assign all of the class columns used in your report (including **Group charts by** columns) to the **Group Analysis by** role.

4. Rename your new column labels. For information about how to do this, see “Stack Columns Task (Reference 1)” on page 192.

5. Insert SAS custom code to accumulate your data. See “Custom User Code to Accumulate Stacked Data (Reference 2)” on page 193.

6. Run the Stack Columns task to transpose and accumulate your data.

7. Select the Area Plot task.

8. Select the Multiple area plots by group column subtask.

9. Assign the new transposed analysis columns to the **Vertical** role.

10. Assign the new transposed class column to the **Group** role.

11. Assign one date or time class column to the **Horizontal** role.

12. (Optional) Assign one or more class columns to the **Group charts by** role.
Example 17

Line Plot with One Analysis Columns, One Class Column, and One Group Column

1. Select the Line Plot task.
2. Select the Multiple line plots by group column subtask.
3. Assign one analysis column to the Vertical role.
4. Assign one date or time class column to the Horizontal role.
5. Assign one class column to the Group role.
6. (Optional) Assign one or more class columns to the Group charts by role.
**Example 18**

**Stack Plot with One Analysis Columns, One Class Column, and One Group Column**

1. Select the Stack Columns task located in the Data category to transpose and accumulate your data.
2. Assign one analysis column that you want to plot to the **Columns to Stack** role.
3. Assign all of the class columns used in your report (including **Group charts by** columns) to the **Group Analysis by** role. Ensure that the class column that you want to accumulate in Step 5 is the last column in the list.
4. Rename your new column labels. See “Stack Columns Task (Reference 1)” on page 192.
6. Run the Stack Columns task to transpose and accumulate your data.
7. Select the Area Plot task.
8. Select the Multiple area plots by group column subtask.
9. Assign the new transposed analysis columns to the **Vertical** role.
10. Assign one date or time class column to the **Horizontal** role.
11. Assign one class column to the **Group** role.
12. (Optional) Assign one or more class columns to the **Group charts by** role.
Example 19

2XY Plot with Two Analysis Columns and One Class Column

1. Select the Line Plot task.
2. Select the Line Plot subtask.
3. Assign one analysis column to the **Vertical** role.
4. Assign one analysis column to the **Vertical (Right)** role.
5. Assign one date or time class column to the **Horizontal** role.
6. (Optional) Assign one or more class columns to the **Group charts by** role.
Example 20

Three-Dimensional Graph
The three-dimensional graph that is available in SAS IT Resource Management 2.7 differs from the three-dimensional graph that is generated with SAS Enterprise Guide. In SAS Enterprise Guide, the columns for the horizontal, vertical, and depth task role must be numeric. In SAS IT Resource Management 2.7, a class column is supported.

You can use the Line Plot task in SAS Enterprise Guide to generate a plot that shows all of the information that is available in the three-dimensional graph from SAS IT Resource Management 2.7. To create this graph, see “Example 17” on page 216.

Creating Tabular Reports Using SAS Enterprise Guide

This section discusses the means by which tabular reports were created with SAS IT Resource Management 2.7 and the recommended means by which they are created using SAS IT Resource Management 3.2.

About Tabular Reports

The following table shows the six tabular report types that are available in SAS IT Resource Management 2.7 and the corresponding SAS Enterprise Guide task that is available to generate those report types in SAS IT Resource Management 3.2.
Table A5.4  SAS IT Resource Management 2.7 Report Types and Corresponding SAS Enterprise Guide Tasks

<table>
<thead>
<tr>
<th>Tabular Report Type</th>
<th>SAS Enterprise Guide Task</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analysis X Statistic</td>
<td>Summary Tables task</td>
</tr>
<tr>
<td>Class (value) X Analysis (Statistic)</td>
<td>Summary Tables task</td>
</tr>
<tr>
<td>Class (value) X Statistic (Analysis)</td>
<td>Summary Tables task</td>
</tr>
<tr>
<td>Class (value) X Analysis (Sum)</td>
<td>Summary Tables task</td>
</tr>
<tr>
<td>Class values X Class (Analysis (Statistic))</td>
<td>Summary Tables task</td>
</tr>
<tr>
<td>Class values X Analysis (Statistic)</td>
<td>Summary Tables task</td>
</tr>
</tbody>
</table>

SAS IT Resource Management 2.7 uses the macro %CPTABRPT to create all of the variations that are shown in the preceding table. In SAS Enterprise Guide, you can create any of these variations with the Summary Tables task.

The following examples show the report output and the Summary Tables task for each of the preceding variations. To create any of the reports in examples 21–27, perform the following steps:

1. Select the **Summary Tables** task located in the **Describe** menu.

2. In the Task Roles window, assign the analysis columns that you want to include in your report to the **Analysis columns** task role.

3. In the Task Roles window, assign the class columns that you want to include in your report to the **Classification columns** task role.

4. In the Summary Tables window, drag and drop the analysis columns and the classification columns to the appropriate section of the **Box Area**. The second display of each example below provides a guide for where to drag and drop the variables.

5. (Optional) In the Task Roles window, assign one or more class columns to the **Pages** role.
Example 21

Tabular Report Analysis X Statistic

<table>
<thead>
<tr>
<th></th>
<th>Mean</th>
<th>Max</th>
<th>Min</th>
</tr>
</thead>
<tbody>
<tr>
<td>BytesIn</td>
<td>21.52</td>
<td>49.16</td>
<td>7.13</td>
</tr>
<tr>
<td>BytesOut</td>
<td>9.60</td>
<td>33.68</td>
<td>0.67</td>
</tr>
</tbody>
</table>

Generated on September 01, 2009 at 3:17 PM
Example 22

Tabular Report Class (Value) X Analysis (Statistic)

Multiple Analysis Variables, Multiple Statistics, One Class Variable

<table>
<thead>
<tr>
<th></th>
<th>BytesIn</th>
<th></th>
<th>BytesOut</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Mean</td>
<td>Max</td>
<td>Mean</td>
<td>Max</td>
</tr>
<tr>
<td>Machine</td>
<td>21.45</td>
<td>49.15</td>
<td>9.97</td>
<td>33.38</td>
</tr>
<tr>
<td>Machine1</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Machine2</td>
<td>21.52</td>
<td>41.07</td>
<td>9.59</td>
<td>23.23</td>
</tr>
<tr>
<td>Machine3</td>
<td>21.78</td>
<td>46.71</td>
<td>9.23</td>
<td>27.48</td>
</tr>
</tbody>
</table>

Generated on September 01, 2009 at 3:17 PM
Example 23

**Tabular Report Class (Value) X Statistic (Analysis)**

<table>
<thead>
<tr>
<th>Machine</th>
<th>Mean BytesIn</th>
<th>Mean BytesOut</th>
<th>Max BytesIn</th>
<th>Max BytesOut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Machine1</td>
<td>21.45</td>
<td>9.57</td>
<td>49.16</td>
<td>33.38</td>
</tr>
<tr>
<td>Machine2</td>
<td>21.62</td>
<td>9.59</td>
<td>41.07</td>
<td>23.23</td>
</tr>
<tr>
<td>Machine3</td>
<td>21.78</td>
<td>9.23</td>
<td>45.71</td>
<td>27.48</td>
</tr>
</tbody>
</table>

Generated on September 01, 2009 at 3:17 PM
Example 24

**Tabular Report Class (Value) X Analysis (Sum)**

<table>
<thead>
<tr>
<th>Machine</th>
<th>BytesIn</th>
<th>BytesOut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Machine1</td>
<td>3860.44</td>
<td>1794.27</td>
</tr>
<tr>
<td>Machine2</td>
<td>3892.05</td>
<td>1726.17</td>
</tr>
<tr>
<td>Machine3</td>
<td>3920.70</td>
<td>1661.09</td>
</tr>
</tbody>
</table>

Generated on September 01, 2009 at 3:17 PM
Example 25

Tabular Report Class Values X Class (Analysis (Statistic))

Multiple Class Variables, Multiple Analysis Variables and Multiple Statistics

<table>
<thead>
<tr>
<th>SiteName</th>
<th>Site1</th>
<th>Site2</th>
<th>Site3</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>BytesIn</td>
<td>BytesOut</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Sum</td>
<td>Mean</td>
<td>Sum</td>
</tr>
<tr>
<td>Machine</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Machine1</td>
<td>1288.70</td>
<td>21.48</td>
<td>627.56</td>
</tr>
<tr>
<td>Machine2</td>
<td>1254.89</td>
<td>20.91</td>
<td>591.20</td>
</tr>
<tr>
<td>Machine3</td>
<td>1350.13</td>
<td>22.50</td>
<td>553.78</td>
</tr>
</tbody>
</table>

Generated on September 01, 2009 at 3:17 PM
Example 26

Tabular Report Class Values X Analysis (Statistic)

<table>
<thead>
<tr>
<th>SiteName</th>
<th>Machine</th>
<th>BytesIn</th>
<th>BytesOut</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Machine1</td>
<td>Mean</td>
<td>Sum</td>
</tr>
<tr>
<td>Site1</td>
<td>21.48</td>
<td>1268.70</td>
<td>627.56</td>
</tr>
<tr>
<td></td>
<td>Machine2</td>
<td>20.91</td>
<td>1254.89</td>
</tr>
<tr>
<td></td>
<td>Machine3</td>
<td>22.50</td>
<td>1350.13</td>
</tr>
<tr>
<td>Site2</td>
<td>21.97</td>
<td>1318.39</td>
<td>602.42</td>
</tr>
<tr>
<td></td>
<td>Machine2</td>
<td>22.95</td>
<td>1322.76</td>
</tr>
<tr>
<td></td>
<td>Machine3</td>
<td>22.52</td>
<td>1351.47</td>
</tr>
<tr>
<td>Site3</td>
<td>20.89</td>
<td>1253.36</td>
<td>564.30</td>
</tr>
<tr>
<td></td>
<td>Machine2</td>
<td>21.91</td>
<td>1314.40</td>
</tr>
<tr>
<td></td>
<td>Machine3</td>
<td>20.32</td>
<td>1219.09</td>
</tr>
</tbody>
</table>

Generated on September 01, 2009 at 3:17 PM
Example 27

Print Report
SAS IT Resource Management 2.7 uses the macro `%CPPRINT` to create print reports. In SAS Enterprise Guide, you can create a print report, known as a listing report, using the List Data task that is available in the Describe category of report tasks.

To create a print report, perform the following steps:

1. Select the List Data task that is located in the Describe category of report tasks.

2. In the Task Roles box, assign the analysis columns and classification columns that you want to include in your report to the List columns task role.

3. (Optional) In the Task Roles box, assign one or more class columns to the Page by role.

---

<table>
<thead>
<tr>
<th>Row Number</th>
<th>SiteName</th>
<th>Machine</th>
<th>BytesIn</th>
<th>BytesOut</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Site1</td>
<td>Machine1</td>
<td>19.0216</td>
<td>11.7330</td>
</tr>
<tr>
<td>2</td>
<td>Site2</td>
<td>Machine1</td>
<td>17.0446</td>
<td>8.2891</td>
</tr>
<tr>
<td>3</td>
<td>Site3</td>
<td>Machine1</td>
<td>21.0311</td>
<td>6.4904</td>
</tr>
<tr>
<td>4</td>
<td>Site1</td>
<td>Machine2</td>
<td>13.9674</td>
<td>4.5770</td>
</tr>
<tr>
<td>5</td>
<td>Site2</td>
<td>Machine2</td>
<td>20.4474</td>
<td>9.3442</td>
</tr>
<tr>
<td>6</td>
<td>Site3</td>
<td>Machine2</td>
<td>21.7311</td>
<td>5.3488</td>
</tr>
<tr>
<td>7</td>
<td>Site1</td>
<td>Machine3</td>
<td>9.3352</td>
<td>9.3088</td>
</tr>
<tr>
<td>8</td>
<td>Site2</td>
<td>Machine3</td>
<td>28.0716</td>
<td>9.2357</td>
</tr>
<tr>
<td>9</td>
<td>Site3</td>
<td>Machine3</td>
<td>22.2383</td>
<td>12.6479</td>
</tr>
</tbody>
</table>

Report Listing
Date=07/03/2009

Generated on September 01, 2009 at 3:17 PM
Example 28

Source Code
SAS IT Resource Management 2.7 uses the macro %CPSRCRPT to submit SAS code that is stored in a catalog source file. In SAS Enterprise Guide, you submit SAS code by creating and submitting a Program node task. The code that you write is saved in the task within the SAS Enterprise Guide project.

To create a Code task to run source code, perform the following steps:

1. Select File ➔ New ➔ Code from the menu bar.
2. Enter your SAS code in the Code window.
3. Right-click and select Run to submit the code.

Working with SAS IT Resource Management

Dynamically Summarized Reporting
SAS IT Resource Management 3.2 enables you to perform all of the data transformations that are necessary to produce analysis and report-ready data before generating reports. You can use the SAS technologies that are available in the SAS IT Resource Management client that are specifically designed for data integration to prepare IT data for analysis and reporting. This will improve the performance of SAS IT Resource Management reporting and the system as a whole.

In earlier versions of SAS IT Resource Management, the performance data warehouse (PDB) structure limited the solution to predefined time period summarizations. In response, SAS IT Resource Management 2.7 reporting macros evolved to perform special time-based summarizations that were calculated at the time of report generation. In SAS IT Resource Management 3.2, the IT data mart structure replaces the PDB and enables you to summarize data through the SAS IT Resource Management 3.2 transformation. Therefore, dynamic summarization capabilities are no longer provided by the %CP report macros.

The SAS IT Resource Management Adapter Setup wizard provides several of the summarized aggregations that were typically created at the time of report generation by SAS IT Resource Management 2.7 report macros.

SAS IT Resource Management 3.2 includes formulas that support various time periods. By choosing the aging columns for your summarized aggregations that use these new formulas, you can create summarized aggregations that provide the equivalent dynamic summarization that is available in SAS IT Resource Management 2.7 reporting. For more information about creating custom aggregations, see the “Creating Aggregation Tables with the Summarized Aggregation Table Wizard” topic in the SAS IT Resource Management: Administrator’s Guide.

Working with Migrated PDBs
With few exceptions, column names and labels are preserved when migrating a SAS IT Resource Management 2.7 PDB to a SAS IT Resource Management 3.2 IT data mart.
Therefore, user-written SAS code that is not dependent on SAS IT Resource Management 2.7 report macros can be submitted to re-create existing reports with minimal changes.

Here are a few tips for re-creating existing reports:

- The DATETIME column that was required in SAS IT Resource Management 2.7 is no longer required in SAS IT Resource Management 3.2. In summarized aggregations, the columns DAYDATE, WEEKDATE, MONTHDATE, and YEARDATE are used instead.

- Table names have changed. The level name is now appended to the original name. For example, a table with the original name SARDEV in the DETAIL library is now named SARDEV_DETAIL.

- SAS IT Resource Management tables are now physical SAS data sets rather than SAS DATA step views. Code that requires views as input will not work.

- Additional columns are created in the staged table to convert COUNT, TIME, and TIMETICKS type variables into rates. The rate variables are what should be specified in the summarized aggregation for computing statistics that are compatible with SAS IT Resource Management 2.7 reporting.

For more details about these changes and for more information about migrating PDBs and working with migrated PDBs, see the *SAS IT Resource Management 3.21 Migration Documentation*. 
## Index

<table>
<thead>
<tr>
<th>Numbers</th>
<th>box plot standards 153</th>
</tr>
</thead>
<tbody>
<tr>
<td>2XY plots</td>
<td>Box Plot task examples 211</td>
</tr>
<tr>
<td>example 218</td>
<td>BY variables in reports 151</td>
</tr>
<tr>
<td>standards 152</td>
<td></td>
</tr>
</tbody>
</table>

| A                             |                         |
| accessibility 8               |                         |
| Adapter Setup wizard 10       |                         |
| defined 19                    |                         |
| deploying and running jobs 29 |                         |
| domain categories 30          |                         |
| Gallery transformations created 76 |                     |
| report jobs 26, 70            |                         |
| report types created 31       |                         |
| using 20                      |                         |
| adapters 4                    |                         |
| axis standards for reports 150|                         |

| B                             |                         |
| backups                       |                         |
| data and reports 184          |                         |
| reports on SAS Content Server 111 |                     |
| bar chart standards 153       |                         |
| Bar Chart task 195            |                         |
| examples 198                  |                         |
| bar line standards 153        |                         |
| batch reporting 10            |                         |
| creating new reports from scratch 43 |                 |
| creating or modifying batch reports 35 |            |
| designing reports 183         |                         |
| modifying data sources 36     |                         |
| modifying report definitions 40 |                     |
| modifying the appearance of batch reports 38 |      |
| style sheets for 91          |                         |
| templates 90                 |                         |
| using a supplied project as a template 42 |             |
| viewing reports 31            |                         |

| C                             |                         |
| color standards for reports 150|                     |
| converting reports 188        |                         |

| D                             |                         |
| data sources                  |                         |
| modifying for batch reporting 36 |                     |
| specifying location 87        |                         |
| documentation                 |                         |
| SAS Add-In for Microsoft Office 130 |                 |
| SAS BI Dashboard 137          |                         |
| SAS Enterprise Guide 119      |                         |
| SAS Information Delivery Portal 134 |                 |
| SAS Web Report Studio 125     |                         |
| domain categories 30          |                         |
| dynamically summarized reporting 228 |             |

| F                             |                         |
| fonts and formats for reports 151 |                     |
| footnotes for reports 149      |                         |

| G                             |                         |
| Gallery Manager 5             |                         |
| Action buttons 106            |                         |
| banner 100                    |                         |
| Browse pane 106               |                         |
| cache 110                     |                         |
| copying and e-mailing reports 99 |                     |
| Favorites pane 105            |                         |
| Filters pane 101              |                         |
| Flow view 104                 |                         |
| Gallery pane 102              |                         |
| logging on 99                 |                         |
organizing reports 96
overview 95
status bar 105
Table view 103
Thumbnail view 104
use of SAS Content Server 110
viewing reports 97
Gallery transformations 13, 74
adding to report jobs 76
created by Adapter Setup wizard 76
deleting 87
editing 86
editing properties 72
naming conventions 78, 145
properties 75

H
Help
SAS Add-In for Microsoft Office 130
SAS BI Dashboard 137
SAS Enterprise Guide 119
SAS Information Delivery Portal 134
SAS IT Resource Management 6
SAS Web Report Studio 125
Hi-Low subtask 212

I
information maps
creating reports in SAS Web Report Studio 124
for batch reporting 12
modifying for batch reporting 36
naming conventions 141
interactive reporting 115
IT data marts
accessing with SAS Enterprise Guide 118
ITRM folder 110
ITRM Gallery task
accessing and navigating 60
deleting user-defined report filter values 66
for batch reporting 12
managing user-defined report filters 65
modifying report definitions 68
sharing user-defined report filter values 67
working with in SAS Enterprise Guide 59

L
line plot standards 152
Line Plot task 207
examples 209, 214, 216, 218
list data standards for reports 153
listing report example 227

M
Microsoft Office 5, 127
migration wizard 52
prerequisites 52
running 52

N
naming conventions
Gallery transformations 78, 145
information maps 141
report jobs 145
reporting 141, 145
SAS Enterprise Guide projects 144
needle plot standards 152

O
online Help
See Help
options for report tasks 190
output for reports 191

P
PDBs 228
Pie Chart task 195
examples 205
plots 207
portal
See SAS Information Delivery Portal
print report example 227
printing reports 192
projects, SAS Enterprise Guide 45, 180
publishing reports 130

R
reference line standards for reports 151
report definitions 12
creating with ITRM Gallery task 59
modifying for batch reports 40
modifying with ITRM Gallery task 68
report jobs 13, 69
adding Gallery transformations 76
copying 72
created by Adapter Setup wizard 26, 70
creating 71
deleting 73
deploying and running 73
modifying 72
naming conventions 145
report tasks 189
reporting
batch 10
dynamically summarized 228
interactive 115
naming conventions 141, 145
standards 147
Top N and Bottom N 191
reports
2XY plot standards 152
axis standards 150
backing up 175
backing up on SAS Content Server 111
bar chart standards 153
bar line standards 153
box plot standards 153
BY variables in 151
color standards 150
converting 188
copying 99
created by Adapter Setup wizard 31
creating new batch reports from scratch 43
creating with information maps in SAS Web Report Studio 124
deleting sample 111
designing for batch jobs 183
duplicate 170
e-mailing 99, 125
fonts and formats 151
footnotes 149
generating with SAS Enterprise Guide projects 46
interactive 115
limiting retrieval by filters 178
line plot standards 152
list data standards 153
managing user-defined settings for filters 65
missing 167, 168
modifying in SAS Enterprise Guide projects 57
needle plot standards 152
organizing 96
output 13, 191
overriding expiration dates 184
printing 192
publishing 130
purging from SAS Content Server 184
reference line standards 151
running during low usage periods 177
standards 147
symbol standards 151
titles 148
viewing 97
S
SAS Add-In for Microsoft Office 5, 127
accessing 127
accessing SAS IT Resource Management data 128
documentation 130
executing stored processes 129
Help 130
SAS BI Dashboard 5, 135
documentation 137
Help 137
logging on 136
SAS Business Intelligence Platform 5
SAS Content Server 109
backing up reports 111
duplicate reports 170
purging reports 184
storage of report output 13, 109
SAS Data Integration Studio 4
SAS Enterprise Guide 5, 117
accessing IT data marts 118
accessing SAS IT Resource Management projects 118
accessing SAS Metadata Repository 50
documentation 119
Help 119
managing projects 180
migrating projects 52
modifying reports in supplied projects 57
naming conventions for projects 144
preparing to work 50
projects for batch reporting 12, 38
report tasks 189
running source code 228
setting up for ITRM data 50
starting 117
working with ITRM Gallery task 59
working with supplied projects 45
SAS High Performance Forecasting 5
SAS Information Delivery Portal 5, 131
accessing 131
documentation 134
Help 134
logging off 132
organization of content 132
SAS Information Map Studio 5
SAS IT Resource Management
  accessing data with SAS Add-In for Microsoft Office  128
  accessing projects with SAS Enterprise Guide  118
  benefits 4
  defined 3
  Help 6
  operation 4
SAS Metadata Repository 5
  accessing for SAS Enterprise Guide  50
SAS Statistics and Econometric Time Series 5
SAS Web Report Studio 5, 121
  creating reports with information maps  124
  documentation 125
  Help 125
  logging on 121
Scatter Plot task example 213
scheduling report jobs  184
Section 508 compliance  8
source code
  running in SAS Enterprise Guide 228
Stack Columns task 192
  example 215
Stack Plot task examples  217
standards for reporting 147
Step Plot subtask  210
stored processes  129
style sheets 88
  default 89
  for batch reports 91
symbol standards for reports 151

T
  tabular reports 219
    examples 221
  templates 88
    default 88
    for batch reports 90
    for color, pattern, and symbol options 191
  three-dimensional graph example 219
  tile charts with Web links  183
  titles for reports 148
  Top N and Bottom N reporting 191
  troubleshooting
    duplicate reports on SAS Content Server 170
    embedded user ID and password 171
    invalid password 171
    invalid user ID 171
    middle-tier connection 172
    reports missing from Gallery Manager 167
    reports missing when running report jobs 168
    SAS Content Server 172
    user ID and password in generated code 171
    user permissions 165

W
  Web links for tile charts 183